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BÀI 1. KHÁI NIỆM CƠ BẢN 
I. Mục tiêu bài học:
1. Kiến thức:
- Biết khái niệm CSDL;
- Biết vai trò của CSDL trong học tập và đời sống;
2. Kĩ năng: 
· Bước đầu hình thành kĩ năng khảo sát thực tế cho ứng dụng CSDL.
3. Thái độ: 
	- Tạo cho HS tìm hiểu biết công việc quản lí là phổ biến trong đời sống.
	- Tìm hiểu biết công việc thường gặp khi quản lí thông tin của một tổ chức nào đó.
	- Biết CSDL giúp hỗ trợ thực hiện các công việc thường xuyên của công tác quản lí.   
4. Định hướng phát triển năng lực:
· Giải quyết vấn đề, hợp tác.
II. Chuẩn bị: 
	Lưu ý: Mục 3: Hệ CSDL, b. Các mức thể hiện của CSDL(trang9); c. Các yêu cầu cơ bản của hệ CSDL(trang12) Không dạy theo công văn số 5842/BGDĐT-VP ngày 1/9/2011 về việc hướng dẫn thực hiện điều chỉnh nội dung dạy học môn Tin học cấp THPT.
1. Giáo viên:
	- Phiếu học tập
	- Máy chiếu
2. Học sinh:
	- Chuẩn bị sách vở
III. Tiến trình lên lớp:
	Hoạt động
	Nội dung

	1. Khởi động/ xuất phát
	- Chia lớp thành 4 nhóm học tập
- Các nhóm lập bảng thể hiện việc chi tiêu hàng ngày trong gia đình mình.
- Chuẩn bị các thông tin về việc quản lí của một trường học, bệnh viện, ngân hàng, xí nghiệp. . .

	2. Hình thành kiến thức
	- Bài toán quản lý
- Khái niệm CSDL, Hệ QTCSDL	

	3. Luyện tập
	- Các công việc thường gặp khi xử lý thông tin của một tổ chức
- Tìm hiểu CSDL giúp hỗ trợ thực hiện các công việc thường xuyên của công tác quản lí.   

	4. Mở rộng
	- Công tác quả lí chiếm thị phần lớn trong các ứng dụng Tin học
- Việc ứng dụng CSDL, Hệ CSDL mang lại thay đổi gì?


IV. Cụ thể tiến trình dạy học:
A. Khởi động
1. Hoạt động 1:Tình huống xuất phát
 (1) Mục tiêu: Tạo động cơ dẫn dắt HS tìm hiểu về các vấn đề trong thực tế, chuẩn bị các thông tin về việc quản lí của một tổ chức nào đó dẫn dắt HS tìm hiểu về các bài toán quản lý.
(2) Phương pháp/kĩ thuật dạy học: cá nhân, thảo luận nhóm.
(3) Phương tiện dạy học: SGK, Máy chiếu, máy tính kết nối mạng internet.
(4) Sản phẩm: bảng thể hiện việc chi tiêu hàng ngày trong gia đình mình; các thông tin về việc quản lí của một tổ chức nào đó.

Nội dung hoạt động
	Hoạt động của giáo viên
	Hoạt động của học sinh

	GV giao nhiệm vụ cho HS, các nhóm 
- Lập bảng thể hiện việc chi tiêu hàng ngày trong gia đình mình.
- Các thông tin cần về việc quản lí của một tổ chức nào đó.

	
- HS thấy được việc quản lí

- Của một tổ chức như một trường học, bệnh viện, ngân hàng, xí nghiệp. . .

	- Tổng hợp ý kiến của HS và các nhóm
	- HS báo cáo kết quả

	- GV dẫn dắt vào bài 1
	- Bổ sung ý kiến, đánh giá kết quả của các nhóm


B. Hình thành kiến thức và luyện tập
Hoạt động 2. Hình thành kiến thức:
(1) Mục tiêu: biết tìm hiểu về các bài toán quản lý. Khái niệm CSDL, Hệ QTCSDL	
(2) Phương pháp/kĩ thuật dạy học: cá nhân, thảo luận nhóm.
(3) Phương tiện dạy học: SGK, Máy chiếu, máy tính kết nối mạng internet.
(4) Sản phẩm: Đối tượng cần quản lí trong các bài toán quản lí, các bước để tạo lập một hồ sơ của đối tượng cần quản lí.
Nội dung hoạt động
	Hoạt động của giáo viên
	Hoạt động của học sinh

	- Trình chiếu một số hình ảnh liên quan đến các lĩnh vực đã nêu.

- Ứng dụng vào rất nhiều lĩnh vựcCông tác quản lí như thế nào?
- Xem thông tin của bài toán Quản lý học sinh.
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	- HS xem trình chiếu
- HS làm việc với SGK
- HS làm việc cá nhân và trao đổi trong nhóm.

	- Trong bài toán về Quản lý học sinh, em hãy xác định đối tượng cần quản lý.
- Thông tin cần quản lý được lưu trữ dưới dạng gì?
- Hướng dẫn hs biết các bước để tạo lập một hồ sơ về các đối tượng cần quản lí.

	- HS làm việc với SGK
- HS làm việc cá nhân và trao đổi trong nhóm.

	- GV cho HS ghi vào vở
1. Bài toán quản lí: ngoài việc lưu trữ thông tin việc quản lí hồ sơ còn có những chức năng cơ bản nào?
2. Các công việc thường gặp khi xử lý thông tin của một tổ chức:
a. Tạo lập hồ sơ
b. Cập nhật hồ sơ
c. Khai thác hồ sơ
3. Hệ CSDL
a. Khái niệm CSDL
b. Khái niệm hệ QTCSDL
	- Xem thông tin
- Xử lý thông tin
- Tìm kiếm, chọn lọc thông tin


- Tham khảo SGK
- HS trao đổi theo nhóm



C. Luyện tập – Vận dụng:
Hoạt động 3. Tìm hiểu các công việc thường gặp khi xử lý thông tin của một tổ chức
(1) Mục tiêu: Các công việc thường gặp khi xử lý thông tin của một tổ chức cụ thể, tìm hiểu CSDL giúp hỗ trợ thực hiện các công việc thường xuyên của công tác quản lí.   
(2) Phương pháp/kĩ thuật dạy học: cá nhân, thảo luận nhóm.
(3) Phương tiện dạy học: SGK, Máy chiếu, máy tính kết nối mạng internet.
(4) Sản phẩm: các nhóm các nêu các công việc thường gặp khi xử lý thông tin của một tổ chức cụ thể
Nội dung hoạt động
	Hoạt động của giáo viên
	Hoạt động của học sinh

	GV yêu cầu HS tìm hiểu Các công việc thường gặp khi xử lý thông tin của một tổ chức cụ thể như một trường học, bệnh viện, ngân hàng, xí nghiệp. . . 
- Mỗi nhóm 1 tổ chức
	-HS làm việc theo nhóm và dán sản phẩm lên bảng

	GV yêu cầu HS tìm hiểu CSDL giúp hỗ trợ thực hiện các công việc thường xuyên của công tác quản lí
	-HS làm việc theo nhóm và dán sản phẩm lên bảng

	Tổ chức HS báo cáo sản phẩm đánh giá và hỗ trợ HS
	-HS làm việc theo nhóm và dán sản phẩm lên bảng


D. Tìm tòi mở rộng:
Hoạt động 4: Tìm hiểu ứng dụng cơ sở dữ liệu trong một số lĩnh vực
(1) Mục tiêu: công tác quản lí chiếm thị phần lớn trong các ứng dụng Tin học, việc ứng dụng CSDL, Hệ CSDL mang lại thay đổi gì? 
(2) Phương pháp/kĩ thuật dạy học: cá nhân, thảo luận nhóm.
(3) Phương tiện dạy học: SGK, Máy chiếu, máy tính kết nối mạng internet.
(4) Sản phẩm: nêu một số ví dụ ứng dụng trong các lĩnh vực khác nhau.
Nội dung hoạt động
	Hoạt động của giáo viên
	Hoạt động của học sinh

	GV yêu cầu HS tìm hiểu công tác quản lí chiếm thị phần lớn trong các ứng dụng Tin học.
- Việc ứng dụng CSDL, Hệ CSDL mang lại thay đổi gì? 
- Trong mọi hoạt động con người vẫn đóng vai trò quyết định
- Có nhiều mức ứng dụng của hệ CSDL

	-HS làm việc theo nhóm và dán sản phẩm lên bảng

	Tổ chức HS báo cáo sản phẩm đánh giá và hỗ trợ HS
	-HS làm việc theo nhóm và dán sản phẩm lên bảng





Tiết: 4,5
BÀI 2: HỆ QUẢN TRỊ CƠ SỞ DỮ LIỆU 
I. Mục tiêu bài học:
1. Kiến thức:
- Biết chức năng của hệ quản trị CSDL;
- Biết vai trò của con người khi làm việc với hệ CSDL.
2. Kĩ năng: 
- Chưa đòi hỏi phải biết các thao tác cụ thể.
3. Thái độ: 
	- Tạo cho HS tìm hiểu biết môi trường tạo lập CSDL, cập nhật, khai thác, kiểm soát, điều khiển truy cập CSDL
4. Định hướng phát triển năng lực:
       - Tự học, giải quyết vấn đề, giao tiếp, hợp tác
II. Chuẩn bị: 
	Lưu ý: Mục 2: Hoạt động của một hệ QTCSDL(trang17) Không dạy theo công văn số 5842/BGDĐT-VP ngày 1/9/2011 về việc hướng dẫn thực hiện điều chỉnh nội dung dạy học môn Tin học cấp THPT.
1. Giáo viên:
	- Phiếu học tập
	- Máy chiếu
2. Học sinh:
	- Chuẩn bị sách vở
III. Tiến trình lên lớp:
	Hoạt động
	Nội dung

	1. Khởi động/ xuất phát
	- Chia lớp thành 4 nhóm học tập
- HS nhắc lại khái niệm về hệ QTCSDL


	2. Hình thành kiến thức
	- Biết các chức năng của hệ QTCSDL
+ Cung cấp khả năng tạo lập CSDL
+ Cung cấp khả năng cập nhật dữ liệu, tìm kiếm và kết xuất thông tin
+ Cung cấp công cụ kiểm soát, điều khiển truy cập vào CSDL
- Vai trò của con người khi làm vieeecj với các hệ CSDL

	3. Luyện tập
	Phân biệt CSDL và hệ QTCSDL

	4. Mở rộng
	- Lập các bước tiến hành để xây dựng một CSDL quản lí.



IV. Cụ thể tiến trình dạy học:
A. Khởi động
1. Hoạt động 1.Tình huống xuất phát
(1) Mục tiêu: biết khái niệm hệ QTCSDL, tìm hiểu một số ví dụ liên quan đến chức năng
(2) Phương pháp/kĩ thuật dạy học: cá nhân, thảo luận nhóm.
(3) Phương tiện dạy học: SGK, Máy chiếu, máy tính kết nối mạng internet.
(4) Sản phẩm: HS trả lời khái niệm hệ QTCSDL, nêu được một số ví dụ liên quan đến chức năng của hệ QTCSDL

Nội dung hoạt động
	Hoạt động của giáo viên
	Hoạt động của học sinh

	GV giao nhiệm vụ cho HS, các nhóm 
- Phát biểu khái niệm hệ QTCSDL
- Trình chiếu một số ví dụ liên quan đến chức năng của hệ QTCSDL

	
- HS làm việc theo nhóm

- HS có thể cho thêm các ví dụ khác

	- Tổng hớp ý kiến của HS và các nhóm
	- HS báo cáo kết quả

	- GV dẫn dắt vào bài 2
	- Bổ sung ý kiến, đánh giá kết quả của các nhóm



B. Hình thành kiến thức và luyện tập:
Hoạt động 2. Các chức năng của hệ QT CSDL; vai trò của con người khi làm việc với hệ CSDL
(1) Mục tiêu: biết chức năng của hệ quản trị CSDL; biết vai trò của con người khi làm việc với hệ CSDL.
(2) Phương pháp/kĩ thuật dạy học: cá nhân, thảo luận nhóm.
(3) Phương tiện dạy học: SGK, Máy chiếu, máy tính kết nối mạng internet.
(4) Sản phẩm: Chức năng của hệ QTCSDL, vai trò của con người khi làm việc với các hệ CSDL.
Nội dung hoạt động
	Hoạt động của giáo viên
	Hoạt động của học sinh

	+ Cung cấp khả năng cập nhật dữ liệu, tìm kiếm và kết xuất thông tin
   . Đây là môđun tác động lên dữ liệu, cho phép người dùng: xem nội dung dữ liệu; cập nhật dữ liệu; sắp xếp lọc, tìm kiếm thông tin; kết xuất báo cáo

	- HS làm việc với SGK
- HS làm việc cá nhân và trao đổi trong nhóm.

	+ Cung cấp công cụ kiểm soát, điều khiển việc truy cập CSDL
   . Đây là nhóm lệnh dùng cho người thiết kế và quản lí hệ thống, bao gồm các chức năng: đảm bảo an ninh, ngăn cấm truy cập không được phép; duy trì tính nhất quán của dữ liệu; tổ chức và điều khiển các truy cập đồng thời; đảm bảo khôi phục CSDL khi có sự cố ở phần cứng hay phần mềm; quản lí từ điển dữ liệu, bao gồm các mô tả dữ liệu trong CSDL.
	


- Tham khảo SGK
- HS trao đổi theo nhóm

	2. Tìm hiểu vai trò của con người khi làm việc với các hệ CSDL
- Người quản trị CSDL




- Người lập trình ứng dụng




- Người dùng
	

- Người QTCSDL là một người hoặc một nhóm người có nhiệm vụ gì?
(Bảo trì hệ CSDL; Nâng cấp CSDL; Tổ chức hệ thống; Quản lí tài nguyên của CSDL. . .)
- Người lập trình ứng dụng là những người có nhiệm vụ gì?  (là những người xây dựng các chương trình ứng dụng hỗ trợ khai thác thông tin từ CSDL. Kết hợp nhiều loại ngôn ngữ khác nhau. . . .)
- Người dùng là tập thể đông đảo nhất những người có quan hệ với hệ CSDL. . .


C. Luyện tập – Vận dụng:
Hoạt động 3. Phân biệt CSDL và hệ QT CSDL
(1) Mục tiêu: Biết phân biệt CSDL và hệ QTCSDL 
(2) Phương pháp/kĩ thuật dạy học: cá nhân, thảo luận nhóm.
(3) Phương tiện dạy học: SGK, Máy chiếu, máy tính kết nối mạng internet.
(4) Sản phẩm: Bảng so sánh CSDL và hệ QTCSDL
Nội dung hoạt động
	Hoạt động của giáo viên
	Hoạt động của học sinh

	GV yêu cầu HS các nhóm lập bảng so sánh sự khác nhau giữa CSDL và hệ QTCSDL
	-HS làm việc theo nhóm và dán sản phẩm lên bảng

	Tổ chức HS báo cáo sản phẩm đánh giá và hỗ trợ HS
	-HS làm việc theo nhóm và dán sản phẩm lên bảng



D. Tìm tòi, mở rộng:
Hoạt động 4. Tìm hiểu các bước xây dựng một CSDL
(1) Mục tiêu: Biết lập các bước tiến hành để xây dựng một CSDL quản lí. 
(2) Phương pháp/kĩ thuật dạy học: cá nhân, thảo luận nhóm.
(3) Phương tiện dạy học: SGK, Máy chiếu, máy tính kết nối mạng internet.
(4) Sản phẩm: bảng lập các bước xây dựng một CSDL quản lí.  .
Nội dung hoạt động
	Hoạt động của giáo viên
	Hoạt động của học sinh

	GV yêu cầu HS tìm hiểu và lập các bước tiến hành để xây dựng một CSDL quản lí. 
Bước 1: Khảo sát hệ thống
+ Tìm hiểu các yêu cầu của công tác quản lí.
+ Xác định và phân tích mối liên hệ các dữ liệu cần lưu trữ
+ Phân tích các chức năng cần có của hệ thống.
Bước 2: Thiết kế hệ thống
+ Thiết kế CSDL.
+ Lựa chọn hệ QTCSDL để triển khai
+ Xây dựng hệ thống chương trình ứng dụng.
Bước 3: Kiểm thử hệ thống
+ Nhập dữ liệu cho CSDL.
+ Chạy thử.
Các bước thường được tiến hành lặp lại nhiều lần cho đến khi hệ thống có khả năng ứng dụng.
	-HS tham khảo SGK 
-HS làm việc theo nhóm và dán sản phẩm lên bảng

	Tổ chức HS báo cáo sản phẩm đánh giá và hỗ trợ HS
	-HS làm việc theo nhóm và dán sản phẩm lên bảng




Tiết: 6
BÀI TẬP
I. MỤC TIÊU BÀI HỌC
1. Kiến thức
- Củng cố các khái niệm, thuật ngữ đã học: CSDL, hệ QTCSDL, hệ CSDL;
- Sự cần thiết phải có CSDL lưu trên máy tính, mối tương tác giữa các thành phần của hệ CSDL;
2. Kĩ năng
 - Bước đầu hình thành kĩ năng khảo sát thực tế cho ứng dụng CSDL.
3. Thái độ
- Có ý thức sử dụng máy tính để khai thác thông tin, phục vụ công việc hàng ngày.
4. Định hướng phát triển năng lực
- Tự học, giải quyết vấn đề, giao tiếp, hợp tác
II. PHƯƠNG PHÁP KĨ THUẬT DẠY HỌC
- Dạy học nêu vấn đề, giải quyết vấn đề
III. PHƯƠNG TIỆN DẠY HỌC
1. Chuẩn bị của giáo viên
- Tư liệu sử dụng: giáo án, SGK, tài liệu liên quan.
- Máy chiếu.
2. Chuẩn bị của học sinh
- Sách giáo khoa.
- Chuẩn bị dụng cụ học tập đầy đủ.
IV. TỔ CHỨC CÁC HOẠT ĐỘNG DẠY HỌC
1. Ổn định lớp
- Điểm danh, kiểm tra sĩ số
2. Chuỗi các hoạt động
A. KHỞI ĐỘNG
Hoạt động 1: Kiểm tra bài cũ
(1) Mục tiêu: 
- Nêu vai trò của con người khi làm việc với hệ CSDL
- Nêu các bước để xây dựng CSDL
- Nêu các khái niệm về CSDL, hệ quản trị CSDL
- Nêu được các chức năng của một hệ quản trị CSDL
- Giải thích được thuật ngữ “Hệ CSDL”
(2) Phương pháp/kĩ thuật : Dạy học nêu vấn đề, giải quyết vấn đề.
(3) Hình thức dạy học: Cá nhân, thảo luận nhóm
(4) Phương tiện dạy học: SGK.
(5) Sản phẩm: HS biết vai trò của con người khi làm việc với hệ CSDL và các bước xây dựng CSDL, phân biệt giữa CSDL với hệ quản trị CSDL. 
Nội dung hoạt động
	Hoạt động của GV
	Hoạt động của HS

	- Chiếu câu hỏi kiểm tra bài cũ
- Gọi HS lên bảng trả lời
	- Cá nhân lên bảng trả lời


	- Đánh giá và ghi điểm cho HS
	- HS khác nhận xét


B. HÌNH THÀNH KIẾN THỨC VÀ LUYỆN TẬP
Hoạt động 2: Bài tập
(1) Mục tiêu: Biết các công việc cơ bản khi xây dựng CSDL đơn giản.
(2) Phương pháp/kĩ thuật : Dạy học nêu vấn đề, giải quyết vấn đề.
(3) Hình thức dạy học: Cá nhân, thảo luận nhóm
(4) Phương tiện dạy học: SGK, giáo án.
(5) Sản phẩm: Biết khảo sát thực tế để tạo lập hồ sơ theo yêu cầu.
Nội dung hoạt động
	Hoạt động của Giáo viên
	Hoạt động của Học sinh

	- Phát phiếu học tập yêu cầu HS điền các các công việc cần thực hiện để tạo lập CSDL quản lí điểm của học sinh trong nhà trường:
1. Tìm hiểu các thông tin cần để quản lý điểm của học sinh
2. Kể tên các thông tin chính liên quan đến học sinh
3. Liệt kê các đối tượng cần quản lý khi xây dựng CSDL
	- Nhóm 1, 2, 3 thảo luận làm trên phiếu học tập

	- Phát phiếu học tập yêu cầu HS điền các các công việc cần thực hiện để tạo lập CSDL quản lý hóa đơn bán hàng của một cửa hàng:
1. Tìm hiểu các hoạt động buôn bán của một cửa hàng
2. Kể tên các hoạt chính của việc buôn bán của một cửa hàng
3. Liệt kê các đối tượng cần quản lý khi xây dựng CSDL
	- Nhóm 4, 5, 6 thảo luận làm trên phiếu học tập

	- GV theo dõi, gợi ý, giúp đỡ các nhóm giải quyết các khó khăn của các nhóm
	-Hoàn thành và nộp phiếu học tập cho GV


C. VẬN DỤNG, TÌM TÒI, MỞ RỘNG
 (1). Mục tiêu: Giúp những học sinh có nhu cầu mở rộng thêm kiến thức của mình.
(2). Phương pháp/kĩ thuật : làm việc cá nhân, nhóm
(3). Hình thức dạy học: Trong lớp và Ngoài lớp học
(4). Phương tiện dạy học: SGK, mạng Internet
(5). Sản phẩm: Học sinh phân tích các mức thể hiện và trình bày các yêu cầu cơ bản của hệ CSDL quản lí điểm của học sinh trong nhà trường và CSDL quản lý hóa đơn bán hàng của một cửa hàng
	Hoạt động của GV
	Hoạt động của HS

	- GV giao nhiệm vụ cho học sinh về nhà dựa trên những kiến thức đã học, phân tích các mức thể hiện và trình bày các yêu cầu cơ bản của hệ CSDL quản lí điểm của học sinh trong nhà trường và CSDL quản lý hóa đơn bán hàng của một cửa hàng	
	- Về nhà thực hiện nhiệm vụ học tập



3. Củng cố, dặn dò, hướng dẫn học ở nhà
- Trả lời các câu hỏi cuối mỗi bài học
- Chuẩn bị bài “Bài tập thực hành 1”, SGK, trang 21

 Tiết: 7 
BÀI TẬP VÀ THỰC HÀNH 1
TÌM HIỂU HỆ CƠ SỞ DỮ LIỆU
I. MỤC TIÊU BÀI HỌC
1. Kiến thức
· Biết xác định những việc cần làm trong hoạt động quản lí của một công việc đơn giản.
· Biết một số công việc cơ bản khi xây dựng CSDL đơn giản 
2. Kĩ năng
· Bước đầu hình thành kĩ năng tư duy khảo sát thực tế cho ứng dụng của CSDL
3. Thái độ
· Tích cực tham gia các nhiệm vụ học tập trên lớp, khẳng định giá trị bản thân thông qua các hoạt động học tập
4. Định hướng phát triển năng lực
-  Tự học, giải quyết vấn đề, tư duy, tự quản lý, giao tiếp, hợp tác
II. PHƯƠNG PHÁP KĨ THUẬT DẠY HỌC
· Thảo luận, đàm thoại gợi mở, thuyết trình…
· Hình thức tổ chức dạy học: cá nhân, nhóm, lớp.
III. PHƯƠNG TIỆN DẠY HỌC
· Giáo viên: SGK, Máy tính, máy chiếu
· Học sinh: SGK, tư liệu
IV. TỔ CHỨC CÁC HOẠT ĐỘNG DẠY HỌC
1. Ổn định lớp
2. Chuỗi các hoạt động
A. KHỞI ĐỘNG
 (1) Mục tiêu: Biết xác định những việc cần làm trong hoạt động quản lí của một công việc đơn giản.
(2) Phương pháp/kĩ thuật : Dạy học nêu vấn đề, giải quyết vấn đề.
(3) Hình thức dạy học: Cá nhân, thảo luận nhóm
(4) Phương tiện, SGK.
(5) Sản phẩm: Biết các công việc cần thực hiện để tạo lập hồ sơ.
Nội dung hoạt động:
	Hoạt động của Giáo viên
	Hoạt động của Học sinh

	- Phát phiếu học tập yêu cầu HS điền các các công việc cần thực hiện để tạo lập CSDL quản lí sách và mượn/trả sách của một thư viện
1. Khảo sát CSDL quản lý sách và mượn/trả sách của một thư viện:
- Tìm hiểu nội qui thư viện, thẻ thư viện, phiếu mượn/trả sách, sổ quản lí sách, ... của thư viện trường THPT.
- Kể tên các hoạt chính của thư viện
- Liệt kê các đối tượng cần quản lý khi xây dựng CSDL. Với mỗi đối tượng, liệt kê các thông tin cần quản lý.
2. Theo em, CSDL nêu trên cần các bảng nào? Mỗi bảng cần những cột nào?
	- Các nhóm thảo luận làm trên phiếu học tập

	- GV theo dõi, gợi ý, giúp đỡ các nhóm giải quyết các khó khăn của các nhóm
	- Hoàn thành và nộp phiếu học tập cho GV



B. HÌNH THÀNH KIẾN THỨC VÀ LUYỆN TẬP
 (1) Mục tiêu: Biết các công việc cơ bản khi xây dựng CSDL đơn giản.
(2) Phương pháp/kĩ thuật : Dạy học nêu vấn đề, giải quyết vấn đề.
(3) Hình thức dạy học: Cá nhân, thảo luận nhóm
(4) Phương tiện, SGK.
(5) Sản phẩm: Biết khảo sát thực tế để tạo lập hồ sơ theo yêu cầu.
Nội dung hoạt động:
	Hoạt động của Giáo viên
	Hoạt động của Học sinh

	Yêu cầu: Đại diện 2 nhóm lên trình bày phần nội dung được phân công.
	- Đại diện 2 nhóm lên bảng trình bày bài tập được giao.
- Theo dõi bài tập, từng nhóm thảo luận và nhận xét những nội dung của các nhóm trình bày.

	- GV Sửa bài tập và chuẩn hóa kiến thức  cho  học sinh
	1. Tìm hiểu nội qui thư viện, thẻ thư viện, phiếu mượn/trả sách, sổ quản lí sách, ... của thư viện trường THPT.
2. Kể tên các hoạt chính của thư viện:
-  Mua và nhập sách, thanh lí sách.
-  Cho mượn sách.
...
3. Liệt kê các đối tượng cần quản lý khi xây dựng CSDL. Với mỗi đối tượng, liệt kê các thông tin cần quản lý.
- Thông tin về người mượn: Số thẻ mượn,  họ tên, ngày sinh, lớp,...
- Thông tin về sách: tên sách, mã số sách, số trang, tác giả, ...
- Thông tin về bảng mượn sách: số thẻ, mã số sách, ngày mượn, ngày trả, ...

	- Yêu cầu HS trình bày các mức thể hiện và trình bày các yêu cầu cơ bản của hệ CSDL quản lý sách và mượn/trả sách của một thư viện.	
	- Cá nhân trả lời



C. VẬN DỤNG, TÌM TÒI, MỞ RỘNG
(1). Mục tiêu: Giúp những học sinh có nhu cầu mở rộng thêm kiến thức của mình.
(2). Phương pháp/kĩ thuật : làm việc cá nhân, nhóm
(3). Hình thức dạy học: Trong lớp và Ngoài lớp học
(4). Phương tiện, SGK, mạng Internet
(5). Sản phẩm: Học sinh phân tích các mức thể hiện và trình bày các yêu cầu cơ bản của hệ CSDL quản lý sách và mượn/trả sách của một thư viện.
	Hoạt động của GV
	Hoạt động của HS

	- GV giao nhiệm vụ cho học sinh về nhà dựa trên những kiến thức đã học, phân tích các mức thể hiện của CSDL quản lý sách và mượn/trả sách của một thư viện.	
	- Về nhà thực hiện nhiệm vụ học tập



3. Củng cố, dặn dò, hướng dẫn học ở nhà
- Xem trước bài 3 “Giới thiệu Microsoft Access”

 Tiết: 8
Chương II. HỆ QUẢN TRỊ CƠ SỞ DỮ LIỆU MICROSOFT ACCESS
BÀI 3. GIỚI THIỆU MICROSOFT ACCESS
I. MỤC TIÊU BÀI HỌC
1. Kiến thức
- Nêu được các chức năng chính của Ms Access: tạo lập bảng, thiết lập mối quan hệ giữa các bảng, cập nhật, kết xuất thông tin.
- Liệt kê được bốn đối tượng chính của Access: Bảng, mẫu hỏi, biểu mẫu, báo cáo.
- Nêu được hai chế độ làm việc: chế độ thiết kế (làm việc với cấu trúc) và chế độ làm việc với dữ liệu.
- Liệt kê được các bước khởi động/kết thúc Access, tạo CSDL mới, mở CSDL đã có, tạo đối tượng mới và mở một đối tượng.
- Nêu được các cách tạo đối tượng: dùng thuật sĩ (Wizard) và tự thiết kế (Design).
2. Kỹ năng 
- Khởi động, thoát Access, tạo mới CSDL, mở CSDL đã có.
3. Thái độ
-  Ham muốn giải các bài toán quản lí bằng Access, thấy được lợi ích của Access phục vụ thực tiễn.
4. Định hướng phát triển năng lực
- Liên hệ được một bài toán quản lí gần gũi với HS cùng các công cụ quản lí tương ứng trong Access
- Biết các công việc cần thực hiện để tạo lập hồ sơ
II. PHƯƠNG PHÁP KĨ THUẬT DẠY HỌC
- Thuyết trình, vấn đáp, tái hiện, thảo luận nhóm, mô phỏng, liên tưởng, kích hoạt não, trực quan, phát hiện giải quyết vấn đề
III. PHƯƠNG TIỆN DẠY HỌC
1. Chuẩn bị của giáo viên
- Tư liệu sử dụng: giáo án, SGK, tài liệu liên quan.
- CSDL QuanliHS.mdb.
- Máy tính, máy chiếu
2. Chuẩn bị của học sinh
- Sách giáo khoa.
- Chuẩn bị dụng cụ học tập đầy đủ.
IV. TỔ CHỨC CÁC HOẠT ĐỘNG DẠY HỌC
1. Ổn định lớp
- Điểm danh, kiểm tra sỉ số
2. Chuỗi các hoạt động
A. HOẠT ĐỘNG KHỞI ĐỘNG
(1) Mục tiêu: Nêu được các chức năng của hệ quản trị CSDL
(2) Phương pháp/ kỹ thuật dạy học: Thuyết trình, vấn đáp
(3) Hình thức tổ chức hoạt động: cá nhân
(4) Phương tiện dạy học: giáo án
(5) Sản phẩm: Liệt kê được 3 chức năng chính của một hệ quản trị CSDL.
	Hoạt động của giáo viên
	Hoạt động của học sinh

	Nêu câu hỏi:
- Nêu các chức năng chính của hệ quản trị CSDL
- Gọi 2 HS đứng tại chỗ trả lời
- Chuẩn hoá lại kiến thức cho HS
	


- Suy nghĩ, trả lời


B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC
Hoạt động 1: Tìm hiểu về các khả năng của Access
(1) Mục tiêu: Nêu được các khả năng của Access
(2) Phương pháp/ kỹ thuật dạy học: Thuyết trình, vấn đáp kết hợp kĩ thuật “kích não”, mô phỏng và liên tưởng để nhận biết khái niệm qua hình ảnh minh hoạ.
(3) Hình thức tổ chức hoạt động: cá nhân
(4) Phương tiện dạy học: giáo án, SGK, máy tính, máy chiếu
(5) Sản phẩm: Liệt kê được các khả năng của Acess
	Hoạt động của giáo viên
	Hoạt động của học sinh

	- Giới thiệu về MS Access
- Yêu cầu HS tham khảo SGK để biết cụ thể các khả năng
- Trình chiếu một ví dụ về bài toán quản lí kết quả học tập một lớp học và thực hiện các chức năng lập bảng, cập nhật, kết xuất thông tin nhanh chóng và ngắn gọn

	- Theo dõi để liên tưởng
- Theo dõi SGK trả lời





- Quan sát ví dụ, từ đó biết các khả năng chính của Access


Hoạt động 2: Tìm hiểu các loại đối tượng chính của Access
(1) Mục tiêu: Nêu được 4 loại đối tượng chính trong Access
(2) Phương pháp/ kỹ thuật dạy học: Trực quan, phát hiện giải quyết vấn đề
(3) Hình thức tổ chức hoạt động: cá nhân
(4) Phương tiện dạy học: giáo án, máy tính, máy chiếu, SGK
(5) Sản phẩm: Nêu và phân biệt được chức năng của 4 loại đối tượng: bảng (Table), mẫu hỏi (Query), biểu mẫu (Form), báo cáo (Report)
	Hoạt động của giáo viên
	Hoạt động của học sinh

	- Trình chiếu CSDL quản lí kết quả học tập của học sinh. Mở bảng chứa dữ liệu về HS
- Giới thiệu Bảng là 1 loại đối tượng của Access
? Nêu các chức năng của bảng và cấu trúc bảng
- Trình chiếu: Chọn loại đối tượng Table làm xuất hiện một bảng
? Một CSDL có bao nhiêu bảng

- Thực hiện tương tự như vậy cho các đối tượng mẫu hỏi, biểu mẫu, báo cáo
- Kết luận: Trong Access có 4 loại đối tượng chính là  bảng, mẫu hỏi, biểu mẫu, báo cáo
	



- Quan sát, suy nghĩ và trả lời: Bảng dùng để chứa dữ liệu, bao gồm nhiều hàng và cột



- Quan sát, trả lời: Gồm nhiều bảng



Hoạt động 3: Tìm hiểu một số thao tác cơ bảng trong Access
(1) Mục tiêu: Nêu được các thao tác cơ bản trong Access
(2) Phương pháp/ kỹ thuật dạy học: Trực quan, phát hiện giải quyết vấn đề
(3) Hình thức tổ chức hoạt động: cá nhân
(4) Phương tiện dạy học: giáo án, máy tính, máy chiếu, SGK
(5) Sản phẩm: HS thực hiện được các thao tác cơ bản trong Access
	Hoạt động của giáo viên
	Hoạt động của học sinh

	- Trình chiếu: Thực hiện cách khởi động Access từ bảng chọn Start
? Giống cách khởi động phần mềm nào đã học
- Yêu cầu HS thực hiện thêm các cách khác (vừa thực hiện vừa thuyết minh)
- Trình chiếu: Thực hiện thao tác kết thúc phiên làm việc với Access
- Yêu cầu HS thực hiện thêm các cách khác (vừa thực hiện vừa thuyết minh)
? Yêu cầu HS nhắc lại cách tạo tệp văn bản mới
- Tương tự MS Word trong Access cũng có các bước để tạo CSDL mới
- Khuyến khích HS xung phong thực hiện tạo CSDL mới
- Chỉ định một số HS lên bảng thực hiện lại
- Khuyến khích HS xung phong thực hiện mở CSDL đã có
- Chỉ định một số HS lên bảng thực hiện lại
- Thực hiện các thao tác trên các phiên bản khác nhau của Windows và Office

	
- Quan sát để nhận biết thao tác

- Ms Word


- Thực hiện trên máy và thuyết minh




- Thực hiện trên máy và thuyết minh


- Chọn File → New



- Lên bảng thực hiện, quan sát


- Lên bảng thực hiện, quan sát
- Quan sát, so sánh



Hoạt động 4: Tìm hiểu các chế độ làm việc với các đối tượng trong Access
(1) Mục tiêu: Nêu được 4 các chế độ làm việc với các đối tượng trong Access
(2) Phương pháp/ kỹ thuật dạy học: Trực quan, kĩ thuật mô phỏng và liên tưởng
(3) Hình thức tổ chức hoạt động: cá nhân
(4) Phương tiện dạy học: giáo án, máy tính, máy chiếu, SGK
(5) Sản phẩm: Biết thao tác chọn chế độ làm việc và nhận dạng được chế độ làm việc

	Hoạt động của giáo viên
	Hoạt động của học sinh

	- Trình chiếu: Mở CSDL QuanliHS.mdb đã chuẩn bị sẵn các loại đối tượng và dữ liệu. Mở các loại đối tượng trong chế độ thiết kế
- Thực hiện một số thao tác tạo đối tượng mới, thay đổi trên các đối tượng trong chế độ thiết kế
? Ta có thể làm được gì trên các đối tượng trong chế độ thiết kế
- Thực hiện mở một số đối tượng loại Table ở chế độ trang dữ liệu. Thực hiện cập nhật dữ liệu
? Có thể làm được gì trong bảng ở chế độ trang dữ liệu
- Thực hiện chuyển bảng sang chế độ thiết kế
- Yêu cầu HS lên bảng thực hiện để kiểm tra mức độ tiếp thu: mở bảng, biểu mẫu, mẫu hỏi, báo cáo và chuyển đổi qua lại giữa 2 chế độ làm việc
	- Quan sát để biết thao tác và nhận dạng chế độ thiết kế







- Suy nghĩ, trả lời: Tạo thêm đối tượng mới, thay đổi cấu trúc của đối tượng


- Quan sát, nhận biết thao tác


- Suy nghĩ, trả lời: Cập nhật dữ liệu

- Quan sát



Hoạt động 5: Tìm hiểu cách tạo đối tượng mới và mở 1 đối tượng đã có
(1) Mục tiêu: Nêu được các cách tạo và mở đối tượng trong Access
(2) Phương pháp/ kỹ thuật dạy học: Trực quan
(3) Hình thức tổ chức hoạt động: cá nhân
(4) Phương tiện dạy học: giáo án, máy tính, máy chiếu, SGK
(5) Sản phẩm: HS tạo mới các đối tượng bằng cách tự thiết kế, thuật sĩ
	Hoạt động của giáo viên
	Hoạt động của học sinh

	- Trình chiếu: Giới thiệu các bước tạo 1 báo cáo bằng cách tự thiết kế và thuật sĩ
- Yêu cầu HS cho biết ưu điểm và nhược điểm của mỗi cách


- Người ta thường kết hợp cả 2 cách để tạo đối tượng.

- Giới thiệu thao tác mở 1 bảng đã có

- Yêu cầu HS mở một số đối tượng: mẫu hỏi, biểu mẫu, báo cáo theo yêu cầu

? Bảng vừa mở ở chế độ làm việc nào

- Yêu cầu HS chuyển sang chế độ thiết kế và ngược lại
	
- Quan sát để nhận biết


- Dùng thuật sĩ sẽ tạo đối tượng nhanh hơn. Dùng tự thiết kế sẽ tạo được đối tượng theo ý thích



- Quan sát, nhận biết các bước

- Thực hiện trên máy để hình thành kĩ năng: Nháy chuột vào đối tượng Table, nháy đúp vào bảng HOC_SINH

- Chế độ trang dữ liệu

- Thực hiện yêu cầu trên máy


C. HOẠT ĐỘNG VẬN DỤNG
Hoạt động 1: Vận dụng kiến thức đã học để trả lời câu hỏi
(1) Mục tiêu: Tổng hợp được kiến thức đã học
(2) Phương pháp/ kỹ thuật dạy học: Vấn đáp, tái hiện
(3) Hình thức tổ chức hoạt động: cá nhân
(4) Phương tiện dạy học: giáo án, SGK
(5) Sản phẩm: Nêu được khả năng của Access, 4 loại đối tượng chính của Access, các chế độ làm việc với đối tượng
	Hoạt động của giáo viên
	Hoạt động của học sinh

	- Nêu các câu hỏi và yêu cầu học sinh trả lời:
+ Access có những khả năng gì?
+ Kể tên 4 loại đối tượng chính trong Access
+ Khi làm việc với Access có những thao tác cơ bản nào?
+ Kể tên 2 chế độ làm việc với các đối tượng trong Access
- Nhắc lại để HS ghi nhớ
	



- Trả lời



D. HOẠT ĐỘNG TÌM TÒI, MỞ RỘNG
(1) Mục tiêu: Giúp những HS có nhu cầu mở rộng thêm kiến thức
(2) Phương pháp/ kỹ thuật dạy học: Thuyết trình
(3) Hình thức tổ chức hoạt động: thảo luận nhóm
(4) Phương tiện dạy học: giáo án, SGK
(5) Sản phẩm: Học sinh báo cáo kết quả về quá trình tìm hiểu của mình
	Hoạt động của giáo viên
	Hoạt động của học sinh

	Nêu yêu cầu:
- Phát phiếu học tập và yêu cầu HS hoàn thành:
+ Trong quá trình làm việc với Access, có những thao tác nào giống với các thao tác trên Ms Word
+ Hãy sắp xếp các bước sau để được một thao tác đúng
a) Chọn nút lệnh Create
b) Nhập tên của CSDL
c) Chọn File → New
d) Chọn Blank Database
- Chia nhóm, cho HS hoàn thành yêu cầu

	

- Thảo luận nhóm, hoàn thành yêu cầu


- Báo cáo kết quả của nhóm



3. Hướng dẫn học ở nhà
- GV nêu yêu cầu: 
+ Trả lời các câu hỏi 4,5 SGK trang 33
+ Đọc trước nội dung bài 4: Cấu trúc bảng
+ Đọc nội dung Phụ lục 3 trang 113, và Phụ lục 4 trang 130, SGK

Tiết: 9								

BÀI 4. CẤU TRÚC BẢNG
I. MỤC TIÊU BÀI HỌC
1. Kiến thức
- Diễn đạt được các khái niệm chính trong cấu trúc bảng.
- Liệt kê được các bước tạo, sửa và lưu cấu trúc bảng.
- Nêu được khái niệm khóa chính và liệt kê được các bước chỉ định một trường làm khóa chính.
2. Kỹ năng 
- Biết cách chọn lựa kiểu dữ liệu cho trường của Table.
- Thực hiện được tạo và sửa cấu trúc bảng, nạp dữ liệu vào bảng, cập nhật dữ liệu.
- Thực hiện việc khai báo khoá.
3. Thái độ
-  Ham muốn giải các bài toán quản lí bằng Access, thấy được lợi ích của Access phục vụ thực tiễn.
4. Định hướng phát triển năng lực
- Tự giác, tích cực và chủ động tự tìm hiểu, khám phá, đặc biệt là khả năng làm việc theo nhóm, tương trợ giúp đỡ lẫn nhau. Phát triễn kĩ năng thực hành.
- Hiểu biết về khái niệm chính trong cấu trúc bảng. 
- Tạo và sửa cấu trúc bảng theo yêu cầu thực tế bài toán.
II. PHƯƠNG PHÁP KĨ THUẬT DẠY HỌC
- Trực quan, mô tả và kĩ thuật liên tưởng
- Thuyết trình, vấn đáp, đàm thoại, diễn giải
III. PHƯƠNG TIỆN DẠY HỌC
1. Chuẩn bị của giáo viên
- Tư liệu sử dụng: giáo án, SGK, tài liệu liên quan.
- Máy tính, máy chiếu
- Bảng danh sách HS
- Bảng các kiểu dữ liệu
2. Chuẩn bị của học sinh
- Sách giáo khoa.
- Chuẩn bị dụng cụ học tập đầy đủ.
IV. TỔ CHỨC CÁC HOẠT ĐỘNG DẠY HỌC
1. Ổn định lớp
- Điểm danh, kiểm tra sĩ số
2. Chuỗi các hoạt động
A. HOẠT ĐỘNG KHỞI ĐỘNG
1. Mục tiêu: Kiểm tra kiến thức bài 3 “ Giới thiệu MS Access”
2. Phương pháp/ kỹ thuật dạy học: Thuyết trình, vấn đáp
3. Hình thức tổ chức hoạt động: Cá nhân
4. Phương tiện dạy học: Giáo án, SGK, máy tính, máy chiếu
5. Sản phẩm: Hoàn thành đúng các câu hỏi trắc nghiệm
Nội dung hoạt động
GV : Chiếu câu hỏi và gọi học sinh trả lời
Câu 1: Access là gì?
a. Là phần cứng
b. Là phần mềm ứng dụng
c. Là hệ QTCSDL do hãng Microsoft sản xuất
d. Là phần mềm công cụ
Câu 2: Các chức năng chính của Access
a. Lập bảng
b. Lưu trữ dữ liệu
c. Tính toán và khai thác dữ liệu
d. Ba câu trên đều đúng
Câu 3: Tập tin trong Access đươc gọi là
a. Tập tin cơ sở dữ liệu
b. Tập tin dữ liệu
c. Bảng
d. Tập tin truy cập dữ liệu
Câu 4: Tập tin trong Access chứa những gì:
a. Chứa các bảng, nơi chứa dữ liệu của đối tượng cần quản lý
b. Chứa các công cụ chính của Access như: table, query, form, report...
c. Chứa hệ phần mềm  khai thác dữ liệu
d. Câu a và b
HS: Trả lời
GV: Gọi HS nhận xét và kết luận
B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC
Hoạt động 1: Tìm hiểu một số khái niệm chính của Access
1. Mục tiêu: Hiểu được các khái niệm chính trong cấu trúc bảng như: trường, bản ghi, kiểu dữ liệu, khoá chính; Biết các bước tạo cấu trúc bảng; Biết các thao tác sửa cấu trúc bảng.
2. Phương pháp/ kỹ thuật dạy học: Trực quan, mô tả và kĩ thuật liên tưởng
3. Hình thức tổ chức hoạt động: Cá nhân
4. Phương tiện dạy học: SGK, giáo an, máy tính, máy chiếu
5. Sản phẩm: Trình bày được các khái niệm chính trong cấu trúc bảng như: trường, bản ghi, kiểu dữ liệu, khoá chính; Biết các bước tạo cấu trúc bảng; Biết các thao tác sửa cấu trúc bảng
	Hoạt động của giáo viên
	Hoạt động của học sinh

	- Trình chiếu hình 20, SGK trang 33. Giới thiệu đây là 1 ví dụ về một bảng dữ liệu trong Access
? Em hiểu như thế nào về bảng


? Chức năng của bảng là gì

- Giới thiệu trên hình về trường, bản ghi
- Yêu cầu HS nhắc lại kiểu dữ liệu trong NNLT Pascal và xác định kiểu dữ liệu cho các trường trong bảng trên hình vẽ
- Yêu cầu HS nhắc lại khái niệm về kiểu dữ liệu trong ngôn ngữ lập trình Pascal
- Trình chiếu bảng chứa một số kiểu dữ liệu thường dùng trong Access. Yêu cầu HS điền vào cột mô tả
- Lưu ý cho HS về kích thước lưu trữ: là khả năng lưu trữ tối đa cho kiểu dữ liệu đó
	- Quan sát danh sách bảng HS

- Gồm nhiều hàng, nhiều cột. Mỗi hàng lưu thông tin về 1 HS, mỗi cột lưu 1 thuộc tính của HS
- Chứa thông tin về chủ thể



- Suy nghĩ và phát biểu



- Lên bảng điền


Hoạt động 2: Tìm hiểu cách tạo cấu trúc bảng
1. Mục tiêu: Biết tạo cấu trúc bảng theo yêu cầu
2. Phương pháp/ kỹ thuật dạy học: Trực quan
3. Hình thức tổ chức hoạt động: Cá nhân, thảo luận nhóm
4. Phương tiện dạy học: Giáo án, SGK, máy tính, máy chiếu
5. Sản phẩm: HS thực hiện được các bước tạo được cấu trúc bảng theo yêu cầu, biết một số tính chất thường dùng
	Hoạt động của giáo viên
	Hoạt động của học sinh

	- Gọi HS lên bảng và gợi ý để HS thực hiện các bước để tạo bảng bằng cách tự thiết kế.
- Chia lớp thành 3 nhóm. Giao cho mỗi nhóm một yêu cầu:
+ Nhóm 1: Lấy ví dụ cụ thể để đặt kích thước cho các trường và giải thích ý nghĩa các thông số được thiết lập đó.
+ Nhóm 2: Tìm ví dụ cụ thể minh hoạ cho tính chất Caption và giải thích ý nghĩa của nó.
+ Nhóm 3: Tìm ví dụ cụ thể minh hoạ cho tính chất Default value và giải thích ý nghĩa của nó.
- Có thể gợi ý bằng 1 ví dụ cụ thể để định hướng yêu cầu cho HS
- Yêu cầu đại diện nhóm trình bày. Có thể cho thành viên nhóm bổ sung, hoặc thành viên nhóm khác chất vấn
- Trình chiếu thực hiện các bước nhằm qui định trường Maso làm khoá chính



- Nhấn mạnh nội dung và ý nghĩa của khoá chính là một số ít nhất các trường sao cho mỗi bộ giá trị của các trường trong khoá chính sẽ xác định duy nhất 1 bản ghi
- Yêu cầu HS nhớ lại cách lưu một file văn bản và thực hiện lưu cấu trúc bảng (Có thể trình bày nhanh)
	
- Thực hiện và quan sát các bước















- Thảo luận theo nhóm










- Đại diện nhóm trình bày, thành viên bổ sung và chất vấn
- Quan sát và nhận xét sự khác nhau trên hình vẽ giữa trường Maso với các trường khác là có hình chìa khoá trước tên trường. HS nhận dạng được khoá chính
- Thực hiện các bước lưu cấu trúc bảng


Hoạt động 3: Tìm hiểu cách thay đổi cấu trúc bảng
(1) Mục tiêu: Biết các thao tác làm việc với cấu trúc bảng
(2) Phương pháp/ kỹ thuật dạy học: Trực quan
(3) Hình thức tổ chức hoạt động: Cá nhân
(4) Phương tiện dạy học: Giáo án, SGK, máy tính, máy chiếu
(5) Sản phẩm: Thực hiện được các thao tác thay đổi cấu trúc bảng theo yêu cầu
	Hoạt động của giáo viên
	Hoạt động của học sinh

	- Gợi ý giúp HS nhớ lại các thao tác trên bảng biểu trong MS Word
- Yêu cầu HS chỉ ra tên các thao tác có thể thực hiện trên cấu trúc bảng. Gợi ý để HS biết là phải xuất phát từ các khái niệm trong bảng để tìm ra các thao tác.
- Giới thiệu các bước để thực hiện các thao tác thay đổi cấu trúc bảng. Sau đó gọi HS thực hiện lại
+ Thay đổi thứ tự trường GT ra sau Ngsinh
+ Chèn thêm trường Namsinh vào trước trường GT
+ Xoá trường To
+ Chỉ định trường Ten thành khoá chính
- Yêu cầu HS khái quát để được các bước thực hiện các thao tác trên và thực hiện các yêu cầu tương tự như các thao tác đó

	
- Chèn dòng ( cột), xoá dòng(cột)


- Thêm 1 trường, xoá 1 trường, đổi khoá chính,…








-Quan sát GV để hình thành thứ tự các bước và thực hiện lại


Hoạt động 4: Tìm hiểu thao tác xoá và đổi tên bảng
(1) Mục tiêu: Biết các thao tác xoá và đổi tên bảng
(2) Phương pháp/ kỹ thuật dạy học: Trực quan
(3) Hình thức tổ chức hoạt động: Cá nhân
(4) Phương tiện dạy học: Giáo án, SGK, máy tính, máy chiếu
(5) Sản phẩm: Thực hiện được thao tác xoá và đổi tên bảng theo yêu cầu
	Hoạt động của giáo viên
	Hoạt động của học sinh

	* Lưu ý:  Có thể thực hiện nhanh các thao tác vì HS đã được làm quen
- Trình chiếu thao tác đổi tên bảng HOC_SINH thành HocSinh
- Yêu cầu HS đổi ngược lại
- Yêu cầu HS nêu các bước
- Yêu cầu HS nêu các bước xoá bảng HOC_SINH và một HS khác thực hiện trên máy. GV chuẩn hoá thao tác trước khi HS thực hiện
- Yêu cầu HS liệt kê các bước chính của thao tác
	
- Theo dõi để hình thành thao tác



- Thực hiện trên máy
- Trình bày






C. HOẠT ĐỘNG VẬN DỤNG
Hoạt động 1: Nhận biết, phân loại
(1) Mục tiêu: Liệt kê được các thao tác, nhận biết được các bước thực hiện các thao tác
(2) Phương pháp/ kỹ thuật dạy học: Thuyết trình, vấn đáp, đàm thoại
(3) Hình thức tổ chức hoạt động: Cá nhân
(4) Phương tiện dạy học: Giáo án, SGK, máy tính, máy chiếu
(5) Sản phẩm: Hoàn thành bài tập theo yêu cầu

	Hoạt động của giáo viên
	Hoạt động của học sinh

	? Thống kê các thao tác đối với bảng

- Trình chiếu bài tập và yêu cầu HS ghép các thao tác ứng với các bước thực hiện
	- Đứng tại chỗ trả lời theo yêu cầu




	Thao tác
	Các bước thực hiện

	Xoá bảng
	- Chọn File → Save. Xuất hiện hộp thoại Save as
- Gõ tên bảng vào ô Table Name và Enter

	Đổi tên bảng
	- Chọn trường. Chọn Edit → Delete Rows

	Thay đổi tính chất của một trường
	- Chọn lệnh Insert → Rows
- Gõ tên trường, chọn kiểu dữ liệu, mô tả và qui định tính chất trường

	Chỉ định khoá chính
	- Chọn bảng
- Chọn Edit → Rename. Gõ tên mới cho bảng và Enter

	Lưu cấu trúc bảng
	- Chọn trường
- Chọn Edit → Primary Key

	Thêm một trường vào cấu trúc
	- Chọn tên bảng
- Chọn Edit → Delete. Nháy nút OK

	Thay đổi thứ tự các trường
	- Chọn trường
- Thực hiện thay đổi ở phần Field Properties

	Xoá trường
	- Chọn trường
- Nhấn chuột, giữ và kéo đến vị trí mới



D. HOẠT ĐỘNG TÌM TÒI, MỞ RỘNG
Hoạt động 1: 
(1) Mục tiêu: Giúp những HS có nhu cầu mở rộng thêm kiến thức
(2) Phương pháp/ kỹ thuật dạy học: Thuyết trình
(3) Hình thức tổ chức hoạt động: Cá nhân
(4) Phương tiện dạy học: giáo án, SGK
(5) Sản phẩm: Học sinh báo cáo kết quả về quá trình tìm hiểu của mình
	HOẠT ĐỘNG CỦA GIÁO VIÊN
	HOẠT ĐỘNG CỦA HỌC SINH

	- Hướng dẫn tìm hiểu Bài tập và thực hành 2, SGK, trang 40
+ Nêu mục đích yêu cầu của bài thực hành
+ Tìm hiểu nội dung của bài tập 1, 2 3
- Đọc các Phụ lục SGK
- Tìm cách đổi tên bảng, xoá bảng bằng một cách khác với cách đã học
	

- Quan sát lắng nghe, ghi chép



3. Hướng dẫn học ở nhà
- GV nêu yêu cầu:
+ Trả lời các câu hỏi 1, 2, 4 SGK, trang 39
+ Tìm hiểu thêm các Phụ lục trong SGK
Tiết: 10							

BÀI TẬP THỰC HÀNH 2. TẠO CẤU TRÚC BẢNG
I. MỤC TIÊU BÀI HỌC
1. Kiến thức
- Biết các bước khởi động và kết thúc Access, tạo cấu trúc bảng
- Biết được các loại đối tượng, sự khác nhau giữa các cửa sổ của từng loại đối tượng
2. Kĩ năng
- Thực hiện được các thao tác cơ bản: khởi động và kết thúc Access, tạo CSDL mới.
- Có các kĩ năng cơ bản về tạo cấu trúc bảng theo mẫu
3. Thái độ:
- Học sinh hiểu bài và hứng thú với bài học.
- Học sinh say mê thực hiện thao tác.
4. Định hướng phát triển năng lực
-  Vận dụng kiến thức đã học tạo được cấu trúc bảng cho một CSDL theo yêu cầu
II. PHƯƠNG PHÁP KĨ THUẬT DẠY HỌC
- Thuyết trình, vấn đáp
- Thực hành
- Kĩ thuật hướng đích
III. PHƯƠNG TIỆN DẠY HỌC
1. Chuẩn bị của giáo viên
- Tư liệu sử dụng: giáo án, SGK, tài liệu liên quan
- Phòng máy vi tính, máy chiếu
- CSDL Quanli_HS, có một bảng HOC_SINH
- Bảng mô tả cấu trúc của bảng HOC_SINH, SGK, trang 40
2. Chuẩn bị của học sinh
- Sách giáo khoa.
- Chuẩn bị dụng cụ học tập đầy đủ.
IV. TỔ CHỨC CÁC HOẠT ĐỘNG DẠY HỌC
1. Ổn định lớp
- Điểm danh, kiểm tra sỉ số
2. Chuỗi các hoạt động
A. HOẠT ĐỘNG KHỞI ĐỘNG
1. Mục tiêu: HS biết được một số vấn đề cần chú ý trước khi thực hành
2. Phương pháp/ kỹ thuật dạy học: Thuyết trình, vấn đáp
3. Hình thức tổ chức hoạt động: Cá nhân
4. Phương tiện dạy học: SGK, giáo án
5. Sản phẩm: Biết một số lưu ý khi tạo cấu trúc bảng

	Hoạt động của giáo viên
	Hoạt động của học sinh

	- Yêu cầu HS tham khảo các nội dung ở phần chú ý: Cách đặt tên trong Access, một số thao tác khi thực hiện sửa cấu trúc bảng (SGK, trang 41)
	- Độc lập tham khảo SGK, trình bày những điểm khác so với kiến thức đã biết



B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC
Hoạt động 1: Thực hiện bài tập 1
1. Mục tiêu: Biết khởi động, kết thúc Access; biết tạo cấu trúc bảng
2. Phương pháp/ kỹ thuật dạy học: Thực hành, hướng đích
3. Hình thức tổ chức hoạt động: Cá nhân
4. Phương tiện dạy học: SGK, giáo án, Phòng máy vi tính, máy chiếu
5. Sản phẩm: Tạo được cấu trúc bảng theo yêu cầu 

	Hoạt động của giáo viên
	Hoạt động của học sinh

	- Giới thiệu yêu cầu của bài tập 1
+ Khởi động Access
+ Tạo CSDL QuanLi_HS
+ Tạo bảng HOC_SINH
+ Lưu bảng HOC_SINH
+ Kết thúc Access
- Chiếu CSDL QuanLi_HS, bảng HOC_SINH để hướng đích cho HS. Chiếu mô tả của cấu trúc bảng để HS biết yêu cầu thực hiện
- Yêu cầu những HS đã hoàn thành tốt bài thực hành tiếp tục hướng dẫn cho các bạn còn lại
- Xác nhận kết quả của HS
+ Nhận xét, đánh giá kết quả của HS
+ Tiếp tục hướng dẫn những HS chưa hoàn thành
- Lưu ý cho HS: Đối với các trường Toan, Van để nhập được số thập phân có một chữ số sau dấu phẩy và luôn hiển thị dạng thập phân ta cần đặt tính chất của các trường này là:
+ Field Size: Decimal
+ Scale: 1
+ Decimal Place: 1
+ Input Mask: 9.9
- Nhắc lại các bước chính khi tạo bảng
- Trình chiếu kết quả cần đạt được lên màn hình và yêu cầu HS đối chiếu kết quả
- Nhắc HS lưu lại bảng
	
- Độc lập thực hiện trên máy. Thông báo với GV khi hoàn thành bài tập



C. HOẠT ĐỘNG VẬN DỤNG, TÌM TÒI, MỞ RỘNG
1. Mục tiêu: Giúp những học sinh có nhu cầu mở rộng thêm kiến thức của mình
2. Phương pháp/ kỹ thuật dạy học: Thuyết trình
3. Hình thức tổ chức hoạt động: Cá nhân, nhóm
4. Phương tiện dạy học: SGK, giáo án, mạng Internet
5. Sản phẩm: Học sinh phân tích, xác định được thông tin cần quản lý của CSDL quản lý mượn/trả sách ở một điểm cho thuê sách

	Hoạt động của giáo viên
	Hoạt động của học sinh

	- Giao nhiệm vụ cho học sinh về nhà dựa trên những kiến thức đã học., phân tích, xác định được thông tin cần quản lý của CSDL quản lý mượn/trả sách ở một điểm cho thuê sách	
	
- Về nhà thực hiện nhiệm vụ học tập



3. Hướng dẫn học ở nhà
- Thực hiện lại bài thực hành nếu có máy vi tính
- Xem trước nội dung, yêu cầu phần còn lại của bài thực hành

Tiết: 11, 12
BÀI TẬP VÀ THỰC HÀNH 2
TẠO CẤU TRÚC BẢNG
I. Mục tiêu:
1. Kiến thức:
- Biết khởi động và kết thúc Access.
- Biết tạo lập CSDL mới.
- Biết các thao tác cơ bản trên bảng.
2. Kĩ năng:
- Tạo cấu trúc bảng theo mẫu, chỉ định được khóa chính.
- Thực hiện được chính sửa và lưu cấu trúc bảng.
3. Thái độ:
- Học sinh hiểu bài và hứng thú với bài học.
- Học sinh say mê thực hiện thao tác.
4. Định hướng năng lực:
 Giải quyết vấn đề:
- Mô hình hóa các tình huống thực tiễn xảy ra.
- Mô phỏng được bảng.
II. Chuẩn bị của giáo viên và học sinh:
Chuẩn bị của giáo viên:
Giáo an, SGK Tin 12, máy tính, máy chiếu, các hình ảnh mô tả cho dữ liệu.
Chuẩn bị của học sinh:
SGK Tin 12, vở ghi.
III. Tổ chức các hoạt động học tập:
1. Ổn định lớp:
1.  Kiểm tra bài cũ: em hãy cho biết các kiểu dữ liệu sử dụng trong Access mà em biết.
1. Tiến hành bài học:
  Hoạt động 1: Tạo cấu trúc bảng 
1. Mục tiêu: học sinh biết được các kiểu dữ liệu.
1.  Phương pháp/kĩ thuật: Thuyết trình, mô tả.
1.  Hình thức tổ chức hoạt động: cá nhân hoặc nhóm.
1. Phương tiện dạy học: SGK, máy tính, máy chiếu.
1. Sản phẩm: học sinh tạo được cấu trúc bảng theo mẫu.
Nội dung hoạt động
	Hoạt động của giáo viên
	Hoạt động của học sinh

	GV: Chiếu bảng danh sách học sinh.

GV: Với bảng danh sách trên thì có bao nhiêu trường? đó là những trường nào?
GV: Nhận xét.



GV: Xác định kiểu dữ liệu của từng trường?
GV: Cho học sinh hoạt động nhóm. Phát phiếu học tập cho học sinh.
GV: Quan sát.
GV: Gọi đại diện nhóm lên báo cáo về cách xác định kiểu dữ liệu cho từng trường.
GV: Gọi các nhóm khác nhận xét.
GV: Nhận xét, bổ sung.
GV: Cho học sinh mở máy thực hiện khỏi động
 Access và tạo cấu trúc bảng.Sau khi tạo cấu trúc bảng xong cho hoc sinh lưu lại.
GV: Nêu Các cách khởi động Access?
GV: Để tạo cấu trúc bảng trước tiên ta phải tạo CSDL mới
GV: Nêu cách tạo CSDL mới?
GV: Nêu cách tạo cấu trúc bảng?
	




HS: trả lời










HS: Thực hiên.


HS: Lên thực hiện.




HS: TL 


HS: TL
HS: TL



Hoạt động 2: Xác định khóa chính
2. Mục tiêu: Học sinh biết được cách chọn khóa chính.
2. Phương pháo/kĩ thuật: Thuyết trình, mô tả.
2. Hình thức tổ chức hoạt động: Cá nhân hoặc nhóm.
2. Phương tiện dạy học: SGK, máy tính, máy chiếu.
2. Sản phẩm: học sinh tạo được khóa chính.
Nội dung hoạt động
	Hoạt động của GV
	Hoạt động của HS

	GV: Em hãy mở lại CSDL và chọn bảng HỌCSINH
GV: Với bảng dữ liệu trên thì các em chọn trường nào làm khóa chính?


GV: Em hãy cho biết cách chỉ định khóa chính trên bảng dữ liệu đã chọn?
GV: Bổ sung.
	HS: Thực hiện đúng thao tác.
HS: trường mã số làm khóa vì trừơng mã số là trường mà giá trị: của nó xác định duy nhất mỗi hàng của bảng.
HS: Trả lời và thao tác
HS: Quan sát, nhận xét.



	
Hoạt động 3: Tìm hiểu cách di chuyển trường, thêm trường.
(1) Mục tiêu: Học sinh biết được cách di chuyển trường.
(2) Phương pháo/kĩ thuật: Thuyết trình, mô tả.
(3) Hình thức tổ chức hoạt động: Cá nhân hoặc nhóm.
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu.
(5) Sản phẩm: Học sinh thực hiện đượccách di chuyển trường, thêm trường.

Nội dung hoạt động

	Hoạt động của GV
	Hoạt động của HS

	Thực hiện bài tập 3
GV: Muốn chuyển các trường sao cho hợp lý cần có những thao tác nào?
GV: - Nhận xét, bổ sung.
   Yêu cầu HS thực hiện
GV: Muốn chèn thêm thuộc tính cho đối tượng cần phải làm gì?
GV: Đưa ra yêu cầu: thêm các trường Li, Hoa, Tin vao bang hoc sinh?
GV: Nhắc HS duy chuyển các trường hợp lý để có thứ tự: Toan, Li, Hoa, Van, Tin.
GV: Yêu cầu HS lưu kết quả và thoát khỏi chương trình
GV:
+ Quan sát quá trình thực hiện của HS
+ Đi vào thực tế từng HS cụ thể để sửa và khắc phục những sai sót mà HS hay mắc phải.
+ Yêu cầu HS tắt máy trước khi ra khỏi phòng máy.
	
HS: Trả lời.



HS: Trả lời.

HS:Thực hiện





HS:Thực hiện



IV. Củng cố: 
· Nhắc lại các thao tác chính trong các bài tập.
· Chấm điểm cho một vài HS để biết kiến thức các em đạt được.
· Tổng kết đánh giá buổi thực hành.
+ Các mặt HS đạt được
+ Những sai sót mắc phải trong quá trình thực hiện bài tập và thao tác.
V. Nhiệm vụ về nhà:
	+ Xem trước bài số 5: Các thao tác trên bảng
		Yêu cầu:
- Các thao tác cập nhật dữ liệu như thế nào? Nêu thao tác đó?
- Lọc dữ liệu là gì? Có những cách nào?
- Thao tác tìm kiếm như thế nào?

Tiết: 13
BÀI 5. CÁC THAO TÁC CƠ BẢN TRÊN BẢNG

I. MỤC TIÊU:
1. Kiến thức:
 - Biết cách cập nhật dữ liệu: Thêm bản ghi mới, chỉnh sửa bản ghi, xóa bản ghi.
 - Biết cách sắp xếp dữ liệu tăng, giảm theo trường (ở chế độ hiển thị dạng bảng)
 - Biết cách lọc dữ liệu để lấy một số bản ghi thỏa mãn một số điều kiện.
    (lọc theo ô dữ liệu đang chọn và lọc theo mẫu).
 - Biết cách tìm kiếm các bản ghi theo giá trị của một trường.
     (hoặc một phần của trường)
 - Biết cách in dữ liệu từ bảng. 
2. Kĩ năng:
- Biết mở bảng ở chế độ trang dữ liệu;
- Biết cập nhật dữ liệu: Thêm bản ghi mới, chỉnh sửa, xoá bản ghi.
- Biết sắp xếp và lọc dữ liệu;
- Biết tìm kiếm đơn giản.
- Biết in dữ liệu.
3. Thái độ:
- Tư duy, khám phá, sáng tạo.
- Thái độ học tập nghiêm túc, cẩn thận và chính xác.
4. Định hướng hình thành năng lực
- Năng lực giải quyết vấn đề;
- Năng lực hợp tác;
- Năng lực sử dụng công nghệ thông tin;
II. CHUẨN BỊ CỦA GIÁO VIÊN VÀ HỌC SINH
1. Giáo viên: 
Thiết bị dạy học: máy tính, máy chiếu, …
Học liệu: CSDL mẫu, SGK, bài giảng, …
2. Học sinh: SGK, vở ghi chép, giấy nháp
III. TỔ CHỨC CÁC HOẠT ĐỘNG HỌC TẬP:
 1. Ổn định lớp: 
 2. Tiến trình bài học:  
A. KHỞI ĐỘNG:
Hoạt động 1: Tìm hiểu nhu cầu cập nhật dữ liệu 
(1) Mục tiêu: Tạo động cơ để HS có nhu cầu tạo, và thao tác với dữ liệu trong bảng. 
(2) Phương pháp/Kĩ thuật: Đàm thoại, phát hiện.
(3) Hình thức tổ chức hoạt động: Cá nhân, thảo luận nhóm.
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu, CSDL mẫu
(5) Sản phẩm: Học sinh có nhu cầu mong muốn được học thêm cách nhập, thêm, sửa, xóa dữ liệu trong bảng.
Nội dung hoạt động
	Hoạt động của GV
	Hoạt động của HS

	GV: Giao nhiệm vụ:
Chiếu bảng HỌC_SINH cho cả lớp theo dõi.
Hãy cho biết các bước để: (1) thêm bạn mới; (2) một bạn chuyển trường hoặc (3) một bạn sai điểm toán.
GV quan sát giúp đỡ học sinh gặp khó khăn.
GV nhận xét và chính xác lại
Để làm được các công việc đó ta cần phải nắm và thực hiện được các thao tác thêm, bớt hoặc sửa chữa nội dung các bản ghi còn gọi là cập nhật dữ liệu.
	HS: Nhận nhiệm vụ và thực hiện



Dự kiến câu trả lời của HS:
- Nếu thêm bạn mới ta phải thêm bản ghi mới. 
- Nếu một bạn chuyển trường ta có thể xóa bản ghi chứa thông tin về bạn đó.
- Nếu sai điểm toán thì phải sửa lại cho đúng.



B. HÌNH THÀNH KIẾN THỨC:
Hoạt động 2. Cập nhật dữ liệu: 
(1) Mục tiêu: Giúp HS hiểu ý nghĩa và cách thức để thực hiện các thao tác cập nhật dữ liệu. 
(2) Phương pháp/Kĩ thuật: Đàm thoại, phát hiện. Khai thác mối quan hệ giữa thực tiễn với tin học. 
(3) Hình thức tổ chức hoạt động: Làm việc cá nhân, thảo luận nhóm. 
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu. 
(5) Sản phẩm: Học sinh biết cách thao tác cập nhật dữ liệu: Thêm, sửa, xóa. 
Nội dung hoạt động 
	Hoạt động của GV
	Hoạt động của HS

	GV: Giao nhiệm vụ:
Yêu cầu HS thực hiện bằng các cách có thể: 


Mở bảng HỌC_SINH và thực 
hiện các thao tác sau:
- Bổ sung học sinh “Nguyễn Thị Thanh, sinh ngày 27/06/1991 với kết quả điểm các môn lần lượt là: 6,5; 8,1; 6,4; 7,1; 6,8; 7,2”. 
- Xóa học sinh "Lê Thị Hồng"
- Sửa điểm Toán của học sinh "Nguyễn Kim Cúc" từ 7,0 thành 7,5.





GV quan sát và giúp đỡ học sinh gặp khó khăn.


GVnhận xét và chính xác lại.
	HS: Nhận nhiệm vụ và thực hiện

Dự kiến câu trả lời của HS:
[image: ](1) Thêm bản ghi mới
- Chọn Insert New Record hoặc nháy nút trên thanh công cụ rồi nhập dữ liệu tương ứng vào các trường.
- Có thể nháy chuột trực tiếp vào bản ghi trống ở cuối bảng rồi gõ dữ liệu tương ứng.
(2) Xóa bản ghi
- Chọn bản ghi cần xóa
- Nháy nút [image: ] hoặc nhấn phím Delete.
- Chọn Yes.
(3) Chỉnh sửa
Nháy chuột vào ô chứa dữ liệu, thực hiện các thay đổi cần thiết.
HS thực hiện được các thao tác theo yêu cầu


Hoạt động 3: Sắp xếp và lọc dữ liệu 
(1) Mục tiêu: Giúp HS hiểu ý nghĩa, các bước để sắp xếp và lọc dữ liệu với những điều kiện cụ thể, thường gặp trong thực tiễn. 
(2) Phương pháp/Kĩ thuật: Đàm thoại, phát hiện. Khai thác mối quan hệ giữa thực tiễn với tin học. 
(3) Hình thức tổ chức hoạt động: Cá nhân, Đàm thoại; Thảo luận nhóm. 
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu. 
(5) Sản phẩm: Học sinh biết cách thao tác sắp xếp và lọc dữ liệu. 
Nội dung hoạt động 
	Hoạt động của GV
	Hoạt động của HS

	 GV: Giao nhiệm vụ:
Muốn sắp xếp các bản ghi theo thứ tự khác với thứ tự chúng được nhập, theo các em ta có các bước nào để thực hiện?
GV:quan sát và giúp đỡ học sinh gặp khó khăn.
GV:nhận xét và chính xác lại
GV: Giao nhiệm vụ:
Để sắp xếp bản ghi theo tên tăng dần, ta có bước nào?
GV quan sát giúp đỡ học sinh gặp khó khăn.

GV nhận xét và chính xác lại

GV: Giao nhiệm vụ:
 Tìm hiểu và cho biết:
· Lọc theo ô dữ liệu đang chọn.
· Lọc theo mẫu. 


GV quan sát giúp đỡ học sinh gặp khó khăn.


GV nhận xét và chính xác lại
	HS: Nhận nhiệm vụ và thực hiện
Dự kiến câu trả lời của HS:
- Chọn trường cần sắp xếp
- Dùng các nút lệnh [image: ] (tăng) hoặc [image: ] (giảm) để sắp xếp
- Lưu lại kết quả sắp xếp.

HS: Nhận nhiệm vụ và thực hiện

Dự kiến câu trả lời của HS:
- Chọn trường tên[image: ]

- Nhấy nút     
- Lưu kết quả sắp xếp.


HS: Nhận nhiệm vụ và thực hiện

Dự kiến câu trả lời của HS:
HS thực hiện lại được
- Lọc theo ô dữ liệu: Chọn [image: ]

ô và nháy vào nút      
- Lọc theo mẫu: [image: ]

B1: Nháy nút            
rồi nhập điều kiện vào từng trường tương ứng theo mẫu.
B2: Nháy nút  [image: ]  để lọc hoặc trở về dữ liệu ban đầu



Hoạt động 4. Tìm kiếm đơn giản và in dữ liệu 
(1) Mục tiêu: Giúp HS biết cách tìm kiếm dữ liệu và biết in dữ liệu từ bảng 
(2) Phương pháp/Kĩ thuật: Đàm thoại, phát hiện. 
(3) Hình thức tổ chức hoạt động: Cá nhân, Đàm thoại; Thảo luận nhóm. 
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu. 
(5) Sản phẩm: Học sinh biết cách tìm kiếm và in dữ liệu từ bảng 
Nội dung hoạt động 
	Hoạt động của GV
	Hoạt động của HS

	GV:giao nhiệm vụ:
  HS tìm hiểu và cho biết:
- Các cách tìm kiếm đơn giản.
- Thay thế
- In dữ liệu.
GV quan sát giúp đỡ học sinh gặp khó khăn.

GVnhận xét và chính xác lại






GV: Sử dụng chức năng In ấn dữ liệu tương tự như trong phần mềm Word.
	HS: Nhận nhiệm vụ và thực hiện




Dự kiến câu trả lời của HS:
- Các cách có thể sử dụng để tìm kiếm dữ liệu: Sử dụng menu Edit Find; Tổ phím Ctrl+F hoặc sử dụng công cụ tìm kiếm.
- Gõ nội dung cần tìm vào hộp Find What
- Lựa chọn cách thức tìm kiếm.
- Nháy nút Find next để tìm kiếm.

- Có thể in dữ liệu từ bảng. Việc thiết đặt trang in và xem trước khi in thực hiện tương tự như Word.


C. LUYỆN TẬP, VẬN DỤNG: (9 phút) 
(1) Mục tiêu: Giúp HS nhận dạng thực hiện việc cập nhật dữ liệu với những kiện cụ thể, thường gặp trong thực tiễn.  
(2) Phương pháp/Kĩ thuật: Đàm thoại, Khai thác mối quan hệ giữa thực tiễn với tin học 
(3) Hình thức tổ chức hoạt động: Thực hành trên máy. 
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu. 
(5) Sản phẩm: Học sinh biết vận dụng kiến thức đã học vào giải quyết tình huống thực tiễn.
Nội dung hoạt động
	Hoạt động của GV
	Hoạt động của HS

	GV: Chia lớp ra làm 4 nhóm.
GV: Giao nhiệm vụ:
Sử dụng bảng HOC_SINH đã được tạo cấu trúc trong bài thực hành 2:
 Nhóm 1:
1. Thêm 5 bản ghi vào bảng HOC_SINH, thực hiện bằng các cách đã học.
Nhóm 2:
2. Sắp xếp giảm dần theo điểm Toán. Sắp xếp tăng dần theo tổ.
Nhóm 3:
3. Lọc ra danh sách học sinh nữ.
4.Lọc ra học sinh Nam ở tổ 1.
Nhóm 4:
5. Tìm trong bảng có bao nhiêu bạn có tên là An, tìm có bao nhiêu bạn có tên bắt đầu là T, tìm có bao nhiêu bạn trong tên có kí tự N bất kỳ.
GV quan sát thảo luận của các nhóm và hỗ trợ HS khi cần thiết.
	HS: Nhận nhiệm vụ và thực hiện



Các nhóm nhận phiếu học tập do GV phát và thực hiện theo nội dung được giao.



Các nhóm thảo luận, trao đổi, ghi các cách thực hiện nội dung được giao vào phiếu học tập.



HS các nhóm báo cáo kết quả sau khi đã thảo luận và nhận xét nhau.

.



D. HƯỚNG DẪN HỌC Ở NHÀ: (1 phút)
- Xem lại hay thực hành lại các thao tác đã học của bài.
- Trả lời các câu hỏi sau bài học.
- Chuẩn bị nội dung cho bài thực hành 3: THAO TÁC TRÊN BẢNG


Tiết: 14,15
BÀI TẬP VÀ THỰC HÀNH 3
THAO TÁC TRÊN BẢNG
I. MỤC TIÊU:
   1. Kiến thức:
- Thực hiện được các thao tác cơ bản trên bảng, làm việc với cả bảng trong cả hai chế độ.
- Sử dụng các công cụ lọc, sắp xếp để kết xuất thông tin từ bảng.
        - Thực hiện thao tác tìm kiếm thông tin trong bảng.
2. Kĩ năng:
Luyện kĩ năng thao tác trên bảng.
3. Thái độ: 
· Tư duy, khám phá, sáng tạo.
· Thái độ học tập nghiêm túc, cẩn thận và chính xác.
4. Định hướng hình thành năng lực: 
- Năng lực giải quyết vấn đề.
- Năng lực sử dụng công nghệ thông tin.
- Năng lực hợp tác.
    II. CHUẨN BỊ CỦA GIÁO VIÊN VÀ HỌC SINH
1. Chuẩn bị của giáo viên
· Thiết bị dạy học: Máy tính, máy chiếu. 
· Học liệu: Giáo án, SGK, phiếu học tập.
2. Chuẩn bị của học sinh
· SGK, vở ghi, giấy nháp.
· Chuẩn bị bài cũ và xem trước các nội dung liên quan đến bài thực hành mới.
III. TỔ CHỨC CÁC HOẠT ĐỘNG HỌC TẬP:
1. Ổn định lớp 
2. Tiến trình bài học:
A. KHỞI ĐỘNG:
Hoạt động 1: Kiểm tra bài cũ 
(1) Mục tiêu: kiểm tra kiến thức của tiết học trước về các thao tác cơ bản trên bảng.
(2) Phương pháp/ kĩ thuật: vấn đáp.
(3) Hình thức tổ chức hoạt động: cá nhân
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu
(5) Sản phẩm: học sinh nêu được các thao tác cơ bản trên bảng.
                Nội dung hoạt động
GV đưa ra câu hỏi:
1. Nêu các thao tác cập nhật dữ liệu? Trình bày các cách của các thao tác cập nhật?
2. Trình bày các thao tác: Sắp xếp, lọc, tìm kiếm và thay thế? 
HS trả lời các câu hỏi.
GV nhận xét, ghi điểm.
B. HÌNH THÀNH KIẾN THỨC VÀ LUYỆN TẬP
Hoạt động 2: Tìm hiểu và thực hành: cách cập nhật dữ liệu 
(1) Mục tiêu: HS biết được các cách cập nhật dữ liệu.
(2) Phương pháp/kĩ thuật: đàm thoại, phát hiện.
(3) Hình thức tổ chức hoạt động: cá nhân và thảo luận nhóm.
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu
(5) Sản phẩm: HS thực hiện được các thao tác cập nhật dữ liệu theo yêu cầu của bài 1.
	Hoạt động của GV
	Hoạt động của HS

	(GV chia lớp thành nhiều nhóm, mỗi nhóm 3 HS)
Mở bảng HỌC_SINH đã tạo ở bài thực hành số 2 và thực hiện:
GV giao nhiệm vụ
 Các em hãy tìm hiểu nội dung Bài 1 (trong sách giáo khoa trang 48) và thực hành theo nội dung của bài 1.
 

-GV quan sát HS các nhóm thực hành và hỗ trợ HS khi cần thiết.


-GV quan sát HS đại diện nhóm thực hành và xem nội dung phiếu học tập để nhận xét, đánh giá kết quả của HS và chính xác hóa các kiến thức mà học sinh đã được thông qua hoạt động.
	

HS nhận nhiệm vụ và thực hiện
- HS đọc Bài 1 (trong sách giáo khoa trang 48) và thực hành theo nội dung bài 1.

- HS các nhóm thảo luận, thực hành và ghi cách thực hiện vào phiếu học tập.

- Đại diện các nhóm lên máy chiếu thực hành bài 1 và các nhóm khác nhận xét nhau.




Hoạt động 3: Tìm hiểu và thực hành: các cách lọc dữ liệu 
(1) Mục tiêu: HS biết được cách lọc dữ liệu theo ô dữ liệu đang chọn và lọc dữ liệu theo mẫu.
(2) Phương pháp/kĩ thuật: đàm thoại, phát hiện.
(3) Hình thức tổ chức hoạt động: cá nhân và thảo luận nhóm.
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu
(5) Sản phẩm: HS lọc được dữ liệu theo yêu cầu của bài 2. 
	Hoạt động của GV
	Hoạt động của HS

	-GV giao nhiệm vụ

Các em hãy tìm hiểu nội dung Bài 2 (trong sách giáo khoa trang 48) và thực hành theo nội dung của bài 2.
 
- GV quan sát HS các nhóm thực hành và hỗ trợ HS khi cần thiết.


- GV quan sát HS đại diện nhóm thực hành và xem nội dung phiếu học tập để nhận xét, đánh giá kết quả của HS và chính xác hóa các kiến thức mà học sinh đã được thông qua hoạt động.
	HS nhận nhiệm vụ và thực hiện
- HS đọc Bài 2 (trong sách giáo khoa trang 48) và thực hành theo nội dung bài 2.


- HS các nhóm thảo luận, thực hành và ghi cách thực hiện và phiếu học tập.


- Đại diện các nhóm lên máy chiếu thực hành bài 2 và các nhóm khác nhận xét nhau.



Hoạt động4: Tìm hiểu và thực hành: Sắp xếp dữ liệu 
(1)Mục tiêu: HS biết được cách sắp xếp dữ liệu theo các tiêu chí khác nhau. 
(2) Phương pháp/kĩ thuật: đàm thoại, phát hiện.
(3) Hình thức tổ chức hoạt động: cá nhân và thảo luận nhóm.
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu
(5) Sản phẩm: HS sắp xếp được dữ liệu theo yêu cầu của bài 3. 
	Hoạt động của GV
	Hoạt động của HS

	- GV giao nhiệm vụ

Các em hãy tìm hiểu nội dung Bài 3 (trong sách giáo khoa trang 49) và thực hành theo nội dung của bài 3.
 
- GV quan sát HS các nhóm thực và hỗ trợ HS khi cần thiết.

- GV quan sát HS đại diện thực hành và xem nội dung phiếu học tập để nhận xét, đánh giá kết quả của HS và chính xác hóa các kiến thức mà học sinh đã được thông qua hoạt động.
	HS nhận nhiệm vụ và thực hiện
- HS đọc Bài 3 (trong sách giáo khoa trang 49) và thực hành theo nội dung bài 3.


- HS các nhóm thảo luận, thực hành và ghi cách thực hiện và phiếu học tập.

- Đại diện các nhóm lên máy chiếu thực hành bài 3 và các nhóm khác nhận xét nhau.




Hoạt động 5: Tìm hiểu và thực hành: Tìm kiếm đơn giản. 
(1)Mục tiêu: HS biết được các cách tìm kiếm đơn giản.
(2)Phương pháp/kĩ thuật: đàm thoại, phát hiện.
(3)Hình thức tổ chức hoạt động: cá nhân và thảo luận nhóm.
(4)Phương tiện dạy học: SGK, máy tính, máy chiếu
 (5)Sản phẩm: HS tìm kiếm được dữ liệu theo yêu cầu của bài 4. 
	Hoạt động của GV
	Hoạt động của HS

	- GV giao nhiệm vụ

Các em hãy tìm hiểu nội dung Bài 4 (trong sách giáo khoa trang 49) và thực hành theo nội dung của bài 4.

- GV quan sát HS các nhóm thực hành và hỗ trợ HS khi cần thiết.

- GV quan sát HS đại diện thực hành và xem nội dung phiếu học tập để nhận xét, đánh giá kết quả của HS và chính xác hóa các kiến thức mà học sinh đã được thông qua hoạt động.
	HS nhận nhiệm vụ và thực hiện
- HS đọc Bài 4 (trong sách giáo khoa trang 49) và thực hành theo nội dung bài 4.


- HS các nhóm thảo luận, thực hành và ghi các cách thực hiện và phiếu học tập.

- Đại diện các nhóm lên máy chiếu thực hành bài 4 và các nhóm khác nhận xét nhau.



C. VẬN DỤNG –MỞ RỘNG: 
(1) Mục tiêu: HS thực hành được các tình huống xảy ra trong thực tiễn.  
(2) Phương pháp/Kĩ thuật: Đàm thoại, Khai thác mối quan hệ giữa thực tiễn với tin học 
(3) Hình thức tổ chức hoạt động: Thực hành trên máy. 
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu. 
(5) Sản phẩm: Học sinh biết vận dụng kiến thức đã học vào giải quyết tình huống thực tiễn.
Nội dung hoạt động
	Hoạt động của GV
	Hoạt động của HS

	GV: Giao nhiệm vụ:
Phát phiếu học tập:

1. Thêm 3 bản ghi vào bảng HOC_SINH, thực hiện bằng các cách đã học.
2. Xóa bản ghi bằng các cách.

3. Lọc ra danh sách học sinh nữ ở tổ 1.
4. Sắp xếp tăng dần theo tổ.
5. Tìm trong bảng có bao nhiêu bạn có tên là Sơn, tìm có bao nhiêu bạn có tên bắt đầu là H, tìm có bao nhiêu bạn có kí tự a bất kỳ trong tên.

- GV quan sát HS các nhóm thực hành và hỗ trợ HS khi cần thiết.
- GV quan sát HS đại diện thực hành và xem nội dung phiếu học tập để nhận xét, đánh giá kết quả của HS và chính xác hóa các kiến thức mà học sinh đã được thông qua hoạt động.
	HS: Nhận nhiệm vụ và thực hiện




- Các nhóm thảo luận, thực hành và ghi cách thực hiện vào phiếu học tập theo nội dung được giao.




- Đại diện các nhóm lên máy chiếu thực hành và các nhóm khác nhận xét nhau.


.


D. HƯỚNG DẪN HỌC Ở NHÀ: 
- Xem lại hay thực hành lại các thao tác đã học của bài.
- Đọc trước bài 6: BIỂU MẪU.


Tiết: 16
BÀI 6. BIỂU MẪU
I. Mục tiêu:
· Hiểu khái niệm biểu mẫu, công dụng của biểu mẫu.
· Biết các thao tác để tạo biểu mẫu và chỉnh sửa biểu mẫu bằng cách dùng thuật sĩ, bằng cách tự thiết kế và kết hợp cả hai cách trên.
· Biết các chế độ làm việc với biểu mẫu: chế độ trang dữ liệu, chế độ thiết kế, chế độ biểu mẫu.
· Biết sử dụng biểu mẫu để cập nhật dữ liệu.
II. Chuẩn bị của giáo viên và học sinh:
· Giáo viên: sách giáo viên, sách giáo khoa, tài liệu về Access, Hướng dẫn thực hiện chuẩn kiến thức, kĩ năng môn Tin học THPT.	
· Học sinh: sách giáo khoa.
III. Phương pháp:
· Thuyết trình
· Đàm thoại
· Nêu vấn đề
IV. Hoạt động dạy- học:
1. Ổn định lớp
2. Kiểm tra bài cũ: không.
3. Tiến trình tiết dạy:
A. HOẠT ĐỘNG KHỞI ĐỘNG
(1) Mục tiêu: Tạo động cơ để HS có nhu cầu sử dụng đối tượng biểu mẫu.
(2) Phương pháp/kĩ thuật dạy học: Đàm thoại, phát hiện. khai thác mối quan hệ giữa thực tiễn với tin học.
(3) Hình thức tổ chức: Làm việc cá nhân, Thảo luận nhóm.
(4) Phương tiện dạy học: SGK, Máy tính, máy chiếu.
(5) Sản phẩm: HS phân tích được ưu điểm khi sử dụng đối tượng biểu mẫu.
Nội dung hoạt động
Cho 2 giao diện sau:
[image: ]
(H1)
[image: ]
(H2)
	Hoạt động của giáo viên
	Hoạt động của học sinh 

	Em thích nhập dữ liệu với giao diện nào hơn, tại sao?

H2 có ưu điểm hơn.
- Giao diện khung nhìn dễ nhập dữ liệu.
- Hiện 1 bản ghi thuận tiện để xem, nhập, sửa dữ liệu. H2 là đối tượng biểu mẫu.
- Thực hiện các thao tác nhập dữ liệu, xem, sửa dữ liệu bằng biểu mẫu hocsinh đã tạo trước trong Access.
	-HS1: H1, quen nhập dữ liệu trên bảng.
-HS2: H2, nhập dữ liệu cho từng trường có tên trường bên cạnh chỉ dẫn nhập dữ liệu dễ dàng kiểm soát hơn.


B. HÌNH THÀNH KIẾN THỨC VÀ LUYỆN TẬP
Hoạt động 1: Khái niệm
(1)Mục tiêu: Năm được ưu điểm của Form.
(2)Phương pháp/kĩ thuật dạy học: Đàm thoại, phát hiện. khai thác mối quan hệ giữa thực tiễn với tin học.
(3)Hình thức tổ chức: Làm việc cá nhân, Thảo luận nhóm.
(4)Phương tiện dạy học: SGK, Máy tính, máy chiếu.
(5)Sản phẩm: thấy được ưu điểm của Form khi sử dụng vào bài toán quản lí trong thực tiễn.
 Nội dung hoạt động
Biểu mẫu là một công cụ trong Access, dựa trên Table/Query để:
· Hiển thị dữ liệu của Table/Query dưới dạng thuận lợi để xem, nhập, và sửa dữ liệu
· Thực hiện các thao tác thông qua các nút lệnh do người dùng tạo ra.
	Hoạt động của giáo viên
	Hoạt động của học sinh 

	- Biểu mẫu cho phép ta thực hiện được công việc gì ?
+ Đưa ra khái niệm về biểu mẫu 
-Nêu sự khác nhau về hiển thị giữa bảng và biểu mẫu.
+ Từ câu trả lời của học sinh, giáo viên trình bày và giải thích rõ về sự khác nhau giữa bảng và biểu mẫu  trong hiển thị dữ liệu (chú ý : biểu mẫu cũng có thể hiển thị nhiều bản ghi giống như bảng và dữ liệu nguồn cho biểu mẫu cũng có thể là mẫu hỏi).
	


- Học sinh dựa vào những hiểu biết trước đó và dựa vào sách giáo khoa để trả lời.


- Học sinh nghe giảng và ghi chép các ý chính vào vở ghi chép.



Hoạt động 2: Tạo biểu mẫu mớiMục tiêu: HS biết thiết kế biểu mẫu.
(1) Phương pháp/kĩ thuật dạy học: Đàm thoại, phát hiện. khai thác mối quan hệ giữa thực tiễn với tin học.
(2) Hình thức tổ chức: Làm việc cá nhân, Thảo luận nhóm.
(3) Phương tiện dạy học: SGK, Máy tính, máy chiếu.
(4) Sản phẩm: HS phải tạo ra được thiết kế biểu mẫu.
[bookmark: OLE_LINK1][bookmark: OLE_LINK2] Nội dung hoạt động
Có 2 cách tạo biễu mẫu mới:
· Phương pháp làm theo từng bước hướng dẫn của Access (Wizard)
· Phương pháp tự thiết kế (Design)
* Phương pháp tạo Form theo từng bước hướng dẫn của Access (Wizard):
 Tạo Form trên một Table:

	Hoạt động của giáo viên
	Hoạt động của học sinh 

	Ví dụ 1: Từ Table DSHV hãy tạo Form chứa các trường của bảng DSHS.

Gv nhận xét nhóm HS trình bày và thao tác lại từng bước cho HS ghi bài.

	- HS thảo luận nhóm để làm tạo Form DSHS.
· - Học sinh quan sát nhóm được gọi trình bày.
· - HS nghe giảng và ghi chép các ý chính vào vở.




B1: Kích vào đối tượng Form, kích đúp vào lệnh , Ở khung Tables/Queries chọn table nguồn: DSHS 
B2: Tùy theo yêu cầu trong Form chứa trường nào  của Table nguồn? để chọn trường vào khung Select Field (chọn trường). Kích dấu >> để chọn hết trường của Table vào Form ( nếu muốn chọn từng trường 1, chọn trường muốn đưa vào Form kích vào dấu >)
B3: Kích vào Next để tiếp tục, xuất hiện , cho phép chọn cách trình bày của Form, chọn dạng cột (Columnar), kích vào Next để tiếp tục xuất hiện cho phép chọn nền của biểu mẫu, chọn International (nền của Form là hình quả địa cầu)  kích vào Next xuất hiện cửa sổ , đặt tên cho Form: DANH SACH HS  kích vào Finish để kết thúc. 
B4: Đóng cửa sổ Form chọn Yes để đồng ý lưu.
C. HOẠT ĐỘNG TÌM TÒI MỞ RỘNG
(1)Mục tiêu: giúp những HS có nhu cầu mở rộng thêm kiến thức của mình.
(2)Phương pháp/kĩ thuật dạy học: Làm việc cá nhân, Thảo luận nhóm.
(3)Hình thức tổ chức: Ngoài lớp học đang xen trong tiết thực hành 22, của bài thực hành 4.
(4)Phương tiện dạy học: SGK, Máy tính, máy chiếu.
(5)Sản phẩm: HS biết mở rộng kiến thức của mình qua bài toán thực tế.
Nội dung hoạt động
Tạo form trên nhiều Table bằng Wizard:
Trên tệp Quanlyhocsinh.mdb. 
Để hiển thị thông tin về một học sinh (ở DSHS) và các môn thi của học sinh đó (BANG_DIEM) ta cần xây dựng Form chính – Main Form (Form ở đầu 1 trên table DSHS) và form phụ - Sub Form(Form ở đầu nhiều trên table BANG_DIEM) để nhập dữ liệu cho cả 02 Table : DSHS và BANG_DIEM (thay vì phải nhập riêng lẻ từng Table một). 
B1: Làm tương tự như ở trên, nhưng ở cửa sổ chọn Table nguồn , ta phải lần lượt chọn 02 table liên tiếp theo thứ tự như sau:
Table nào ở đầu 1 thì chọn trước, ở đây ta chọn :
Lần 1: Chọn tất cả các trường của DSHS sang khung chọn trường bên phải 
Lần 2: Chọn các trường của BANG_DIEM, và kích vào Next để tiếp tục
B2: chọn Table DSHS : chi phối biểu mẫu BANG_DIEM, kích vào Next
B3: Chọn kiểu Internetional (quả địa cầu làm ảnh nền cho Form-thường kích chọn Standard), kích vào Next, nhập tên cho form: F_TONGHOP, Access cho biết form phụ là BANG_DIEM (BANG_DIEM Subform). Kích vào Finish để kết thúc.
E. Nội dung câu hỏi củng cố chủ đề Form
(1)Mục tiêu: giúp những HS hệ thống kiến thức chủ đề Form.
(2)Phương pháp/kĩ thuật dạy học: Làm việc cá nhân, Thảo luận nhóm.
(3)Phương tiện dạy học: SGK, Máy tính, máy chiếu.
(5)Sản phẩm: HS trả lời phiếu câu hỏi và qua đó HS củng cố kiến thức bài học.
Nội dung hoạt động
Câu 1: Để tạo biểu mẫu ta chọn đối tượng nào trên bảng chọn đối tượng? 
A. Queries		B. Forms		C. Tables		D. Reports
Câu 2: Trong Access, ta có thể sử dụng biểu mẫu để :
A. Tính toán cho các trường tính toán	B. Sửa cấu trúc bảng
C. Xem, nhập và sửa dữ liệu			D. Lập báo cáo
Câu 3: Để tạo biểu mẫu, trước đó phải có dữ liệu nguồn là từ:
A. Bảng hoặc mẫu hỏi				B. Bảng hoặc báo cáo
C. Mẫu hỏi hoặc báo cáo			D. Mẫu hỏi hoặc biểu mẫu
Câu 4: Trong Access, muốn tạo biểu mẫu theo cách dùng thuật sĩ, ta chọn:
A. Create form for using Wizard		B. Create form by using Wizard
C. Create form with using Wizard		D. Create form in using Wizard
Câu 5: Trong Access, muốn tạo biểu mẫu theo cách tự thiết kế, ta chọn:
A. Create form in Design View		B. Create form by using Wizard
C. Create form with using Wizard		D. Create form by Design View
Câu 6: Cho các thao tác:
	(1) Gõ tên cho biểu mẫu rồi nháy Finish
	(2) Chọn đối tượng Form trong bảng chọn đối tượng rồi nháy đúp vào Create form by using wizard
	(3) Chọn kiểu cho biểu mẫu rồi nhấn Next
	(4) Chọn cách bố trí biểu mẫu rồi nhấn Next
	(5) Trong hộp thoại Form Wizard, chọn bảng (hoặc mẫu hỏi) từ ô Tables/Queries, tiếp theo là chọn các trường đưa vào biểu mẫu rồi nhấn Next
Trình tự các thao tác để có thể thực hiện tạo biểu mẫu bằng cách dùng thuật sĩ sẽ là:
A (2)  (5)  (3)  (4)  (1)			B. A (2)  (5)  (4)  (3)  (1)
C. (5)  (2)  (3)  (4)  (1)			D. A (2)  (3)  (4)  (5)  (1)
Câu 7: Chỉnh sửa biểu mẫu (thay đổi hình thức biểu mẫu) chỉ thực hiện được ở chế độ:
A. Thiết kế		B. Trang dữ liệu		C. Biểu mẫu		D. Thuật sĩ
Câu 8: Phát biểu nào trong các phát biểu sau là sai?
A. Chế độ biểu mẫu có giao diện thân thiện, thường được sử dụng để cập nhật dữ liệu
B. Bảng ở chế độ hiển thị trang dữ liệu có thể được sử dụng để cập nhật dữ liệu
C. Để làm việc trên cấu trúc của biểu mẫu thì biểu mẫu phải ở chế độ thiết kế
D. Có thể tạo biểu mẫu bằng cách nhập dữ liệu trực tiếp (nháy đúp vào Create form by entering data)
Câu 9: Thao tác nào sau đây có thể thực hiện được trong chế độ biểu mẫu?
A. Thêm một bản ghi mới			B. Định dạng font chữ cho các trường dữ liệu
C. Tạo thêm các nút lệnh			D. Thay đổi vị trí các trường dữ liệu 
- Dặn dò: Các em chuẩn bị cho bài thực hành 4

Tiết: 17,18
BÀI THỰC HÀNH SỐ 4.
TẠO BIỂU MẪU ĐƠN GIẢN
I. MỤC TIÊU
1. Kiến thức
+ Tạo biểu mẫu; Chỉnh sửa biểu mẫu trong chế độ thiết kế.
					+ Nhập dữ liệu cho bảng bằng biểu mẫu.
					+ Cập nhật, tìm kiếm thông tin trong chế độ trang dữ liệu của biểu mẫu.
	+ Học sinh biết: Sắp xếp, lọc và tìm kiếm dữ liệu trên bảng qua biểu mẫu.
2. Kĩ năng:
+ Luyện kĩ năng thao tác trên bảng;
				+ Sử dụng các công cụ và thanh bảng chọn. 
+ Thực hiện được các thao tác sắp xếp, lọc và tìm kiếm thông tin qua biểu mẫu.
3. Thái độ
+ Nghiêm túc trong quá trình làm thực hành.
4. Định hướng hình thành năng lực
- Năng lực giải quyết vấn đề;
- Năng lực làm việc cộng tác;
II. PHƯƠNG PHÁP DẠY HỌC, PHƯƠNG TIỆN CHỦ YẾU
          - Cho HS tự thao tác để tạo được biểu mẫu
- Diễn giải, vấn đáp.
-  Dạy học theo định hướng phát triển năng lực học sinh
- Sử dụng máy chiếu, slide bài giảng, SGK, máy tính 
III. CHUẨN BỊ 
1- Giáo viên: SGK, SGV, phòng máy để thực hành. 
2- Học sinh: SGK, vở soạn và vở ghi nội dung bài thực hành.
IV. TỔ CHỨC CÁC HOẠT ĐỘNG
A. Khởi động
Hoạt động 1: Kiểm tra bài cũ
(1) Mục tiêu: Nắm được các bước để tạo biểu mẫu bằng thuật sĩ
(2) Phương pháp/Kĩ thuật:   Viết bảng
(3) Hình thức tổ chức hoạt động: Cá nhân 
(4) Phương tiện dạy học: SGK, máy chiếu, máy tính
(5) Sản phẩm:  Trình bày được các bước để tạo biểu mẫu
Nội dung hoạt động:
1. Nháy đúp Create form by using wizard;
2. Trong hộp thoại Form Wizard (h. 36): 
Chọn bảng (hoặc mẫu hỏi) từ ô Tables/Queries;
Chọn các trường đưa vào mẫu hỏi từ ô Available Fiels;
Nháy Next để tiếp tục.
Trong các bước tiếp theo, chọn bố cục biểu mẫu (h. 37), chẳng hạn dạng Cột (Columnar) rồi chọn kiểu cho biểu mẫu, chẳng hạn kiểu Chuẩn (Standard) (h. 38).
Trong bước cuối cùng, có thể gõ tên mới cho biểu mẫu (h. 39). Đánh dấu chọn Open the form to view or enter information để xem hoặc nhập dữ liệu hoặc chuyển sang chế độ thiết kế để tiếp tục sửa (chọn Modify the form’s design). Cuối cùng nháy Finish.  Ta đã có biểu mẫu dạng cột có dạng như hình 39.
HS lên bảng thực hiện
GV: gọi HS khác nhận xét
GV: nhận xét và cho điểm
B. HÌNH THÀNH KIẾN THỨC MỚI VÀ LUYỆN TẬP
Hoạt động 2: Sử dụng CSDL Quanli_HS trong “bài tập và thực hành số 3”Tạo biểu mẫu để nhập dữ liệu cho bảng HOC_SINH theo mẫu:
[image: ]
(1) Mục tiêu: 
- Biết cách tạo  biểu mẫu bằng thuật sĩ và chỉnh sửa biểu mẫu trong chế độ thiết kế
	(2) Phương pháp/ Kỹ thuật: đàm thoại, vấn đáp, thực hành trên máy tính
	(3) Hình thức tổ chức hoạt động: Cá nhân và thảo luận nhóm ( Có thể phát huy năng lực của những học sinh khá, giỏi thực hành tốt hướng dẫn cho các bạn yếu, kém)
	(4) Phương tiện dạy học: SGK, máy tính, máy chiếu
	(5) Sản phẩm: Học sinh tạo và chỉnh sửa được biểu mẫu theo mẫu
	Hoạt động của GV
	Hoạt động của HS

	GV: Các bước để tạo được biểu mẫu theo mẫu 
[image: ]
GV: Hỏi bảng dữ liệu nguồn dùng để tạo biểu mẫu là bảng nào?
GV: Để tạo được biểu mẫu theo mẫu như trên ta cần đưa những trường nào vào biểu mẫu?
GV: Để chỉnh sửa biểu biễu ta thực hiện trong chế độ làm việc nào
Ta chuyển sang chế độ thiết kế (h. 41) để thay đổi hình thức biểu mẫu. 
[image: ]
Hình 1
Tại đây ta có thể thực hiện:
Thay đổi nội dung các tiêu đề;
Sử dụng phông chữ tiếng Việt; 
Thay đổi kích thước trường (thực hiện khi con trỏ có dạng mũi tên hai đầu như các hình 41a và 41b); 
Di chuyển vị trí các trường (thực hiện khi con trỏ có dạng bàn tay như hình 41c),...
[image: ]               [image: ]             [image: ]
a)                                b)                                  c)
Hình 2
Sau khi thay đổi, nháy nút [image: ] để lưu biểu mẫu.
GV: Nhận xét kết quả thực hành của HS

	HS nhận nhiệm vụ và thực hiện
Gồm 2 bước:
Bước 1: sử dụng thuật sĩ tạo biểu mẫu
Bước 2: Chỉnh sữa tiêu đề và kích thước của các trường trong biểu mẫu ở chế độ thiết kế



HS: bảng HOC_SINH

HS: maso, hodem, ten,gioitinh, ngaysinh,doanvien,diachi,to,toan,li,hoa,van,tin




HS: Chỉnh sửa trong chế độ thiết kê
Vieww  design view



Hoạt động 3: Sử dụng biểu mẫu vừa tạo để nhập thêm các bản ghi cho bảng theo mẫu sau:
[image: ]

(1) Mục tiêu: 
- Biết cách nhập dữ liệu trên biểu mẫu
	(2) Phương pháp/ Kỹ thuật: thực hành trên máy tính
	(3) Hình thức tổ chức hoạt động: Cá nhân và thảo luận nhóm
	(4) Phương tiện dạy học: SGK, máy tính, máy chiếu
	(5) Sản phẩm: Học sinh nhập được dữ liệu trên biểu mẫu vừa tạo và biết được các nút lệnh trên biểu mẫu
[image: ]

	Hoạt động của GV
	Hoạt động của HS

	GV: Để nhập dữ liệu cho biểu mẫu ta làm việc ở chế độ nào?
GV: yêu cầu HS nghiêm túc thực hành 
GV: Giới thiệu các nút lệnh trong biểu mẫu
[image: ]
Nút lệnh [image: ]  Quay về bản ghi đầu tiên
Nút lệnh [image: ] Quay về trước bản ghi hiện tại 1 bản ghi
Nút lệnh  [image: ]  bản ghi hiện tại đang là bản ghi số 1
Nút lệnh [image: ]: Di chuyển về sau bản ghi hiện tại
Nút lệnh [image: ]  Quay về bản ghi cuối cùng

Nút lệnh [image: ]: Thêm vào bản ghi mới

[image: ] : Tổng số bản ghi trong biểu mẫu

GV: Nhận xét kết quả thực hành của HS
	HS:  chế độ biểu mẫu View  form  view

HS: Nghiêm túc thực hành



C. VẬN DỤNG
Hoạt động 4: Thực hiện các thao tác sắp xếp, lọc dữ liệu trên biểu mẫu
(1) Mục tiêu: 
- HS biết các thao tác sắp xếp, lọc dữ liệu trên biểu mẫu
	(2) Phương pháp/ Kỹ thuật: thực hành trên máy tính
	(3) Hình thức tổ chức hoạt động: Cá nhân và thảo luận nhóm
	(4) Phương tiện dạy học: SGK, máy tính, máy chiếu
	(5) Sản phẩm: Học sinh thực hiện được việc sắp xếp dữ liệu theo một tiêu chí nào đó trên biểu mẫu, lọc được những dữ liệu đơn giản
	Hoạt động của GV
	Hoạt động của HS

	GV: Tương tự như các thao tác cơ bản trên bảng như sắp xếp, lọc , tìm kiếm dữ liệu ta cũng có thể thực hiện trên biểu mẫu
GV: Gọi HS nhắc lại cách thực hiện sắp xếp, lọc dữ liệu






GV: yêu cầu 
1.Sắp xếp tên học sinh theo thứ tự a,b,c
2. Lọc ra danh sách các học sinh nam
	



HS: trả lời
Sắp xếp: ta chọn record  sort  chọn cách sắp xếp tăng hoặc giảm
Lọc dữ liệu: Chọn Record  Filter  chọn cách lọc theo mẫu ( Filter  by form)  hoặc chọn lọc theo ô DL đang chọn ( Filter by selection)

HS: Thực hiện yêu cầu của GV



D.TÌM TÒI, MỞ RỘNG KIẾN THỨC
Hướng dẫn học ở nhà:
Tạo cơ sở dữ liệu QUANLI_NHANVIEN gồm có bảng NHAN_VIEN có cấu trúc sau:
	Tên trường
	Kiểu dữ liệu

	Manv
Hodem
Ten
Ngaysinh
Gioitinh
Chuc_vu
Phongban
	Autonumber
Text
Text
Date/ time
Text
Text
Text



Tạo biểu mẫu để nhập dữ liệu cho bảng NHAN_VIEN
( Dữ liệu HS tự nhập và chú ý:
Chuc_vu: là chức vụ của nhân viên như: GĐ, PGĐ, TP, PP, NV
Phongban: là phòng làm việc như: hành chính, tài vụ, kinh doanh, ...) 
Dặn dò: HS về nhà làm bài thực hành và nộp lại cho GV bằng cách gởi vào hộp mail của GV theo địa chỉ mà GV đã cung cấp để chấm và lấy điểm cộng  và chuẩn bị cho bài học tiếp theo

Tiết: 19
KIỂM TRA MỘT TIẾT
A. Mục tiêu:
· Củng cố lại các kiến thức đã học thông qua hệ thống các câu trắc nghiệm và một số câu hỏi tự luận.
· Rèn luỵên kĩ năng làm việc với các biểu tượng, nút lệnh.
B. Phương pháp:
· Nêu vấn đề
C. Nội dung kiểm tra
I. Phần trắc nghiệm (6 điểm): Mỗi câu trả lời đúng 0.33 điểm
	Câu 1 . 
	Trong Access, từ Filter có ý nghĩa gì ?

	A.
	Tìm kiếm dữ liệu
	B.
	Lọc dữ liệu
	C.
	Sắp xếp dữ liệu
	D.
	Xóa dữ liệu

	Câu 2 
	Trong Access, muốn tạo biểu mẫu theo cách dùng thuật sĩ, ta chọn

	A.
	Create form by using Wizard
	B.
	Create form in using Wizard

	C.
	Create form for using Wizard
	D.
	Create form with using Wizard

	Câu 3 
	Hãy sắp xếp các bước sau để được một thao tác đúng ?
(1) Chọn nút Create                 (3) Nhập tên cơ sở dữ liệu
(2) Chọn File – New                 (4) Chọn Blank Database

	A.
	(1)  (2)  (3)  (4)
	B.
	(1)  (2)  (4)  (3)

	C.
	(2)  (4)  (3)  (1)
	D.
	(2)  (3)  (4)  (1)

	Câu 4 
	Trong Access, nút lệnh này [image: ] có ý nghĩa gì ?

	A.
	Khởi động Access
	B.
	Cài mật khẩu cho tệp cơ sở dữ liệu

	C.
	Mở tệp cơ sở dữ liệu
	D.
	Xác định khoá chính

	Câu 5 
	Trong Access, khi nhập dữ liệu cho bảng, giá trị của field GIOI_TINH là True. Khi đó field GIOI_TINH được xác định kiểu dữ liệu gì ?

	A.
	Boolean
	B.
	True/False
	C.
	Yes/No
	D.
	Date/Time

	Câu 6 
	Trong Access, muốn tạo cấu trúc bảng theo cách tự thiết kế, ta chọn

	A.
	Create table by Design view
	B.
	Create table with Design view

	C.
	Create table in Design view
	D.
	Create table for Design view

	Câu 7 
	Trong Access, kiểu dữ liệu số được khai báo bằng từ ?

	A.
	Number
	B.
	Text
	C.
	Memo
	D.
	Curency

	Câu 8 
	Trong khi tạo cấu trúc bảng, muốn thay đổi kích thước của trường, ta xác định giá trị mới tại dòng :

	A.
	Field Name
	B.
	Data Type
	C.
	Description
	D.
	Field Size

	Câu 9
	Trong khi làm việc với cấu trúc bảng, muốn xác định khóa chính, ta thực hiện : ............  Primary Key

	A.
	Tools
	B.
	Edit
	C.
	File
	D.
	Insert

	Câu 10 
	Trong Access, muốn tạo một cơ sở dữ liệu mới, ta thực hiện

	A.
	Insert – New
	B.
	File – New
	C.
	View – New
	D.
	Tools – New

	Câu 11
	Trong khi nhập dữ liệu cho bảng, muốn xóa một bản ghi đã được chọn, ta bấm phím :

	A.
	Tab
	B.
	Space
	C.
	Enter
	D.
	Delete

	Câu 12
	Trong vai trò của con người khi làm việc với các hệ cơ sở dữ liệu, người thiết kế và cấp phát quyền truy cập cơ sở dữ liệu, là người ?

	A.
	Người lập trình ứng dụng
	B.
	Người quản trị cơ sở dữ liệu

	C.
	Người bảo hành các thiết bị phần cứng của máy tính
	D.
	Người sử dụng (khách hàng)

	Câu 13 
	

	A.
	
	
	
	
	
	
	

	Câu 14 
	Trong khi nhập dữ liệu cho bảng, muốn chèn thêm một bản ghi mới, ta thực hiện : Insert  ............

	A.
	New Rows
	B.
	New Record
	C.
	Rows
	D.
	Record

	Câu 15 
	Trong Access, muốn thực hiện việc lọc dữ liệu, ta chọn :

	A.
	[image: ]
	B.
	[image: ]
	C.
	[image: ]
	D.
	[image: ]

	Câu 16 
	Khi làm việc với cấu trúc bảng, để xác định kiểu dữ liệu của trường, ta xác định tên kiểu dữ liệu tại cột :

	A.
	Field Type
	B.
	Data Type
	C.
	Field Properties
	D.
	Description

	Câu 17
	Em hiểu như thế nào về cụm từ  “Hệ quản trị cơ sở dữ liệu” ?

	A.
	Hệ quản trị cơ sở dữ liệu là một loại thiết bị hỗ trợ màn hình máy tính

	B.
	Hệ quản trị cơ sở dữ liệu là một loại dữ liệu được lưu trữ trên máy tính

	C.
	Hệ quản trị cơ sở dữ liệu là một loại phần mềm máy tính

	D.
	Hệ quản trị cơ sở dữ liệu là một loại thiết bị hỗ trợ mạng máy tính

	Câu 18. 
	


II. Phần tự luận (4 điểm)
Câu 1(2 điểm): Hệ quản trị CSDL là gì?Trình bày các chức năng của hệ quản trị CSDL.
Câu 2 (2 điểm): Theo sáng kiến của Đoàn thanh niên, các bạn học sinh khối 12 tự nguyện đóng góp sách để xây dựng tủ sách tham khảo chung. Để quản lí tủ sách này, các bạn trong nhóm yêu thích tin học đã xây dựng một bộ chương trình khá phức tạp đóng vai trò hệ quản trị CSDL cho phép:
· Tìm tài liệu theo tên, theo chuyên đề hay tác giả.
· Ghi nhận ngày mượn, người mượn, người trả.
· Cung cấp các thông tin thống kê như tài liệu nào được nhiều người mượn nhất, chuyên đề nào thu hút nhiều sự quan tâm nhất….
Chức năng quan trọng nào cần có của bộ chương trình này chưa được xây dựng hoặc đã xây dựng rồi các bạn trong nhóm quên giới thiệu? Cho ví dụ minh hoạ.




Tiết:20
BÀI 7. LIÊN KẾT GIỮA CÁC BẢNG
I. Mục tiêu: 
· Biết khái niệm liên kết giữa các bảng, sự cần thiết và ý nghĩa của việc liên kết.
· Biết cách tạo liên kết trong Access.
II. Chuẩn bị của GV và HS: 
- Giáo viên: SGK, SGV, CSDL KINH_DOANH, máy chiếu Projector, Hướng dẫn thực hiện chuẩn kiến thức, kĩ năng môn Tin học THPT.	
- Học sinh: sách giáo viên
III. Phương pháp giảng dạy: Thực hành mẫu, học sinh làm theo, thuyết trình.
IV. Hoạt động dạy học
A. Khởi động
Hoạt động: Đặt vấn đề 
1. Mục tiêu: Tạo động cơ để HS có nhu cầu thực hiện liên kết giữa các bảng.
1. Phương pháp/ kĩ thuật dạy học: Cá nhân.
1. Phương tiện dạy học: SGK, máy tính, máy chiếu.
1. Sản phẩm: Học sinh có nhu cầu muốn được học cách tạo liên kết giữa các bảng
Nội dung hoạt động
	Hoạt động của GV
	Hoạt động của HS

	- Một công ti chuyên bán dụng cụ văn phòng thường xuyên nhận đơn hàng từ khách hàng. Ta xây dựng CSDL gồm 3 bảng sau:
KHACH_HANG
	Tên trường
	Mô tả
	Khoá chính

	Ma_khach_hang
	Mã khách hàng
	[image: ]

	Ten_khach_hang
	Tên khách hàng
	

	Dia_chi
	Địa chỉ
	


MAT_HANG
	Tên trường
	Mô tả
	Khoá chính

	Ma_mat_hang
	Mã mặt hàng
	[image: ]

	Ten_mat_hang 
	Tên mặt hàng
	

	Don_gia
	Đơn giá (VNĐ)
	


HOA_DON
	Tên trường
	Mô tả
	Khoá chính

	So_don
	Số hiệu đơn đặt hàng
	[image: ]

	Ma_khach_hang
	Mã khách hàng
	

	Ma_mat_hang
	Mã mặt hàng
	

	So_luong
	Số lượng
	

	Ngay_giao_hang
	Ngày giao hàng
	


GV chiếu CSDL trên tách ra gồm 3 bảng.
(?) Bảng KHACH_HANG có bao nhiêu trường, chọn kiểu dữ liệu cho từng trường.
(?) Bảng MAT_HANG có bao nhiêu trường, chọn kiểu dữ liệu cho từng trường.
(?) Bảng HOA_DON có bao nhiêu trường, chọn kiểu dữ liệu cho từng trường.
(?) GV nhận xét và cho điểm.
(?) Muốn có được thông tin gồm: Tên khách hàng, tên mặt hàng, số lượng, đơn giá để tính tiền cho khách hàng, ta lấy thông tin đó từ bảng nào.

	
































- Hs trả lời và chọn kiểu dữ liệu 

- Hs trả lời và chọn kiểu dữ liệu 

- Hs trả lời và chọn kiểu dữ liệu 


- Lấy thông tin đó từ 3 bảng



	-GV chốt: 3 bảng độc lập, vậy để lấy được thông tin tổng hợp từ ba bảng trên ta cần nắm và thực hiện được việc tạo liên kết các bảng này lại với nhau.
	



B. Hình thành kiến thức
(1) Mục tiêu: Giúp HS hiểu ý nghĩa và cách thức để thực hiện liên kết giữa các bảng.
(2) Phương pháp/Kĩ thuật: Đàm thoại, phát hiện. Khai thác mối quan hệ giữa
thực tiễn với tin học.
(3) Hình thức tổ chức hoạt động: Làm việc cá nhân.
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu.
(5) Kết quả: Học sinh biết cách liên kết giữa các bảng.
Nội dung hoạt động
	Hoạt động của GV
	Hoạt động của HS

	Bước 1: Đặt vấn đề: 
(?) 2 bạn ngồi cạnh nhau. Em quen bạn bên cạnh bằng cách nào.


(?) Tương tự như vậy: 3 bảng trên em xem có bảng nào liên quan với bảng nào hay không. Và bằng cách nào.



(?) Em nhận xét gì về trường MA KHACH HANG trong bảng KHACH HANG  và bảng HOA DON


(?) Em nhận xét gì về trường MA MAT HANG trong bảng MAT HANG  và bảng HOA DON

GV: Trong CSDL các bảng được liên kết với nhau qua trường chung hay còn gọi là trường khóa.
	
- Có thể cùng chung 1 trường, 1 lớp, cùng ở 1 làng… sẽ quen biết nhau.
- Bảng KHACH HANG liên quan với bảng HOA DON do có chung trường MA KHACH HANG, bảng MAT HANG liên quan với bảng HOA DON do có chung trường MA MAT HANG.
- Trường MA KHACH HANG là trường khóa chính trong bảng KHACH HANG, không phải là trường khóa trong bảng HOA DON.
- Trường MA MAT HANG là trường khóa chính trong bảng MAT HANG, không phải là trường khóa trong bảng HOA DON

	Bước 2: Thực hiện các bước tạo liên kết qua 1 ví dụ
- GV: Các mối liên kết được thể hiện trong cửa sổ Relationships, mọi thao tác như xem, tạo, sửa, xoá liên kết đều được thực hiện trong cửa sổ này. Để mở cửa sổ này chọn ToolsRelationships... hoặc nháy nút lệnh [image: ] (Relationships).
- Gv giới thiệu và thực hiện trên máy các bước liên kết để liên kết bảng KHACH HANG và bảng HOA DON.

	








- Hs quan sát và ghi bài


Luyện tập
	Hoạt động của giáo viên
	Hoạt động của Học sinh

	1.  GV chiếu CSDL gồm 3 bảng trên. Yêu cầu 2 học sinh lên thực hiện
+ Liên kết giữa bảng KHACH HANG và bảng HOA DON, giữa bảng MAT HANG và bảng HOA DON
Yêu cầu hs khác lên tạo liên kết giữa các bảng
Yêu cầu hs khác nhận xét.
	- HS thực hiện




- Hs thực hiện



C. Vận dụng
(1) Mục tiêu: rèn luyện cho học sinh nhận biết và thực hiện được các bước tạo liên kết bảng
(2) Phương pháp/ kỹ thuật: Đàm thoại
(3) Hình thức tổ chức hoạt động: thảo luận nhóm.
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu projector.
(5) Sản phẩm: Học sinh làm được các bài tập trong phiếu học tập
Bước 1: Chuyển giao nhiệm vụ học  tập;
In Phiếu học tập đề bài ra giấy và đưa ra tất cả các HS trong lớp (y/c hs làm việc cá nhân trong 2 P)
	PHIẾU HỌC TẬP
Câu 1: Liên kết giữa các bảng cho phép:
A. Tránh được dư thừa dữ liệu 		C. Có thể có được thông tin tổng hợp từ nhiều bảng
C. Nhất quán dữ liệu				D. Cả A, B, C đều đúng
Câu 2: Để tạo liên kết giữa các bảng, ta chọn: 
A.Tool/ Relationships hoặc nháy nút [image: ] 		B.Tool/ Relationships
C.Edit/ Insert/ Relationships				D.Tất cả đều đúng
Câu 3: Sắp xếp các bước theo đúng thứ tự thực hiện để tạo liên kết giữa hai bảng:
1. Kéo thả trường khóa làm liên kết từ bảng phụ tới bảng chính( trường khóa làm khóa chính)
1. Chọn các tham số liên kết
1. Hiển thị hai bảng (các trường) muốn tạo liên kết
1. Mở cửa sổ Relationships
1. 2413		B. 4312		C. 4231	D. 3142
Câu 4: GV Cho CSDL quản lí kì kiểm tra môn Toán của cả tỉnh có ba bảng sau:
+ Bảng THI SINH (SBD, HO VA TEN, NGAY SINH, TRUONG)
+ Bảng DANH PHACH (SBD, PHACH)
+ Bảng DIEM THI (PHACH, DIEM)
Tạo liên kết cho các bảng trên.
Câu 5: Cách xóa liên kết giữa các bảng trên.




Hết thời gian yêu cầu HS chia thành 4 nhóm  theo  4 tổ 
GV hướng dẫn HS phân công nhóm trưởng , thư kí 
Thư kí có nhiệm vụ ghi lại kết quả của cả nhóm
Bước 2: Thực hiện nhiệm vụ học tập 
Gv quan sát từng nhóm trong lớp , hỗ trợ các nhóm nếu gặp khó khăn và nhắc nhở những bạn hs chưa tích cực tham gia hoạt động nhóm
Bước 3: Báo cáo kết quả thảo luận:
Câu 1, 2, 3 gọi đồng thời 4 nhóm viết trên bảng.
Câu 4: Mỗi nhóm cử 1 bạn lên thực hiện.
Câu 5: Cử nhóm xung phong trước nhất lên thực hiện.
Bước 4: Đánh giá kết quả thực hiên nhiệm vụ học tập
Gv đánh giá kết quả của các nhóm và cho điểm.
D. Tìm tòi mở rộng 
(1) Mục tiêu: rèn luyện cho học sinh tạo các bảng và liên kết
(2) Phương pháp/ kỹ thuật: liên hệ thực tế
(3) Hình thức tổ chức hoạt động: cá nhân
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu projector.
(5) Sản phẩm: Học sinh tạo được CSDL gồm các bảng và liên kết các bảng
Nội dung hoạt động
	Hoạt động của giáo viên
	Hoạt động của học sinh

	Theo em, để quản lí thư viện sách ở trường thpt cần những bảng nào. Em hãy tạo CSDL để lưu trữ các bảng và thực hiện tạo liên kết các bảng đó.
	- Hs trả lời

- Hs về nhà tìm hiểu thêm




Tiết: 21, 22

BÀI TẬP VÀ THỰC HÀNH 5. LIÊN KẾT GIỮA CÁC BẢNG
I. Mục tiêu: 
- Tiếp tục rèn luyện kĩ năng tạo bảng với cấu trúc cho trước, kĩ năng nhập dữ liệu vào bảng.
- Tạo được CSDL gồm nhiều bảng.
- Tạo được sơ đồ liên kết giữa các bảng của CSDL.
- Thực hiện được các thao tác tạo liên kết, sửa liên kết giữa các bảng.
II. Chuẩn bị của GV & HS:
· Giáo viên: Phòng máy tính có cài đặt HQTCSDL Microsoft Access, sách GK tin 12, Sách GV tin 12, đĩa chứa các chương trình minh họa (csdl KINH_DOANH).
· Học sinh: Đọc trước bài tập thực hành 5 theo yêu cầu của giáo viên, học bài cũ.
III. Phương pháp dạy học:
· Thuyết trình
· Hỏi đáp
· Đặt vấn đề
· So sánh.
IV. Tiến trình lên lớp:
A. Hoạt động khởi động: 
· Ổn định lớp và bố trí chỗ ngồi.
· GV yêu cầu HS vào phòng máy, giữ trật tự
· GV phân công và kiểm tra vị trí ngồi của HS sao cho đúng
· Khởi động máy
· GV yêu cầu HS khởi động máy 
B. Nội dung thực hành: bài tập và Thực hành 4.
Hoạt động 1:Tạo CSDL KINH_DOANH gồm 3 bảng KHACH_HANG, MAT_HANG, HOA_DON. 
(1)Mục tiêu: xác định cấu trúc, kiểu dữ liệu tạo bảng.
(2)Phương pháp/kĩ thuật dạy học: Vấn đáp.
(3)Hình thức tổ chức: Làm việc cá nhân, Thảo luận nhóm.
(4)Phương tiện dạy học: SGK, Máy tính, máy chiếu.
  (5)Sản phẩm: Tạo 3 bảng KHACH_HANG, MAT_HANG, HOA_DON.

Nội dung hoạt động

· Tạo CSDL KINH_DOANH.

· Tạo cấu trúc cho bảng KHACH_HANG, khoá chính: Ma_khach_hang



· Tạo cấu trúc cho bảng HOA_DON, khoá chính: so_hieu_don



· Tạo cấu trúc cho bảng MAT_HANG, khoá chính: ma_mat_hang



· Nhập dữ liệu cho ba bảng: KHACH_HANG, HOA_DON, MAT_HANG.

	Hoạt động của GV
	Hoạt động của HS

	- Đưa ra bài toán: Tạo CSDL KINH_DOANH như yêu cầu ở bài tập 1.
- Cho học sinh nhắc lại các kiến thức đã học:

- Hãy cho biết cách tạo CSDL mới?









- Làm thế nào để tạo bảng với cấu trúc cho trước.


Sau khi tạo bảng, hoc sinh tiến hành nhập thông tin vào bảng.
- Sau khi cho học sinh nhắc lại cách thức tạo một CSDL mới, cách tạo cấu trúc bảng. Gv thực hiện mẫu trên máy một lượt. 

	- Hs đọc đề bài tập 1

- Lắng nghe phần dẫn dắt, diễn giải  và trả lời các câu hỏi của gv.
Trả lời:
Để tạo một CSDL mới:
1. Chọn lệnh File/ New…
2. Chọn Blank Database, hộp thoại Flie New Database xuất hiện
3. Trong hộp thoại File New Database, chọn vị trí lưu tệp và nhập tên tệp CSDL mới. Nhấp Creat để tạo tệp.
- Học sinh nhắc lại 2 cách để tạo cấu trúc bảng.


Quan sát, lắng nghe, thực hiện đúng yêu cầu.


Hoạt động2: Tạo liên kết cho các bảng trong CSDL KINH_DOANH và nhập dữ liệu
(1)Mục tiêu: xác định trường liên kiết, phương thức tiến hành liên kết.
(2)Phương pháp/kĩ thuật dạy học: Vấn đáp.
(3)Hình thức tổ chức: Làm việc cá nhân, Thảo luận nhóm.
(4)Phương tiện dạy học: SGK, Máy tính, máy chiếu.
  (5)Sản phẩm: Tạo được liên kết giữa 3 bảng KHACH_HANG, MAT_HANG, HOA_DON.

Nội dung hoạt động

 Tạo liên kết cho các bảng trong CSDL KINH_DOANH vừa tạo ở bài 1 để có sơ đồ liên kết như hình dưới đây: 




· Sau khi tạo liên kết, thực hiện xoá, chỉnh sửa liên kết đã tạo.
· Để xoá một liên kết:Nháy vào đường nối thể hiện liên kết để chọn nó rồi nhấn phím Delete.
· Để sửa liên kết: Nháy đúp vào đường nối thể hiện liên kết để mở lại hộp thoại Edit Relationships
	Hoạt động của GV
	Hoạt động của HS

	Sau khi tạo CSDL KINH_DOANH gồm 3 bảng KHACH_HANG, HOA_DON, MAT_HANG. Ta tiến hành tạo liên kết cho các bảng trên theo yêu cầu ở bài tập 2, nêu các bước liên kết?
- Mối liên hệ giữa hai bảng KHACH_HANG và HOA_DON được thực hiện thông qua trường nào? 
- Khi liên kết giữa 2 bảng KHACH_HANG và HOA_DON được thực hiện thì mỗi đơn hàng sẽ chứa cả thông tin về khách hàng (Ho_ten) và địa chỉ của khách hàng (Dia_chi) tương ứng với mã khách hàng (Ma_khach_hang) trong đơn hàng. 
- Hoàn toàn tương tự học sinh phân tích mối liên kết giữa 2 bảng: MAT_HANG và HOA_DON
- Nêu mục đích của việc tạo mối liên kết giữa các bảng? 
Gv giải thích thêm: Khi thực hiện các thống kê trên CSDL sẽ có thông tin đầy đủ thông tin lấy từ 3 bảng nhưng tránh được dư thừa dữ liệu.
Như vậy muốn tạo liên kết giữa các bảng ta thực hiện ntn?



Sau khi tạo liên kết giữa các bảng ta có thể chỉnh sửa, xoá liên kết đã tạo.
-Gv làm mẫu một lần để hs quan sát 

	


- Học sinh quan sát yêu cầu bài tập 2.





- Chú ý phân tích của giáo viên.

- Hs: Trường Ma_khach_hang





 - 01 hs phân tích mối liên kết giữu 2 bảng MAT_HANG và HOA_DON
 
Hs trả lời câu hỏi:
· Bước 1: Tools/ Relationships.
· Bước 2: Chọn các bảng cần tạo liên kết: 
· Chọn bảng KHACH_HANG, chọn Add
· Chọn bảng HOA_DON, chọn Add
· Chọn bảng MAT_HANG, chọn Add
· Bước 3: Tạo liên kết giữa các cặp bảng.  Sau đó nhấn nút Close để đóng và hoàn thành việc tạo liên kết.

- Tạo liên kết giữa cho các bảng trên máy tính của mình.


4. Củng cố - dặn dò
1. Củng cố: Giáo viên nhận xét ưu, khuyết điểm của HS qua tiết thực hành. 
Qua bài này các em phải thực hiện được:
+ Việc tạo cấu trúc cho CSDL
+ Tạo được sơ dồ liên kết cho các bảng đã tạo
2. Dặn dò: Xem trước nội dung bài 8 – Truy vấn dữ liệu. 
V. Rút kinh nghiệm:
Tiết: 23
BÀI 8. TRUY VẤN DỮ LIỆU
I. MỤC TIÊU
1. Kiến thức:
- Hiểu khái niệm mẫu hỏi. 
- Biết vận dụng một số hàm và phép toán tạo ra các biểu thức số học, biểu thức điều kiện và biểu thức lôgic để xây dựng mẫu hỏi.
2. Kĩ năng:
- Biết các bước chính để tạo một mẫu hỏi.
- Biết sử dụng hai chế độ: chế độ thiết kế và chế độ trang dữ liệu. 
- Nắm vững cách tạo mẫu hỏi mới trong chế độ thiết kế.
3. Thái độ: 
         	- Tự giác, tích cực trong giờ học
4. Định hướng phát triển năng lực:
- Giải quyết vấn đề, CNTT và truyền thông, hợp tác, đọc hiểu.
II. CHUẨN BỊ CỦA GIÁO VIÊN VÀ HỌC SINH
1. Chuẩn bị của giáo viên
- Thiết bị dạy học: Bảng, phấn, máy chiếu.
- Học liệu: SGK, SGV
2. Chuẩn bị của học sinh
	- Sách giáo khoa, vở ghi.
III. TỔ CHỨC CÁC HOẠT ĐỘNG HỌC TẬP
1. Ổn định lớp:  Kiểm tra sĩ số
2. Kiểm tra bài cũ:  không
3. Tiến trình bài học
A. Khởi động
Hoạt động 1: khởi động thông qua 1 ví dụ 
(1) Mục tiêu: Tạo động cơ để học sinh muốn tạo mẫu hỏi
(2) Phương pháp/Kĩ thuật: Đàm thoại, phát hiện. 
(3) Hình thức tổ chức hoạt động: Làm việc cá nhân.
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu.
(5) Kết quả: Học sinh có nhu cầu muốn học cách tạo mẫu hỏi.
Nội dung hoạt động
	Hoạt động của giáo viên
	Hoạt động của học sinh

	- Chiếu CSDL quản lí học sinh, bảng HOC SINH
[image: ]
(?) Bảng trên gồm mấy trường, trường nào chọn làm khóa.
(?) Các em quan sát và tìm cho cô hs nào có điểm môn tin cao nhất và thấp nhất.
(?) Giả sử bảng trên gồm 1000 bản ghi thì em sẽ gặp khó khăn gì trong việc tìm ra hs có điểm tin cao nhất và thấp nhất.


Gv chốt: Nếu câu hỏi liên quan tới 1 bảng bằng thao tác tìm kiếm và lọc có thể tìm ra, nhưng với câu hỏi phức tạp, liên quan tới nhiều bảng thì ta cần sử dụng mẫu hỏi. Vậy mẫu hỏi có khả năng làm những gì và cách tạo mẫu hỏi như nào. Cô và các em cùng tìm hiểu bài hôm nay.
	






- Hs trả lời

- Hs trả lời

- Mất nhiều thời gian, độ chính xác chưa cao.
- Hs cũng có thể đưa ra câu trả lời là sử dụng thao tác lọc và tìm kiếm có thể tìm ra




B. Hình thành kiến thức
(1) Mục tiêu: Giúp HS hiểu ý nghĩa và cách thức để thực hiện liên kết giữa các bảng.
(2) Phương pháp/Kĩ thuật: phát hiện, giải quyết vấn đề
(3) Hình thức tổ chức hoạt động: Làm việc cá nhân
 (4) Phương tiện dạy học: SGK, máy tính, máy chiếu.
(5) Kết quả: Học sinh biết vận dụng một số hàm và phép toán tạo ra các biểu thức số học, biểu thức điều kiện và biểu thức lôgic để xây dựng mẫu hỏi.
Hoạt động2: tìm hiểu khái niệm 
1. Phương pháp/kỹ thuật dạy học: hỏi đáp, giải quyết vấn đề,....
1. Hình thức:  
	Hoạt động của GV
	Hoạt động của HS

	GV: chiếu CSDL quản lí học sinh, đưa ra một số mẫu hỏi đã làm sẵn như sắp xếp họ tên hs theo bảng chữ cái, tính điểm trung bình học sinh.
Từ những ví dụ trên và dựa vào sgk trả lời các câu hỏi sau:
(?) Trong Access các em đã học những đối tượng nào.
(?) Mẫu hỏi có phải là đối tượng của Access?
(?) Mẫu hỏi là gì.
(?) Có mấy chế độ làm việc với mẫu hỏi
- Yc học sinh khác nhận xét
- Gv nhận xét và chốt lại kiến thức

Chú ý: Kết quả thực hiện của mẫu hỏi cũng đóng vai trò như một bảng và có thể tham gia vào việc tạo bảng, biểu mẫu, tạo mẫu hỏi khác và báo cáo.

	




- Hs trả lời

- Hs trả lời

- Hs trả lời

- Hs trả lời


- Hs nhận xét
- Hs ghi bài

	GV: Để thực hiện tính toán và kiểm tra điều kiện trong access có công cụ để viết biểu thức
( ?) Trong Toán, cho biểu thức sau : x + 10
X đgl gì, 10 đgl gì, sử dụng phép toán nào.
( ?) Tương tự vậy, biểu thức trong Access gồm có thành phần nào.
(?) Trong tính toán chúng ta có những loại phép toán nào?

- GV: Chúng ta dùng các phép toán trên để tính toán trên các toán hạng vậy trong Access các toán hạng là những đối tượng nào?
- GV nhận xét và chốt lại kiến thức

( ?) Giả sử cho 2 trường DON_GIA, SO_LUONG để tính thành tiền cho khách hàng, theo em sẽ viết như thế nào
- GV nhận xét và chỉnh sửa lại cho đúng. Từ đó rút ra quy cách viết biểu thức số học và cú pháp cho trường tính toán. 
( ?) Trong CSDL quản lí học sinh, theo em  có thể viết biểu thức như thế nào để tìm ra những học sinh là Nữ, có điểm môn Văn từ 7.5 trở lên
- GV nhận xét và chỉnh sửa lại cho đúng. 
( ?) Biểu thức trên có phải là biểu thức số học không.
- Gv kết luận lại biểu thức trên là biểu thức logic, đưa ra kiến thức về biểu thức logic

- GV giới thiệu các hàm. Trong đó bốn hàm (SUM, AVG, MIN, MAX) chỉ thực hiện trên các trường kiểu số
	


- Hs trả lời

- gồm phép toán và toán hạng

- Trả lời câu hỏi.

- Hs trả lời


- Hs chú ý và ghi bài

- Hs lên bảng viết (có thể cách viết chưa đúng), hs khác nhận xét


- Hs ghi bài

- Hs lên bảng viết (có thể cách viết chưa đúng), hs khác nhận xét

 Hs trả lời, hs khác nhận xét

- Hs ghi bài


- Hs chú ý và ghi bài


Hoạt động3: tìm hiểu cách tạo mẫu hỏi 
1. Phương pháp/kỹ thuật dạy học: giải quyết vấn đề,....
1. Hình thức:  
	Hoạt động của GV
	Hoạt động của HS

	GV: Để bắt đầu làm việc với mẫu hỏi, cần xuất hiện trang mẫu hỏi bằng cách chọn Queries trong bảng chọn đối tượng của cửa sổ CSDL.
Có thể tạo mẫu hỏi bằng cách dùng thuật sĩ hay tự thiết kế, Dù sử dụng cách nào thì các bước chính để tạo một mẫu hỏi cũng như nhau
GV: Giới thiệu 2 cách tạo mẫu hỏi thông qua 1 ví dụ: Chiếu CSDL quản lí học sinh, tìm ra những học sinh có điểm tất cả các môn từ 6.5 trở lên.

GV: Thuyết trình:
 Với các mẫu hỏi cần thống kê, nháy nút ∑ (Total) trên thanh công cụ
VD: Muốn đếm HS có điểm Hóa =10
Cần xác định:
+ Trường phân nhóm: (Total: Group by)
→ Hóa
+ Trường đk làm tiêu chuẩn phân nhóm
→Hoa=10
+ Trường tính toán (Total: 1 số hàm: sum, avg, count..)
→So_HS (count)
GV: Có hai chế độ thường dùng để làm việc với mẫu hỏi: chế độ thiết kế và chế độ trang dữ liệu.
Trong chế độ thiết kế, ta có thể thiết kế mới hoặc xem hay sửa đổi thiết kế cũ của mẫu hỏi. 
	- Hs chú ý



HS:  Chú ý nghe giảng và ghi bài








HS:  Chú ý nghe giảng 





C. VẬN DỤNG
(1) Mục tiêu: Giúp HS thực hiện truy vấn dữ liệu
(2) Phương pháp/Kĩ thuật: Đàm thoại, phát hiện
(3) Hình thức tổ chức hoạt động: Cá nhân, cặp đôi thực hành, hoạt động nhóm.
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu.
(5) Học sinh biết vận dụng kiến thức đã học vào giải quyết tình huống thực
tiễn cụ thể 
Hoạt động4: Ví dụ 
1. Phương pháp/kỹ thuật dạy học: giải quyết vấn đề, đàm thoại
1. Hình thức:  
Bước 1: Chuyển giao nhiệm vụ học  tập;
In Phiếu học tập đề bài ra giấy và đưa ra tất cả các HS trong lớp (y/c hs làm việc cá nhân trong 2 P)
	PHIẾU HỌC TẬP

Câu 1: Nếu những bài toán mà câu hỏi chỉ liên quan tới một bảng, ta có thể:
A. Thực hiện thao tác tìm kiếm và lọc trên bảng hoặc biểu mẫu	B. Sử dụng mẫu hỏi
C. A và B đều đúng							D. A và B đều sai
Câu 2: Nếu những bài toán phức tạp, liên quan tới nhiều bảng, ta sủ dụng:
A. Mẫu hỏi			B. Bảng		C. Báo cáo			D. Biểu mẫu
Câu 3: Bảng DIEM có các trường MOT_TIET, HOC_KY. Để tìm những học sinh có điểm một tiết trên 7 và điểm thi học kỳ trên 5 , trong dòng Criteria của trường HOC_KY, biểu thức điều kiện nào sau đây là đúng:
A. MOT_TIET > 7 AND HOC_KY >5 	B. [MOT_TIET] > 7 AND [HOC_KY]>5
C. [MOT_TIET] > 7 OR [HOC_KY]>5	D. [MOT_TIET] > "7" AND [HOC_KY]>"5"
Câu 4: Bảng DIEM có các trường MOT_TIET, HOC_KY. Trong Mẫu hỏi, biểu thức số học để tạo trường mới TRUNG_BINH, lệnh nào sau đây là đúng:
A. TRUNG_BINH:(2* [MOT_TIET] + 3*[HOC_KY])/5	       
B. TRUNG_BINH:(2* MOT_TIET + 3*HOC_KY)/5
C. TRUNG_BINH:(2* [MOT_TIET] + 3*[HOC_KY]):5          
D. TRUNG_BINH=(2* [MOT_TIET] + 3*[HOC_KY])/5
Câu 5: Cho CSDL quản lí học sinh (chiếu trên slide) tạo mẫu hỏi tìm ra những học sinh làm nam có điểm toán, văn trên 8.


Hết thời gian yêu cầu HS chia thành 4 nhóm  theo  4 tổ 
GV hướng dẫn HS  phân công nhóm trưởng , thư kí 
Thư kí có nhiệm vụ ghi lại kết quả của cả nhóm
Bước 2: Thực hiện nhiệm vụ học tập 
Gv quan sát từng nhóm trong lớp , hỗ trợ các nhóm nếu gặp khó khăn và nhắc nhở những bạn hs chưa tích cực tham gia hoạt động nhóm
Bước 3: Báo cáo kết quả thảo luận:
Câu 1, 2, 3, 4 gọi đồng thời 4 nhóm viết trên bảng.
Câu 5: Cử 2 nhóm xung phong trước nhất lên thực hiện.
Bước 4: Đánh giá kết quả thực hiên nhiệm vụ học tập
Gv đánh giá kết quả của các nhóm và cho điểm.
D. Tìm tòi mở rộng 
(1) Mục tiêu: rèn luyện cho học sinh tạo mẫu hỏi
(2) Phương pháp/ kỹ thuật: phân tích, giải quyết vấn đề.
(3) Hình thức tổ chức hoạt động: cá nhân
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu projector.
(5) Sản phẩm: Học sinh tạo được mẫu hỏi.
Nội dung hoạt động
	Hoạt động của giáo viên
	Hoạt động của học sinh

	
Câu 6: Cho CSDL quản lí học sinh (chiếu trên slide) tạo mẫu hỏi gồm các trường sau: MaSO, HoDem, Ten, Toan, Van, Li, Hoa, Tin, tính điểm trung bình các môn và sắp xếp danh sách học sinh theo bảng chữ cái.
(?) Công thức tính điểm trung bình
(?) Các trường MaSO, HoDem, Ten, Toan, Van, Li, Hoa, Tin đã có ở bảng ta chỉ chọn hiển thị trong mẫu hỏi. Điểm trung bình muốn hiển thị trong mẫu hỏi thì phải làm thế nào.
(?) Đặt tên cho trường mới là gì? Mô tả trường này ta sử dụng biểu thức nào để viết. Cách viết ntn.
Gv: còn thời gian sẽ gọi hs lên bảng làm, nếu không sẽ cho về nhà tìm hiểu thêm và làm.
	





1. Hs trả lời
1. Hs trả lời: ta phải thêm một trường mới


1. Hs trả lời






Tiết: 24, 25
BÀI TẬP VÀ THỰC HÀNH 6
MẪU HỎI TRÊN MỘT BẢNG (Tiết 1,2)

I. MỤC TIÊU BÀI HỌC
	1.  Kiến thức
1. Biết khái niệm và công dụng của mẫu hỏi.
1. Biết vận dụng một số hàm, phép toán để xây dựng, biểu thức điều kiện và biểu thức lôgích để xây dựng mẫu hỏi.
2. Kỹ năng
1. Thực hiện được tạo mẫu hỏi kết xuất thông tin từ một bảng.
1. Thực hiện được các thao tác tạo mẫu hỏi liệt kê và sắp thứ tự.
1. Thực hiện được các thao tác tạo mẫu hỏi có sử dụng gộp nhóm ở mức độ đơn giản.
1. Tạo được những biểu thức điều kiện đơn giản.
3. Thái độ
1. Ham thích môn học, có tính kỷ luật cao
1. Nghiêm túc khi làm việc với dữ liệu
         4. Định hướng phát triển năng lực
1. Mô hình hóa các bài toán quản lí thực tiễn dưới dạng của các biểu mẫu, thiết kế được biểu mẫu để quản lí.
II. PHƯƠNG PHÁP, PHƯƠNG TIỆN DẠY HỌC
2.1 Phương pháp
Thực hiện một số pp dạy học tích cực: Đặt tình huống có vấn đề, thảo luận nhóm, câu hỏi gợi mở, thuyết trình, vấn đáp…
- Thực hiện hướng dẫn chung cho cả lớp
- Hướng dẫn theo từng nhóm nhỏ theo máy
- Hỗ trợ khi cần thiết
2.2 Phương tiện
	- Chuẩn bị của giáo viên: Giáo án, SGK, SGV, Hướng dẫn thực hiện chuẩn kiến thức, kĩ năng môn Tin học THPT.	
	- GV nên chuẩn bị sẵn CSDL, máy chiếu, phòng máy, cài đặt phần mềm Netop schools, Phòng máy tính có cài đặt HQTCSDL Microsoft Access, đĩa chứa các chương trình minh họa 
- Chuẩn bị của học sinh: SGK, vở ghi, bảng nhóm thực hiện bài tập nhóm, đọc trước nội dung theo yêu cầu của giáo viên, học bài cũ.
III. HOẠT ĐỘNG DẠY - HỌC
A. HOẠT ĐỘNG KHỞI ĐỘNG
1. Hoạt động 1: Ổn định tổ chức 
	Yêu cầu lớp trưởng ổn định lớp và báo cáo sỉ số
0. Ổn định lớp và bố trí chỗ ngồi.
0. GV yêu cầu HS vào phòng máy, giữ trật tự
0. GV phân công và kiểm tra vị trí ngồi của HS sao cho đúng
0. Khởi động máy
0. GV yêu cầu HS khởi động máy 
B. HÌNH THÀNH BÀI HỌC
1. Hoạt động 2: Thực hành nội dung bài tập 1 - SGK
(a) Mục tiêu hoạt động: Biết cách tạo mẫu hỏi theo nhu cầu sử dụng
	(b) Phương pháp/ kỹ thuật: Gợi mở, đàm thoại, vấn đáp, đặt vấn đề.
	(c) Phương tiện dạy học: Sách giáo khoa, sách bài tập.
	(d) Hình thức tổ chức: Cá nhân và thảo luận nhóm
	(e) Sản phầm hoạt động: Biết tạo điều kiện trong lưới QBE
Nội dung hoạt động
Bài 1: Sử dụng CSDL QLHS, tạo mẫu hỏi liệt kê và sắp thứ tự theo tổ, họ tên, ngày sinh của các bạn nam.
Hướng dẫn thực hiện: 
Thực hiện các thao tác sau đây:
1. Mở cơ sở dữ liệu QUANLI_HS:
Có 2 cách để mở CSDL đã có:
1. Cách 1: Nháp chuột lên tên CSDL (nếu có) trong khung New File;
1. Cách 2: Chọn lệnh File → Open…. rồi tìm và nháp đúp vào tên CSDL cần mở.
2. Tạo mẫu hỏi:
1. Bước 1. Chọn đối tượng Queries;
1. Bước 2. Chọn dòng lệnh Create query in Design view;
1. Bước 3. Trong của sổ Show table → chọn tên bảng HOC_SINH → Add → Close; 
1. Bước 4. Các trường đưa vào mẫu hỏi: Hodem, Ten, Ngsinh, To, GT. Mô tả điều kiện mẫu hỏi trong vùng lưới QBE. Trong lưới QBE, trên dòng Criteria, tại các cột GT = “Nam”.
	Hoạt động của giáo viên
	Hoạt động của học sinh

	? Nêu các bước tạo Queries








- Yêu cầu học sinh thực hiện các bước đã nêu, gv quan sát, nhắc nhở và giúp đỡ các học sinh chưa tự lập trong thực hành
? Các trường cần đưa vào mẫu hỏi này là gì?
? Nêu điều kiện để lọc các bạn nam
Gv yêu cầu học sinh thực hiện các thao tác vừa hướng dẫn để lọc các bạn nam theo yêu cầu
Gv quan sát nhắc nhở, nhận xét thực hiện
	Hs trả lời:
- Mở CSDL QLHS, tại của sổ Database chọn Queries. Kích đúp chuột vào nút Creat queries in Design view
- Chọn bảng HocSinh trong của sổ Show table -> Add-> Cclose để đóng hộp hội thoại Show table. 
- Bấm chuột vào nút lệnh Run hoặc Query/Run để thực hiện mẫu hỏi.
- Lưu và đặt tên cho mẫu hỏi.
Hs thực hiện nhiệm vụ học tập trên máy cá nhân

Học sinh trả lời: Hodem, Ten, Ngsinh, To, GT. 
Hs trả lời: Trong lưới QBE, trên dòng Criteria, tại các cột GT = “Nam”.
Hs thực hiện các thao tác đã được hướng dẫn, lưu ý các nội dung cần thực hiện theo bài tập.

Lắng nghe, ghi nhớ


1. Hoạt động 3: Thực hành bài tập 2 - SGK
(a) Mục tiêu hoạt động: Biết cách gộp nhóm các mẫu hỏi.
	(b) Phương pháp/ kỹ thuật: Gợi mở, đàm thoại, vấn đáp, đặt vấn đề.
	(c) Phương tiện dạy học: Sách giáo khoa, sách bài tập.
	(d) Hình thức tổ chức: Cá nhân và thảo luận nhóm
	(e) Sản phầm hoạt động: Mẫu hỏi có gộp nhóm
Nội dung hoạt động
Bài 2: Mẫu hỏi có gộp nhóm
Trong CSDL QUANLI_HS tạo mẫu hỏi THONG_KE có sử dụng các hàm gộp nhóm để so sánh trung bình điểm Toán và điểm Văn giữa các tổ 
Gợi ý làm bài:
Tiến hành theo các bước như sau:
1. Bước 1. Trong trang mẫu hỏi, nháy đúp vào Create query in Design view.
1. Bước 2. Cửa sổ mẫu hỏi ngầm định Query1: Select Query được mở ra cùng hộp thoại Show Table:
· Nháy đúp HOC_SINH.
· Nháy nút [image: Bài tập và thực hành 6: Mẫu hỏi trên một bảng] để đóng hộp thoại Show Table.
1. Bước 3. Trên cửa sổ mẫu hỏi:
· Chọn trường GT (để gộp nhóm các bạn nam và các bạn nữ);
· Chọn các trường TOAN và VAN (để tính các giá trị cần đưa vào mẫu hỏi).
1. Bước 4. Để gộp nhóm, nháy nút [image: Bài tập và thực hành 6: Mẫu hỏi trên một bảng] hoặc chọn lệnh View → Totals.
· Nháy mũi tên chỉ xuống ở cạnh phải của ô thuộc hàng Total (hình 1) và cột TOAN, chọn Avg và đổi tên trường thành TBTOAN.
· Nháy mũi tên chỉ xuống ở cạnh phải của ô thuộc hàng Total (hình 1) và cột VAN, chọn Avg và đổi tên trường thành TBVAN.
[image: Bài tập và thực hành 6: Mẫu hỏi trên một bảng]
Hình 1. Mẫu hỏi ở chế độ thiết kế
1. Bước 5. Nháy nút [image: Bài tập và thực hành 6: Mẫu hỏi trên một bảng] hoặc chọn lệnh Query →→ Run để thực hiện mẫu hỏi. Kết quả được kết xuất trên trang dữ liệu của mẫu hỏi (hình 2).
1. Bước 6. Lưu mẫu hỏi với tên THONG_KE.
Vào File →→ Save as →→ Gõ tên ThongKe →→ Nháy OK.
[image: Bài tập và thực hành 6: Mẫu hỏi trên một bảng]
Hình 2. Mẫu hỏi ở chế độ trang dữ liệu

	Hoạt động của giáo viên
	Hoạt động của học sinh

	? Chọn trường nào để gộp nhóm các bạn nam nữ
? Chọn trường nào để tính điểm và so sánh
? Để hộp nhóm các mẫu hỏi phải sử dụng lệnh nào
- Gv yêu cầu học sinh thực hành, nêu các chú ý để học sinh quan sát
- Gv có thể thao tác trước các bước cho học sinh theo dõi và thực hành theo (đối với các lớp khả năng tự thực hành chưa được cao, với các lớp khá giỏi nên để các em tự nghiên cứu)
- Yêu cầu học sinh lưu lại bài tập
- Chỉnh sửa các sai sót, nêu các lưu ý
	- HS trả lời: Chọn trường GT

- HS trả lời: Chọn trường Toan và Van
- Hs trả lời: Để gộp nhóm, nháy nút [image: Bài tập và thực hành 6: Mẫu hỏi trên một bảng] hoặc chọn lệnh View → Totals.


- Hs thực hành nội dung trên máy tính cá nhân, lưu ý các hướng dẫn của giáo viên, ghi chép các bước và theo dõi giúp đỡ các bạn yếu kém.

- Hs lưu lại bài tập với tên Thống kê
- Lắng nghe, ghi nhớ




1. Hoạt động 4: Thực hành bài tập 3 - SGK
(a) Mục tiêu hoạt động: Biết cách xử lý thông tin trong mẫu hỏi
	(b) Phương pháp/ kỹ thuật: Gợi mở, đàm thoại, vấn đáp, đặt vấn đề.
	(c) Phương tiện dạy học: Sách giáo khoa, sách bài tập.
	(d) Hình thức tổ chức: Cá nhân và thảo luận nhóm
	(e) Sản phầm hoạt động: Xử lý các thông tin trong mẫu hỏi, tạo bảng thống kê được các thông tin.
Nội dung hoạt động
Bài 3
Sử dụng CSDL QUANLI_HS, tạo mẫu hỏi KI_LUC_DIEM thống kê các điểm cao nhất của tất cả các bạn trong lớp về từng môn (Toán, Lí, Hoá, Văn, Tin).
Gợi ý làm bài:
1. Bước 1. Chọn đối tượng Queries;
1. Bước 2. Chọn dòng lệnh Create query in Design view;
1. Bước 3. Trong của sổ Showtable → chọn tên bảng HOC_SINH → Add → Close 
1. Bước 4. Nháy đúp chuột vào tên trường: toan, van, li, hoa, tin trong bảng HOC_SINH;
1. Bước 5. Chọn lệnh View →→ Totals.. Chọn Group By ở hàng Total. Bấm chuột vào mũi tên chỉ xuống ở cạnh phải của ô thuộc cột toan, li, hoa, van, tin hàng Total và chọn max (lớn nhất).
1. Bước 6. Nháy nút [image: Bài tập và thực hành 6: Mẫu hỏi trên một bảng] hoặc chọn lệnh Query →→ Run để thực hiện mẫu hỏi. Kết quả được kết xuất trên trang dữ liệu của mẫu hỏi.
Chú ý:
1. Nếu trong khi chọn trường để đưa vào mẫu hỏi ta chỉ định nhầm trường thì có thể loại nó khỏi mẫu hỏi đang xây dựng bằng cách chọn trường đó rồi nhấn phím Delete.
1. Thứ tự các trường trong mẫu hỏi cũng có thể được thay đổi bằng cách chọn trường cần di chuyển rồi kéo thả đến vị trí mới.
	
Hoạt động của giáo viên
	Hoạt động của học sinh

	? Chọn trường nào để xử lí thông tin đưa vào mẫu hỏi

? Trong bảng lưới QBE chọn hàng nào để thực thi các lệnh lựa chọn
? Cách nào hiển thị hàng Totals trong lưới QBE
? Trong các cột toan, li… để thực hiện nhiệm vụ của bài toán chọn lệnh nào
? Thứ tự các trường trong mẫu hỏi có thể thay đổi được hay không? Nếu được thì thay đổi như thế nào?
- Gv yêu cầu học sinh thực hành, nêu các chú ý để học sinh quan sát
- Gv có thể thao tác trước các bước cho học sinh theo dõi và thực hành theo (đối với các lớp khả năng tự thực hành chưa được cao, với các lớp khá giỏi nên để các em tự nghiên cứu)
- Yêu cầu học sinh lưu lại bài tập
- Chỉnh sửa các sai sót, nêu các lưu ý
	- HS trả lời: Chọn các trường toan, van, li, hoa, tin trong bảng HOC_SINH;
- Chọn hàng totals

- Hs trả lời: Thực hiện lệnh View →Totals..
- Hs trả lời: Chọn lệnh max trong totals..

- Hs trả lời: Thứ tự các trường trong mẫu hỏi cũng có thể được thay đổi bằng cách chọn trường cần di chuyển rồi kéo thả đến vị trí mới.

- Hs thực hành nội dung trên máy tính cá nhân, lưu ý các hướng dẫn của giáo viên, ghi chép các bước và theo dõi giúp đỡ các bạn yếu kém.
- Hs lưu lại bài tập 
- Lắng nghe, ghi nhớ


1. Hoạt động 5: HƯỚNG DẪN VỀ  NHÀ
(a) Mục tiêu hoạt động: Giúp học sinh vận dụng, tìm tòi mở rộng các kiến thức trong bài học và tương tác với cộng đồng. Tùy theo năng lực mà các em có thể thực hiện các bài tập ở các mức độ khác nhau.
	(b) Phương pháp/ kỹ thuật: Gợi mở, đàm thoại, vấn đáp, đặt vấn đề.
	(c) Phương tiện dạy học: Sách giáo khoa, sách bài tập.
	(d) Hình thức tổ chức: Cá nhân và thảo luận nhóm
	(e) Sản phầm hoạt động: Học sinh nắm được các cách thức làm việc cơ bản với các đối tượng có trong access
Gợi ý phương thức tổ chức hoạt động
Nội dung: 
0. GV nhắc lại những vấn đề mà HS đã được học, Giáo viên nhận xét ưu, khuyết điểm của HS qua tiết thực hành.
0. Yêu cầu HS về nhà đọc và tập thao tác lại các nội dung đã làm
1. Qua bài này các em phải thực hiện được:
1. Việc tạo mẫu hỏi cho CSDL, thống kê và xử lý các thông tin cần thống kê trong mẫu hỏi.
1. Lưu lại các mẫu hỏi sau khi thực hiện thống kê theo yêu cầu của các bài toán thực tế.
1. Thực hiện các bài tập SGK
Gv đặt vấn đề chuyển giao nhiệm vụ đã nêu trong sách tài liệu để thực hiện ngoài lớp học. Gv có thể yêu cầu học sinh thực hiện các bài tập và gởi qua mail hoặc tạo thư mục chung cho học sinh gởi sản phẩm của mình.
Gv ghi nhận kết quả cam kết của cá nhân hoặc nhóm học sinh. Hướng dẫn, gợi ý cách thực hiện cho HS, hướng dẫn học sinh tự đánh giá hoặc đánh giá lẫn nhau.
IV. CÂU HỎI KIỂM TRA VÀ ĐÁNH GIÁ BÀI HỌC
	Câu hỏi
	Đáp án lựa chọn

	Câu 1: Để thêm hàng Total vào lưới thiết kế QBE, ta nháy vào nút lệnh:

	A. [image: ]	B. [image: ]			
C. [image: ]	D. [image: ]

	Câu 2: Để thực hiện mẫu hỏi ( đưa ra kết quả của truy vấn) ta có thể sử dụng cách nào sau đây? 

	1. Nháy nút  [image: ]       		
C.  Nháy nút [image: ]
1. Chọn lệnh View Datasheet View
D.  Cả 3 cách trên đều đúng

	Câu 3: Nếu thêm nhầm một bảng làm dữ liệu nguồn trong khi tạo mẫu hỏi, để bỏ bảng đó khỏi cửa sổ thiết kế, ta thực hiện:
	A. Edit Delete			
B. Query Remove Table
C. Chọn bảng cần xóa rồi nhấn phím Backspace
D. Tất cả đều đúng

	Câu 4: Để thêm bảng làm dữ liệu nguồn cho mẫu hỏi, ta nháy nút lệnh:

	A. [image: ]	B. [image: ]		
C. [image: ]	D. [image: ]

	Câu 5: Trong cửa sổ CSDL đang làm việc, để mở một mẫu hỏi đã có, ta thực hiện:

	A.Queries/ Nháy đúp vào tên mẫu hỏi.
B.Queries/ nháy nút Design.
C.Queries/ Create Query by using Wizard
D.Queries/ Create Query in Design Wiew.

	Câu 6: Trong cửa sổ CSDL đang làm việc, để tạo một Mẫu hỏi mới bằng cách dùng thuật sĩ, thao tác thực hiện lệnh nào sau đây là đúng?
	A. Chọn Tables /Create Table in Design View 
B. Chọn Queries/Create Query by using wizard
C. Chọn Queries/Create Query in Design View
D. Chọn Forms /Create Form by using wizard

	Câu 7: Trình tự thao tác để tạo mẫu hỏi bằng cách tự thiết kế, biết:
 (1) Chọn bảng hoặc mẫu hỏi khác làm dữ liệu nguồn
(2) Nháy nút [image: ]
(3) Nháy đúp vào Create query in Design view
(4) Chọn các trường cần thiết trong dữ liệu nguồn để đưa vào mẫu hỏi
(5) Mô tả điều kiện mẫu hỏi ở lưới QBE
	A. (1) -> (3) -> (4) -> (5) ->(2)	
B. (3) -> (1) -> (4) -> (5) ->(2)
C. (3) -> (1) -> (5) -> (4) ->(2)	
D. (3) -> (4) -> (5) -> (1) ->(2)





Tiết: 26
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MẪU HỎI TRÊN MỘT BẢNG (Tiết 3)
	I. MỤC TIÊU
Sau bài học, học sinh đạt được
1. Kiến thức
1. Biết khái niệm và công dụng của mẫu hỏi.
1. Biết vận dụng một số hàm, phép toán để xây dựng, biểu thức điều kiện và biểu thức logic để xây dựng mẫu hỏi.
2.  Kỹ năng
1. Thực hiện được tạo mẫu hỏi kết xuất thông tin từ một bảng.
1. Thực hiện được các thao tác tạo mẫu hỏi có sử dụng gộp nhóm ở mức độ đơn giản.
1. Tạo được những biểu thức điều kiện đơn giản.
3. Thái độ
1. Ham thích môn học, có tính kỷ luật cao
1. Nghiêm túc khi làm việc với dữ liệu
4. Định hướng hình thành năng lực: Năng lực tự học, năng lực giải quyết vấn đề, năng lực sáng tạo.
	II. CHUẨN BỊ CỦA GIÁO VIÊN VÀ HỌC SINH
1. Chuẩn bị của giáo viên
- Thiết bị dạy học: Phòng máy đã cài đặt Netop school, máy tính, máy chiếu.
- Học liệu: SGK, SGV, CSDL mẫu
2. Chuẩn bị của học sinh
- Chuẩn bị các nội dung liên quan đến bài học theo sự hướng dẫn của giáo viên như chuẩn bị tài liệu, TBDH, SGK, vở ghi chép, ...
- Sưu tầm tranh ảnh, tư liệu, …
	III. TỔ CHỨC CÁC HOẠT ĐỘNG HỌC TẬP
1. Ổn định lớp
2. Tiến trình bài học
A. HOẠT ĐỘNG KHỞI ĐỘNG
HĐ1: Kiểm tra bài cũ
(1) Mục tiêu: Tạo được mẫu hỏi trên một bảng
(2) Phương pháp/Kĩ thuật: Gợi mở, đàm thoại
(3) Hình thức tổ chức hoạt động: Cá nhân
(4) Phương tiện dạy học: Máy tính
(5) Sản phẩm: HS tạo được mẫu hỏi theo yêu cầu
	Hoạt động của GV
	Hoạt động của HS

	Giao nhiệm vụ
- Trong CSDL Quanli_HS, tạo mẫu hỏi để so sánh tổng điểm môn Toán và môn Văn theo giới tính.
- Gọi 1 HS lên thao tác trên máy chủ.
- Giáo nhận xét và cho điểm, GV có thể thực hiện lại các thao tác cho HS đối chiếu kết quả đồng thời cũng cố các bước tạo mẫu hỏi cho HS.
	

Nhận và thực hiện nhiệm vụ




B. HÌNH THÀNH KIẾN THỨC VÀ LUYỆN TẬP
HĐ2: Tìm hiểu Bài tập 3/68 SGK
(1) Mục tiêu: Tạo được mẫu hỏi trên một bảng 
(2) Phương pháp/Kĩ thuật: Gợi mở, đàm thoại, vấn đáp, đặt vấn đề, hướng dẫn mẫu.
(3) Hình thức tổ chức hoạt động: Cá nhân và thảo luận nhóm nhỏ.
(4) Phương tiện dạy học: Máy tính
(5) Sản phẩm: Thực hành được bài tập 3/68 SGK.
	Hoạt động của GV
	Hoạt động của HS

	Giao nhiệm vụ
Nghiên cứu kỹ nội dung bài tập 3 và trả lời các câu hỏi sau:
(1) Sử dụng đối tượng nào để xử lý?
(2) Dữ liệu lấy từ bảng nào? Gồm những trường nào?
(3) Sử dụng phép toán nào để thực hiện?
(4) Có gộp nhóm hay không?
(5) Nêu các bước để thực hiện?
Giáo viên quan sát, giúp đỡ




Tổ chức thảo luận, trao đổi, báo cáo



Chính xác hóa câu trả lời của HS.
Giáo viên yêu cầu HS thực hành trên máy và lưu lại kết quả. Giáo viên có thể thao tác trước và yêu cầu HS quan sát.
Quan sát giúp đỡ những HS gặp khó khăn và chỉnh sửa các sai sót nếu có.
	Nhận nhiệm vụ


Thực hiện nhiệm vụ


Dự kiến câu trả lời của HS
(1) Queries
(2) HOC_SINH (Quanli_HS): Toan, Li, Hoa, Van, Tin
(3) Max
(4) Không gộp nhóm
(5) Các bước thực hiện
B1. Chọn đối tượng Queries;
B2. Create query in Design view;
B3. Trong của sổ Show Table → chọn tên bảng HOC_SINH → Add → Close 
B4. Nháy đúp chuột vào tên trường: toan, van, li, hoa, tin trong bảng HOC_SINH;
B5. Chọn lệnh View → Totals.. Tại hàng Total, nháy chuột tại nút ComboBox cột toan, li, hoa, van, tin và chọn max (lớn nhất).
B6. Nháy nút [image: ] hoặc chọn lệnh Query → Run để thực hiện mẫu hỏi. Kết quả được kết xuất trên trang dữ liệu của mẫu hỏi.



C. VÂN DỤNG, TÌM TÒI, MỞ RỘNG
(1) Mục tiêu: Tạo được mẫu hỏi trên một bảng
(2) Phương pháp/Kĩ thuật: Gợi mở, đàm thoại, vấn đáp, đặt vấn đề, hướng dẫn mẫu.
(3) Hình thức tổ chức hoạt động: Cá nhân và thảo luận nhóm nhỏ.
(4) Phương tiện dạy học: Máy tính
(5) Sản phẩm: Thực hành được bài tập bài tập theo yêu cầu.
	Hoạt động của GV
	Hoạt động của HS

	Giao nhiệm vụ
Sử dụng CSDL Quanli_HS, tạo mẫu hỏi THONGKE thống kê điểm cao nhất của tất cả các bạn trong từng tổ theo từng môn Toan, Li, Hoa, Van, Tin.
Nghiên cứu kỹ nội dung bài tập và trả lời các câu hỏi sau:
(1) Có gộp nhóm hay không?
(2) Nêu các bước để thực hiện?
Giáo viên quan sát, giúp đỡ




Tổ chức thảo luận, trao đổi, báo cáo


Chính xác hóa câu trả lời của HS.
Giáo viên yêu cầu HS thực hành trên máy và lưu lại kết quả. Giáo viên có thể thao tác trước và yêu cầu HS quan sát.
Quan sát giúp đỡ những HS gặp khó khăn và chỉnh sửa các sai sót nếu có.
	Nhận nhiệm vụ


Thực hiện nhiệm vụ

Dự kiến câu trả lời của HS
(1) Có gộp nhóm (trường To)
(2) Các bước thực hiện
B1. Chọn đối tượng Queries;
B2. Create query in Design view;
B3. Trong của sổ Show Table → chọn tên bảng HOC_SINH → Add → Close 
B4. Nháy đúp chuột vào tên trường: To, toan, van, li, hoa, tin trong bảng HOC_SINH;
B5. Chọn lệnh View → Totals.. Tại hàng Total, nháy chuột tại nút ComboBox cột To chọn Group by và cột toan, li, hoa, van, tin và chọn max (lớn nhất).
B6. Nháy nút [image: ] hoặc chọn lệnh Query → Run để thực hiện mẫu hỏi. Kết quả được kết xuất trên trang dữ liệu của mẫu hỏi.



IV.  HƯỚNG DẪN HỌC Ở NHÀ (2 phút)
- Thực hiện các bài tập về mẫu hỏi
- Trả lời các câu hỏi sau bài học
- Chuẩn bị nội dung cho bài thực hành 7: Mẫu hỏi trên nhiều bảng


Tiết: 27,28
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MẪU HỎI TRÊN MỘT BẢNG (Tiết 1-2)

	I. MỤC TIÊU
Sau bài học, học sinh đạt được
1. Kiến thức
1. Biết khái niệm và công dụng của mẫu hỏi.
1. Biết vận dụng một số hàm, phép toán để xây dựng, biểu thức điều kiện và biểu thức logic để xây dựng mẫu hỏi trên nhiều bảng.
2. Kỹ năng
1. Thực hiện được tạo mẫu hỏi kết xuất thông tin từ nhiều bảng.
1.  Củng cố và rèn luyện kĩ năng tạo mẫu hỏi.
3. Thái độ
1. Ham thích môn học, có tính kỷ luật cao
1. Nghiêm túc khi làm việc với dữ liệu
4. Định hướng hình thành năng lực: Năng lực tự học, năng lực giải quyết vấn đề, năng lực sáng tạo.
	II. CHUẨN BỊ CỦA GIÁO VIÊN VÀ HỌC SINH
1. Chuẩn bị của giáo viên
- Thiết bị dạy học: Phòng máy đã cài đặt Netop school, máy tính, máy chiếu.
- Học liệu: SGK, SGV, CSDL mẫu
2. Chuẩn bị của học sinh
- Chuẩn bị các nội dung liên quan đến bài học theo sự hướng dẫn của giáo viên như chuẩn bị tài liệu, TBDH, SGK, vở ghi chép, ...
- Sưu tầm tranh ảnh, tư liệu, …
	III. TỔ CHỨC CÁC HOẠT ĐỘNG HỌC TẬP
1. Ổn định lớp
2. Tiến trình bài học
A. HOẠT ĐỘNG KHỞI ĐỘNG
HĐ1: Kiểm tra bài cũ
(1) Mục tiêu: Tạo được mẫu hỏi trên một bảng
(2) Phương pháp/Kĩ thuật: Gợi mở, đàm thoại
(3) Hình thức tổ chức hoạt động: Cá nhân
(4) Phương tiện dạy học: Máy tính
(5) Sản phẩm: HS tạo được mẫu hỏi theo yêu cầu
	Hoạt động của GV
	Hoạt động của HS

	Giao nhiệm vụ
Sử dụng CSDL Quanli_HS, tạo mẫu hỏi THGKE thống kê điểm thấp nhất của từng môn Toan, Li, Hoa, Van, Tin theo giới tính.
- Gọi 1 HS lên thao tác trên máy chủ.
- Giáo nhận xét và cho điểm, GV có thể thực hiện lại các thao tác cho HS đối chiếu kết quả đồng thời cũng cố các bước tạo mẫu hỏi cho HS.
	

Nhận và thực hiện nhiệm vụ




B. HÌNH THÀNH KIẾN THỨC VÀ LUYỆN TẬP
HĐ2: Tìm hiểu Bài tập 1/69 SGK
(1) Mục tiêu: Tạo được mẫu hỏi trên nhiều bảng 
(2) Phương pháp/Kĩ thuật: Gợi mở, đàm thoại, vấn đáp, đặt vấn đề, hướng dẫn mẫu.
(3) Hình thức tổ chức hoạt động: Cá nhân và thảo luận nhóm nhỏ.
(4) Phương tiện dạy học: Máy tính
(5) Sản phẩm: Thực hành được bài tập 1/69 SGK.
	Hoạt động của GV
	Hoạt động của HS

	Giao nhiệm vụ
Nghiên cứu kỹ nội dung bài tập 1 và trả lời các câu hỏi sau:
(1) Sử dụng đối tượng nào để xử lý?
(2) Lấy dữ liệu từ những trường nào?
(3) Có gộp nhóm hay không?
(4) Nêu các bước để thực hiện?
Giáo viên quan sát, giúp đỡ




Tổ chức thảo luận, trao đổi, báo cáo



Chính xác hóa câu trả lời của HS.
Giáo viên yêu cầu HS thực hành trên máy và lưu lại kết quả. Giáo viên có thể thao tác trước và yêu cầu HS quan sát.
Quan sát giúp đỡ những HS gặp khó khăn và chỉnh sửa các sai sót nếu có.
	Nhận nhiệm vụ


Thực hiện nhiệm vụ


Dự kiến câu trả lời của HS
(1) Queries
(2) MAT_HANG: Ten_san_pham; HOA_DON: Ma_khach_hang
(3) Có gộp nhóm (Ten_san_pham)
(4) Các bước thực hiện
B1. Chọn đối tượng Queries;
B2. Create query in Design view;
B3. Trong của sổ Show Table, chọn tên bảng MAT_HANG nháy Add; HOA_DON nháy Add, nháy Close 
B4. Nháy đúp chuột vào tên trường: Ten_san_pham trong bảng MAT_HANG; và Ma_khach_hang trong bảng HOA_DON
B5. Chọn lệnh View → Totals.. Tại hàng Total, nháy chuột tại nút ComboBox cột Ten_san_pham chọn Group by và cột Ma_khach_hang  chọn Count (đếm).
B6. Nháy nút [image: ] hoặc chọn lệnh Query → Run để thực hiện mẫu hỏi. Kết quả được kết xuất trên trang dữ liệu của mẫu hỏi.



HĐ3: Tìm hiểu Bài tập 2/69 SGK
(1) Mục tiêu: Tạo được mẫu hỏi trên nhiều bảng 
(2) Phương pháp/Kĩ thuật: Gợi mở, đàm thoại, vấn đáp, đặt vấn đề, hướng dẫn mẫu.
(3) Hình thức tổ chức hoạt động: Cá nhân và thảo luận nhóm nhỏ.
(4) Phương tiện dạy học: Máy tính
(5) Sản phẩm: Thực hành được bài tập 2/69 SGK.
	Hoạt động của GV
	Hoạt động của HS

	Giao nhiệm vụ
Nghiên cứu kỹ nội dung bài tập 2 và trả lời các câu hỏi sau:
(1) Sử dụng đối tượng nào để xử lý?
(2) Lấy dữ liệu từ những trường nào?
(3) Có gộp nhóm hay không?
(4) Nêu các bước để thực hiện?
Giáo viên quan sát, giúp đỡ




Tổ chức thảo luận, trao đổi, báo cáo



Chính xác hóa câu trả lời của HS.
Giáo viên yêu cầu HS thực hành trên máy và lưu lại kết quả. Giáo viên có thể thao tác trước và yêu cầu HS quan sát.
Quan sát giúp đỡ những HS gặp khó khăn và chỉnh sửa các sai sót nếu có.
	Nhận nhiệm vụ


Thực hiện nhiệm vụ


Dự kiến câu trả lời của HS
(1) Queries
(2) MAT_HANG: Ten_san_pham; HOA_DON: Don_gia
(3) Có gộp nhóm (Ten_san_pham)
(4) Các bước thực hiện
B1. Chọn đối tượng Queries;
B2. Create query in Design view;
B3. Trong của sổ Show Table, chọn tên bảng MAT_HANG nháy Add; HOA_DON nháy Add, nháy Close 
B4. Nháy đúp chuột vào tên trường: Ten_san_pham trong bảng MAT_HANG; và Don_gia trong bảng HOA_DON (3 lần)
B5. Chọn lệnh View → Totals.. Tại hàng Total, nháy chuột tại nút ComboBox cột Ten_san_pham chọn Group by, cột Don_gia thứ nhất chọn AVG (Trung bình), Don_gia thứ hai chọn MAX (Lớn nhất) và Don_gia thứ ba chọn MIN (Nhỏ nhất)
B6. Nháy nút [image: ] hoặc chọn lệnh Query → Run để thực hiện mẫu hỏi. Kết quả được kết xuất trên trang dữ liệu của mẫu hỏi.



C. VẬN DỤNG, TÌM TÒI, MỞ RỘNG
(1) Mục tiêu: Tạo được mẫu hỏi trên nhiều bảng
(2) Phương pháp/Kĩ thuật: Gợi mở, đàm thoại, vấn đáp, đặt vấn đề, hướng dẫn mẫu.
(3) Hình thức tổ chức hoạt động: Cá nhân và thảo luận nhóm nhỏ.
(4) Phương tiện dạy học: Máy tính
(5) Sản phẩm: Thực hành được bài tập bài tập theo yêu cầu.
	Hoạt động của GV
	Hoạt động của HS

	Giao nhiệm vụ
Sử dụng CSDL KINH_DOANH, tạo mẫu hỏi THANHTOAN để tính tổng tiền cho từng khách hàng.
Nghiên cứu kỹ nội dung bài tập và trả lời các câu hỏi sau:
(1) Có gộp nhóm hay không?
(2) Nêu các bước để thực hiện?
Giáo viên quan sát, giúp đỡ



Tổ chức thảo luận, trao đổi, báo cáo


Chính xác hóa câu trả lời của HS.
Giáo viên yêu cầu HS thực hành trên máy và lưu lại kết quả. Giáo viên có thể thao tác trước và yêu cầu HS quan sát.
Quan sát giúp đỡ những HS gặp khó khăn và chỉnh sửa các sai sót nếu có.
	Nhận nhiệm vụ


Thực hiện nhiệm vụ

Dự kiến câu trả lời của HS
(1) Có gộp nhóm (trường Ho_ten)
(2) Các bước thực hiện
B1. Chọn đối tượng Queries;
B2. Create query in Design view;
B3. Trong của sổ Show Table → chọn đồng thời 3 bảng KHACH_HANG, HOA_DON, MAT_HANG → Add → Close 
B4. Nháy đúp chuột vào tên trường: Ho_ten trong bảng KHACH_HANG; cột tiếp theo ở Field gõ Tong_tien: [Don_gia]*[So_luong]
B5. Chọn lệnh View → Totals.. Tại hàng Total, nháy chuột tại nút ComboBox cột Ho_ten chọn Group by và cột Tong_tien và chọn Sum (Tổng).
B6. Nháy nút [image: ] hoặc chọn lệnh Query → Run để thực hiện mẫu hỏi. Kết quả được kết xuất trên trang dữ liệu của mẫu hỏi.



IV.  HƯỚNG DẪN HỌC Ở NHÀ 
- Thực hiện các bài tập về mẫu hỏi
- Trả lời các câu hỏi sau bài học
- Chuẩn bị nội dung cho bài thực hành 7: Mẫu hỏi trên nhiều bảng (Tiết 3)


 Tiết: 29
BÀI TẬP VÀ THỰC HÀNH 7
MẪU HỎI TRÊN MỘT BẢNG (Tiết 3)

	I. MỤC TIÊU
Sau bài học, học sinh đạt được
1. Kiến thức
1. Biết khái niệm và công dụng của mẫu hỏi.
1. Biết vận dụng một số hàm, phép toán để xây dựng, biểu thức điều kiện và biểu thức logic để xây dựng mẫu hỏi trên nhiều bảng.
2. Kỹ năng
1. Thực hiện được tạo mẫu hỏi kết xuất thông tin từ nhiều bảng.
1.  Củng cố và rèn luyện kĩ năng tạo mẫu hỏi.
3. Thái độ
1. Ham thích môn học, có tính kỷ luật cao
1. Nghiêm túc khi làm việc với dữ liệu
4. Định hướng hình thành năng lực: Năng lực tự học, năng lực giải quyết vấn đề, năng lực sáng tạo.
	II. CHUẨN BỊ CỦA GIÁO VIÊN VÀ HỌC SINH
1. Chuẩn bị của giáo viên
- Thiết bị dạy học: Phòng máy đã cài đặt Netop school, máy tính, máy chiếu.
- Học liệu: SGK, SGV, CSDL mẫu
2. Chuẩn bị của học sinh
- Chuẩn bị các nội dung liên quan đến bài học theo sự hướng dẫn của giáo viên như chuẩn bị tài liệu, TBDH, SGK, vở ghi chép, ...
- Sưu tầm tranh ảnh, tư liệu, …
	III. TỔ CHỨC CÁC HOẠT ĐỘNG HỌC TẬP
1. Ổn định lớp
2. Kiểm tra bài cũ (Trong giờ thực hành)
3. Tiến trình bài học
A. HOẠT ĐỘNG KHỞI ĐỘNG
HĐ1: Tìm hiểu bài toán quản lý thư viện
(1) Mục tiêu: Tạo tình huống có vấn đề để HS có nhu cầu quản lý
(2) Phương pháp/Kĩ thuật: Gợi mở, đàm thoại
(3) Hình thức tổ chức hoạt động: Cá nhân
(4) Phương tiện dạy học: Máy tính, máy chiếu
(5) Sản phẩm: HS có nhu cầu quản lý
	Hoạt động của GV
	Hoạt động của HS

	Giao nhiệm vụ
Để quản lý việc học sinh mượn sách ở thư viện của một trường, thông thường thư viện cần quản lý những thông tin gì?
Quan sát giúp đỡ HS gặp khó khăn

GV chính xác hóa câu trả lời của HS
	Nhận và thực hiện nhiệm vụ
Dự kiến câu trả lời của HS
- Tình hình mượn sách: Số thẻ, mã số sách, ngày mượn, ngày trả.
- Các học sinh có thẻ mượn sách: Số thẻ, họ tên, ngày sinh, lớp
- Sách có trong thư viện: Mã số sách, tên sách, số trang, tác giả, ...


B. HÌNH THÀNH KIẾN THỨC VÀ LUYỆN TẬP
HĐ2: Xây dựng CSDL THUVIEN
(1) Mục tiêu: Tạo được các bảng và mối liên kết giữa các bảng. 
(2) Phương pháp/Kĩ thuật: Gợi mở, đàm thoại, vấn đáp, đặt vấn đề, hướng dẫn mẫu.
(3) Hình thức tổ chức hoạt động: Cá nhân và thảo luận nhóm nhỏ.
(4) Phương tiện dạy học: Máy tính, máy chiếu
(5) Sản phẩm: Xây dựng được CSDL THUVIEN
	Hoạt động của GV
	Hoạt động của HS

	Giao nhiệm vụ
(1) Tạo bảng MUONSACH (Sothe, Masosach, Ngaymuon, Ngaytra)
(2) Tạo bảng NGUOIMUON (Sothe, Hoten, Ngaysinh, Lop)
(3) Tạo bảng SACH (Masosach, Tensach, Sotrang, Tacgia)
(4) Nhập dữ liệu cho 3 bảng (mỗi bảng ít nhất 5 mẫu tin)
(5) Thực hiện liên kết giữa các bảng
Giáo viên quan sát, giúp đỡ

Tổ chức thảo luận, trao đổi, và thực hành
Chính xác hóa câu trả lời của HS.
Giáo viên yêu cầu HS thực hành trên máy và lưu lại kết quả. 
	Nhận nhiệm vụ và thực hiện nhiệm vụ






Dự kiến câu trả lời của HS
Học sinh tạo được CSDL THUVIEN theo yêu cầu.


HĐ3: Tạo mẫu hỏi 
(1) Mục tiêu: Tạo được mẫu hỏi trên nhiều bảng 
(2) Phương pháp/Kĩ thuật: Gợi mở, đàm thoại, vấn đáp, đặt vấn đề, hướng dẫn mẫu.
(3) Hình thức tổ chức hoạt động: Cá nhân và thảo luận nhóm nhỏ.
(4) Phương tiện dạy học: Máy tính
(5) Sản phẩm: Thực hành được các mẫu hỏi theo yêu cầu.
	Hoạt động của GV
	Hoạt động của HS

	Giao nhiệm vụ
BT1. Tạo mẫu hỏi liệt kê đếm số sách đã mượn của từng học sinh;
BT2. Tạo mẫu hỏi liệt kê tên sách cùng số lần được mượn của cuốn sách đó.
Với mỗi bài HS trả lời các câu hỏi sau:
(1) Sử dụng đối tượng nào để xử lý?
(2) Lấy dữ liệu từ những bảng  nào?
(3) Có gộp nhóm hay không?
(4) Nêu các bước để thực hiện?

Giáo viên quan sát, giúp đỡ







Tổ chức thảo luận, trao đổi, báo cáo



Chính xác hóa câu trả lời của HS.
Giáo viên yêu cầu HS thực hành trên máy và lưu lại kết quả. Giáo viên có thể thao tác trước và yêu cầu HS quan sát.
Quan sát giúp đỡ những HS gặp khó khăn và chỉnh sửa các sai sót nếu có.
	Nhận nhiệm vụ


Thực hiện nhiệm vụ


Dự kiến câu trả lời của HS
BT1
(1) Queries
(2) SACH, NGUOIMUON, MUONSACH
(3) Có gộp nhóm (Hoten)
(4) Các bước thực hiện
B1. Chọn đối tượng Queries;
B2. Create query in Design view;
B3. Trong của sổ Show Table, chọn 3 bảng SACH, NGUOIMUON, MUONSACH nháy Add, nháy Close 
B4. Nháy đúp chuột vào tên trường: Hoten trong bảng NGUOIMUON; và Tensach trong bảng SACH.
B5. Chọn lệnh View → Totals.. Tại hàng Total, nháy chuột tại nút ComboBox cột Hoten chọn Group by, cột Tensach chọn Count
B6. Nháy nút [image: ] hoặc chọn lệnh Query → Run để thực hiện mẫu hỏi. Kết quả được kết xuất trên trang dữ liệu của mẫu hỏi.
BT2
(1) Queries
(2) SACH, MUONSACH
(3) Có gộp nhóm (Tensach)
(4) Các bước thực hiện
B1. Chọn đối tượng Queries;
B2. Create query in Design view;
B3. Trong của sổ Show Table, chọn 2 bảng SACH,  MUONSACH nháy Add, nháy Close 
B4. Nháy đúp chuột vào tên trường: Tensach trong bảng SACH và Masosach trong bảng SACH
B5. Chọn lệnh View → Totals.. Tại hàng Total, nháy chuột tại nút ComboBox cột Tensach chọn Group by, cột Masosach chọn Count
B6. Nháy nút [image: ] hoặc chọn lệnh Query → Run để thực hiện mẫu hỏi. Kết quả được kết xuất trên trang dữ liệu của mẫu hỏi.


C. VẬN DỤNG, TÌM TÒI, MỞ RỘNG
(1) Mục tiêu: Tạo được mẫu hỏi trên nhiều bảng
(2) Phương pháp/Kĩ thuật: Gợi mở, đàm thoại, vấn đáp, đặt vấn đề, hướng dẫn mẫu.
(3) Hình thức tổ chức hoạt động: Cá nhân và thảo luận nhóm nhỏ.
(4) Phương tiện dạy học: Máy tính
(5) Sản phẩm: Thực hành được bài tập bài tập theo yêu cầu.
	Hoạt động của GV
	Hoạt động của HS

	Giao nhiệm vụ
Sử dụng CSDL THUVIEN, tạo mẫu hỏi cho biết số sách được mượn trong một ngày nào đó (Ví dụ: 24/09/2007).
Nghiên cứu kỹ nội dung bài tập và trả lời các câu hỏi sau:
(1) Có gộp nhóm hay không?
(2) Nêu các bước để thực hiện?
Giáo viên quan sát, giúp đỡ




Tổ chức thảo luận, trao đổi, báo cáo


Chính xác hóa câu trả lời của HS.
Giáo viên yêu cầu HS thực hành trên máy và lưu lại kết quả. Giáo viên có thể thao tác trước và yêu cầu HS quan sát.
Quan sát giúp đỡ những HS gặp khó khăn và chỉnh sửa các sai sót nếu có.
	Nhận nhiệm vụ


Thực hiện nhiệm vụ

Dự kiến câu trả lời của HS
(1) Có gộp nhóm (trường Ngaymuon)
(2) Các bước thực hiện
B1. Chọn đối tượng Queries;
B2. Create query in Design view;
B3. Trong của sổ Show Table → chọn đồng thời 2 bảng SACH, MUONSACH → Add → Close 
B4. Nháy đúp chuột vào tên trường: Ngaymuon trong bảng MUONSACH; và trường Tensach trong bảng SACH
B5. Chọn lệnh View → Totals.. Tại hàng Total, nháy chuột tại nút ComboBox cột Ngaymuon chọn Group by và cột Tensach và chọn Count.
B6. Nháy nút [image: ] hoặc chọn lệnh Query → Run để thực hiện mẫu hỏi. Kết quả được kết xuất trên trang dữ liệu của mẫu hỏi.



IV.  HƯỚNG DẪN HỌC Ở NHÀ
- Thực hiện các bài tập về mẫu hỏi
- Trả lời các câu hỏi sau bài học
- Chuẩn bị nội dung cho bài 9: Báo cáo và kết xuất báo cáo

Tiết: 30
Bài 9. BÁO CÁO VÀ KẾT XUẤT BÁO CÁO

	I. MỤC TIÊU
Sau bài học, học sinh đạt được
1. Kiến thức
- Thấy được lợi ích của báo cáo trong công việc quản lí;
- Biết các thao tác tạo báo cáo đơn giản.
2. Kỹ năng
- Tạo được báo cáo bằng thuật sĩ.
- Thực hiện được lưu trữ và in báo cáo.
3. Thái độ
1. Ham thích môn học, có tính kỷ luật cao
1. Tự giác tích cực trong học tập
4. Định hướng hình thành năng lực: Năng lực tự học, năng lực giải quyết vấn đề, năng lực giao tiếp.
	II. CHUẨN BỊ CỦA GIÁO VIÊN VÀ HỌC SINH
1. Chuẩn bị của giáo viên
- Thiết bị dạy học: Máy tính, máy chiếu.
- Học liệu: SGK, SGV, CSDL mẫu
2. Chuẩn bị của học sinh
- Chuẩn bị các nội dung liên quan đến bài học theo sự hướng dẫn của giáo viên như chuẩn bị tài liệu, TBDH, SGK, vở ghi chép, ...
- Sưu tầm tranh ảnh, tư liệu, …
	III. TỔ CHỨC CÁC HOẠT ĐỘNG HỌC TẬP
1. Ổn định lớp
2. Tiến trình bài học
A. HOẠT ĐỘNG KHỞI ĐỘNG
HĐ1: Kiểm tra bài cũ
(1) Mục tiêu: Tạo được mẫu hỏi trên một bảng
(2) Phương pháp/Kĩ thuật: Gợi mở, đàm thoại
(3) Hình thức tổ chức hoạt động: Cá nhân
(4) Phương tiện dạy học: Máy tính, máy chiếu
(5) Sản phẩm: HS tạo được mẫu hỏi theo yêu cầu
	Hoạt động của GV
	Hoạt động của HS

	Giao nhiệm vụ
Sử dụng CSDL Quanli_HS, hãy tạo mẫu hỏi hiển thị điểm trung bình môn toán và môn văn giữa các tổ.
- Gọi 1 HS lên thao tác trên máy chủ.
- Giáo nhận xét và cho điểm, GV có thể thực hiện lại các thao tác cho HS đối chiếu kết quả đồng thời cũng cố các bước tạo mẫu hỏi cho HS.
	

Nhận và thực hiện nhiệm vụ

Dự kiến kết quả HS thực hiện được như H1


[image: ]
H1

[image: ]
H2
HĐ2. Tạo tình huống có vấn đề để vào bài mới
(1) Mục tiêu: Tạo tình huống có vấn đề để HS có nhu cầu sử dụng báo cáo
(2) Phương pháp/Kĩ thuật: Đàm thoại, phát hiện, khai thác mối quan hệ giữa thực tiễn với tin học.
(3) Hình thức tổ chức hoạt động: Làm việc cá nhân, thảo luận nhóm
(4) Phương tiện dạy học: Máy tính, máy chiếu
(5) Sản phẩm: HS có nhu cầu sử dụng báo cáo.
	Hoạt động của GV
	Hoạt động của HS

	Giao nhiệm vụ
Hãy so sánh ưu nhược điểm của H1 (sử dụng mẫu hỏi) và H2 (sử dụng báo cáo)


Giáo viên quan sát giúp đỡ



GV chính xác hóa câu trả lời của HS từ đó dẫn dắt vào bài mới.


	Nhận và thực hiện nhiệm vụ

Dự kiến câu trả lời của HS
- Ở H2 có thể tổng hợp, trình bày linh hoạt và in dữ liệu theo khuôn dạng nhất định (đặc biệt là khả năng gộp nhóm). Ở H1 trình bày không linh hoạt.
- Trong H2 có thể so sánh, tổng hợp và tính tổng theo nhóm các tập hợp dữ liệu lớn.
- Trong H2 có thể hiển thị cả chi tiết lẫn tổng hợp; H1 chỉ hiện thị tổng hợp (không hiển thị được chi tiết).


B. HÌNH THÀNH KIẾN THỨC VÀ LUYỆN TẬP
HĐ3. Khái niệm
(1)Mục tiêu: Nêu khái niệm báo cáo.
(2)Phương pháp/kĩ thuật dạy học: Đàm thoại, vấn đáp.
(3)Hình thức tổ chức: Làm việc cá nhân, thảo luận nhóm nhỏ.
(4)Phương tiện dạy học: SGK, Máy tính, máy chiếu.
(5)Sản phẩm: HS phát biểu được khái niệm báo cáo.
Nội dung hoạt động
	Hoạt động của GV
	Hoạt động của HS

	GV yêu cầu HS nghiên cứu SGK và trả lời các câu hỏi sau:
(1) Khái niệm báo cáo? Lợi ích của báo cáo?
(2) Để tạo một báo cáo, trước tiên ta phải làm gì?


Quan sát giúp đỡ HS gặp khó khăn




GV chính xác hóa câu trả lời của HS

	HS nhận và thực hiện nhiệm vụ

Dự kiến câu trả lời của HS
(1) - Báo cáo là hình thức thích hợp nhất khi cần tổng hợp, trình bày và in dữ liệu theo khuôn dạng.
- Thể hiện được sự so sánh và tổng hợp thông tin từ các nhóm dữ liệu. Trình bày nội dung văn bản theo mẫu quy định.
(2) Để tạo một báo cáo cần trả lời các câu hỏi sau
+ Báo cáo được tạo ra để kết xuất những thông tin gì?
+ Dữ liệu từ những bảng, mẫu hỏi nào sẽ được đưa vào báo cáo?
+ Dữ liệu sẽ được nhóm như thế nào?


HĐ4. Dùng thuật sĩ để tạo báo cáo
(1)Mục tiêu: Biết tạo được báo cáo bằng thuật sĩ.
(2)Phương pháp/kĩ thuật dạy học: Đàm thoại, vấn đáp.
(3)Hình thức tổ chức: Làm việc cá nhân, thảo luận nhóm nhỏ.
(4)Phương tiện dạy học: SGK, Máy tính, máy chiếu.
(5)Sản phẩm: HS tạo được báo cáo đơn giản bằng thuật sĩ.
Nội dung hoạt động
	Hoạt động của GV
	Hoạt động của HS

	GV yêu cầu HS nghiên cứu SGK và trả lời các câu hỏi sau:
(1) Để làm việc với báo cáo ta chọn đối tượng nào?
(2) Để tạo nhanh một báo cáo, thường thực hiện theo các bước nào?
(3) Dùng thuật sĩ để tạo báo thông qua những bước nào?


Quan sát giúp đỡ HS gặp khó khăn




GV chính xác hóa câu trả lời của HS





Giáo viên thực hiện mẫu để tạo được mẫu báo cáo hình 56 SGK, yêu câu HS chú ý quan sát.
	HS nhận và thực hiện nhiệm vụ

Dự kiến câu trả lời của HS
(1) Reports trong bảng chọn đối tượng
(2) – Dùng thuật sĩ để tạo báo cáo
- Sửa đổi thiết kế báo cáo được tạo ra ở bước trên
(3) Các bước
B1. Nháy đúp Create report by using wizard.
B2. Trong hộp thoại Report Wizard
- Chọn dữ liệu nguồn cho báo cáo ở mục Tables/Queries
- Chọn các trường đưa vào báo báo từ ô Avaiable Fields
- Nháy Next
B3. Chọn các trường để gộp nhóm (nếu có)
B4. Chỉ ra các trường sắp xếp các bản ghi và các yêu cầu thống kê
B5. Chọn cách bố trí và kiều trình bày. Nháy Next.
B6. Đặt tên cho báo cáo. Nháy Finish.


C. VẬN DỤNG, TÌM TÒI, MỞ RỘNG
 (1) Mục tiêu: Tạo được mẫu hỏi trên nhiều bảng
(2) Phương pháp/Kĩ thuật: Gợi mở, đàm thoại, vấn đáp, đặt vấn đề, hướng dẫn mẫu.
(3) Hình thức tổ chức hoạt động: Cá nhân và thảo luận nhóm nhỏ.
(4) Phương tiện dạy học: Máy tính
(5) Sản phẩm: Thực hành được bài tập bài tập theo yêu cầu.
Nội dung hoạt động
	Hoạt động của GV
	Hoạt đông của HS

	Giao nhiệm vụ
Trong CSDL QUANLI_HS tạo mẫu hỏi THONG_KE có sử dụng các hàm gộp nhóm để so sánh trung bình điểm Toán và điểm Văn giữa các tổ và chỉnh sửa cho đẹp như hình H2

Quan sát giúp đỡ HS gặp khó khăn

Gọi HS đại diện 1 hoặc 2 nhóm trình bày GV, cùng các bạn ở dưới quan sát, nhóm được gọi trợ giúp hoàn thiện sản phảm của nhóm.


Giáo viên chính xác hóa lại kết quả
	HS nhận và thực hiện nhiệm vụ
Dự kiến các bước thực hiện của HS
B1.Trong CSDL chọn đối tượng Reports. Nháy đúp chuột vào Create reports by using wizard
B2. Trong hộp thoại Reports wizard, chọn thông tin đưa vào báo cáo:
+ Tables/Queries:Chọn các bảng Học_sinh.
+ Chọn các trường hodem, ten, to, toan, van đưa vào báo cáo.
B3. Chọn trường To để gộp nhóm.
B4. Chọn trường ten sắp thứ tự các bản ghi và chọn SumaryOptions và hàm AVG cho trường toan, van.
B5.Chọn các bố trí và kiểu trình bày báo cáo.
B6. Đặt tên HOC_SINH, chọn kiểu hiện báo cáo, nháy  Finish.


IV.  HƯỚNG DẪN HỌC Ở NHÀ
- Thực hiện các bài tập về mẫu hỏi
- Trả lời các câu hỏi sau bài học
- Chuẩn bị nội dung cho bài thực hành 8: Tạo báo cáo

 Tiết: 31
BÀI TẬP VÀ THỰC HÀNH 8
TẠO BÁO CÁO (TIẾT 1)
I. MỤC TIÊU BÀI HỌC
1. Kiến thức, kỹ năng và thái độ
Kiến thức: Củng cố lại những kiến thức đã học về cách tạo báo cáo.
Kỹ năng: Tạo được báo cáo đơn giản.
2. Đinh hướng phát triển năng lực: 
Năng lực quan sát, năng lực phát hiện và giải quyết vấn đề.
II. PHƯƠNG PHÁP - KĨ THUẬT DẠY HỌC
Trực quan, phát vấn, giảng giải
III. PHƯƠNG TIỆN DẠY HỌC
1. Giáo viên: 
Giáo án, SGK.
GV nên chuẩn bị sẵn CSDL, máy chiếu, phòng máy.
2. Học sinh:
Đọc trước nội dung của bài thực hành
Sách giáo khoa
IV. TỔ CHỨC CÁC HOẠT ĐỘNG DẠY HỌC
1. Ổn định lớp
Điểm diện, bố trí chỗ ngồi cho học sinh trong phòng máy..
2. Chuỗi các hoạt động
A. HOẠT ĐỘNG KHỞI ĐỘNG
- Mục tiêu: Tạo động cơ để học sinh có nhu cầu quan tâm đến việc khai thác CSDL QuanLi_HS
- Phương pháp/kỹ thuật dạy học: Trực quan, cá nhân, thảo luận nhóm
- Phương tiện dạy học: SGK, máy tính, máy chiếu
- Sản phẩm: Học sinh có nhu cầu về tạo báo cáo.
Nội dung hoạt động
	Hoạt động của Giáo viên
	Hoạt động của Học sinh

	Giáo viên trình chiếu bảng HOC_SINH trong CSDL QuanLi_HS
Giáo viên trình chiếu báo cáo danh sách học sinh gồm các trường: họ tên, ngày sinh, địa chỉ, nhóm danh sách học sinh theo giới tính (nam, nữ) và đếm trong danh sách có bao nhiêu nam , nữ.
Giáo viên đặt câu hỏi: Để tạo ra danh sách học sinh như trên ta phải làm gì và làm như thế nào?
Giáo viên nhận xét và bổ sung câu trả lời của các nhóm
	Học sinh quan sát hai hình ảnh mà Giáo viên trình chiếu trên màn hình.
- HS lắng nghe, thảo luận nhóm và trả lời câu hỏi mà giáo viên đặt ra.


B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC
- Mục tiêu: Học sinh tạo được báo cáo đơn giản
- Phương pháp/kỹ thuật dạy học: trực quan, phát hiện và giải quyết vấn đề.
- Hình thức tổ chức hoạt động: cá nhân, thảo luận nhóm
- Phương tiện dạy học: SGK, máy tính, máy chiếu
- Sản phẩm: Học sinh tạo được báo cáo hiển thị danh sách học sinh như yêu cầu.
Hoạt động.
Bài 1: Từ bảng HOC_SINH trong, tạo báo cáo để in ra danh sách học sinh gồm họ tên, ngày sinh, địa chỉ. Hãy nhóm theo giới tính (nam, nữ) và tính số học sinh nam, số học sinh nữ (sử dụng hàm count).
Nội dung hoạt động
	HOẠT ĐỘNG CỦA GIÁO VIÊN
	HOẠT ĐỘNG CỦA HS 

	Giáo viên dẫn dắt: để có danh sách học sinh như trên ta phải tạo báo cáo (report) và cách tiến hành như sau.
GV thực hiên các bước để tạo báo cáo:
Mở CSDL QuanLi_HS, rồi thực hiện
Bước 1: Chọn đối tượng Reports, nháy đúp vào mục Create report by using wizard.
Bước 2: Chọn nguồn dữ liệu đưa vào báo cáo (Hoc_Sinh) và chọn những trường (Hodem, Ten, Ngaysinh, Diachi, GT) cần đưa vào báo cáo bằng cách nháy nút [image: Bài tập và thực hành 8: Tạo báo cáo]. 
Bước 3: Chọn trường GT để nhóm
Bước 4: Chọn trường Ten để sắp xếp. (Có thể chọn thêm trường Ngaysinh.) 
Bước 5: Chọn cách bố trí các bản ghi và kiểu trình bày báo cáo. 
Bước 6: Lưu báo cáo
Nhập tên báo cáo là Bai tap 1;
Bấm chuột chọn Preview the report để xem kết quả của báo cáo.
Nháy chuột vào Finish 
GV yêu cầu HS tạo báo cáo như trên.
GV quan sát để kịp thời phát hiện và giúp đở những em gặp khó khăn trong việc tạo báo cáo
	 Học sinh theo dõi cách tạo báo cáo.


















HS thảo luận và thực hiện việc tạo báo cáo như yêu cầu.

	GV thiết kế lại báo cáo để thống kê số HS nam và số HS nữ.
Chọn Design View;
Chọn lệnh View/Sorting and Grouping, bật hiển thị chân nhóm, rồi thêm ô Text Box để tính hàm Count cho trường GT.
GV yêu cầu học sinh thiết kế lại báo cáo
GV quan sát, phát hiện và giúp các em gặp khó khăn khi thực hiên.
GV đánh giá kết quả thực hiện của HS
	Học sinh theo dõi cách thiết kế lại báo cáo.




HS thảo luận  và thực hiện việc tạo báo cáo như yêu cầu.


C. HOẠT ĐỘNG VẬN DỤNG
- Mục tiêu: Học sinh tạo được báo cáo đơn giản khác
- Hình thức tổ chức hoạt động: cá nhân, thảo luận nhóm
- Phương tiện dạy học: SGK, máy tính, máy chiếu
- Sản phẩm: Học sinh tạo được báo báo hiển thị danh sách học sinh như yêu cầu.
Nội dung hoạt động
	HOẠT ĐỘNG CỦA GIÁO VIÊN
	HOẠT ĐỘNG CỦA HỌC SINH

	Giáo viên yêu cầu học sinh tạo báo cáo để in ra danh sách học sinh gồm họ tên, ngày sinh, địa chỉ. Hãy nhóm theo tổ và đếm số học sinh trong mỗi tổ.
GV quan sát, phát hiện và giúp các em gặp khó khăn khi thực hiện.
GV đánh giá kết quả thực hiện của HS
	HS thảo luận và thực hiện việc tạo báo cáo như yêu cầu.


D. HOẠT ĐỘNG TÌM TÒI, MỞ RỘNG
- Mục tiêu: Giúp học sinh có nhu cầu mở rộng thêm kiến thức của mình
- Hình thức tổ chức hoạt động: cá nhân, thảo luận nhóm
- Phương tiện dạy học: SGK, máy tính, máy chiếu
- Sản phẩm: Học sinh báo cáo kết quả về quá trình tìm hiểu của mình.
Nội dung hoạt động
	HOẠT ĐỘNG CỦA GIÁO VIÊN
	HOẠT ĐỘNG CỦA HỌC SINH

	1. Trong CSDL QuanLi_HS ta có thể tạo báo cáo để hiện thị dữ liệu theo nhu cầu và nhóm dữ liệu treo trường nào?
- GV nhận xét và chốt lại câu hỏi
2. Trong CSDL KINH_DOANH, ta có thể tạo báo cáo để hiện thị dữ liệu theo nhu cầu và nhóm dữ liệu treo trường nào?
- GV nhận xét và chốt lại câu hỏi
	- Học sinh lắng nghe.
- HS trả lời câu hỏi
- Học sinh ghi nhiệm vụ và thực hiện nhiệm vụ ở ngoài lớp.
- Học sinh lắng nghe.
- HS trả lời câu hỏi
- Học sinh ghi nhiệm vụ và thực hiện nhiệm vụ ở ngoài lớp.


3. Củng cố, dặn dò, hướng dẫn học ở nhà
a. Củng cố:
Giáo viên hệ thống hóa lại bài và nhận xét về buổi thực hành
b. Dặn dò, hướng dẫn học ở nhà:
Học sinh về nhà học bài cũ, xem và nghiên cứu trước bài 2 của bài tập và thực hành 8

 Tiết: 32								
BÀI TẬP VÀ THỰC HÀNH 8
TẠO BÁO CÁO (TIẾT 2)
I. MỤC TIÊU BÀI HỌC
1. Kiến thức, kỹ năng và thái độ
Kiến thức: Củng cố lại những kiến thức đã học về cách tạo báo cáo.
Kỹ năng: Tạo được báo cáo đơn giản.
2. Đinh hướng phát triển năng lực: 
Năng lực quan sát, năng lực phát hiện và giải quyết vấn đề.
II. PHƯƠNG PHÁP - KĨ THUẬT DẠY HỌC
Trực quan, phát vấn, giảng giải
III. PHƯƠNG TIỆN DẠY HỌC
1. Giáo viên: 
Giáo án, SGK.
GV nên chuẩn bị sẵn CSDL, máy chiếu, phòng máy.
2. Học sinh:
Đọc trước nội dung của bài thực hành
Sách giáo khoa
IV. TỔ CHỨC CÁC HOẠT ĐỘNG DẠY HỌC
1. Ổn định lớp
Điểm diện, bố trí chỗ ngồi cho học sinh trong phòng máy..
2. Chuỗi các hoạt động
A. HOẠT ĐỘNG KHỞI ĐỘNG
- Mục tiêu: Tạo động cơ để học sinh có nhu cầu quan tâm đến việc khai thác CSDL QuanLi_HS
- Phương pháp/kỹ thuật dạy học: Trực quan, cá nhân, thảo luận nhóm
- Phương tiện dạy học: SGK, máy tính, máy chiếu
- Sản phẩm: Học sinh có nhu cầu về tạo báo cáo.
Nội dung hoạt động
	Hoạt động của Giáo viên
	Hoạt động của Học sinh

	Giáo viên trình chiếu bảng HOC_SINH trong CSDL QuanLi_HS
Giáo viên trình chiếu báo cáo danh sách học sinh khá (điểm trung bình các môn từ 6.5 trở lên).
Giáo viên đặt câu hỏi: Để tạo ra danh sách học sinh như trên ta phải làm gì và làm như thế nào?
Giáo viên nhận xét và bổ sung câu trả lời của các nhóm
	- Học sinh quan sát hai hình ảnh mà Giáo viên trình chiếu trên màn hình.
- HS lắng nghe, thảo luận nhóm và trả lời câu hỏi mà giáo viên đặt ra.



B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC
- Mục tiêu: Học sinh tạo được báo cáo đơn giản
- Phương pháp/kỹ thuật dạy học: trực quan, phát hiện và giải quyết vấn đề.
- Hình thức tổ chức hoạt động: cá nhân, thảo luận nhóm
- Phương tiện dạy học: SGK, máy tính, máy chiếu
- Sản phẩm: Học sinh tạo được báo cáo hiển thị danh sách học sinh như yêu cầu.
Hoạt động .
Bài 2: Tạo báo cáo in danh sách học sinh khá (điểm trung bình các môn từ 6.5 trở lên).
Hướng dẫn thực hiện:
Trước khi tạo báo cáo, cần tạo mẫu hỏi cho danh sách học sinh khá HS_KHA
Tạo báo cáo dựa trên mẫu hỏi HS_KHA
	HOẠT ĐỘNG CỦA GIÁO VIÊN
	HOẠT ĐỘNG CỦA HỌC SINH

	Giáo viên dẫn dắt: để báo cáo có danh sách học sinh như trên ta nên tạo mẫu hỏi trước để lọc ra nhưng học sinh khá, sau đó mới tạo báo cáo sau.
GV nhắc lại cách tạo mẫu hỏi để lọc ra những học sinh khá
GV yêu cầu học sinh tạo mẫu hỏi như trên.
GV quan sát, phát hiện và giúp các em gặp khó khăn khi thực hiện.
GV yêu cầu học sinh tạo báo cáo có nguồn dữ liệu từ mẫu hỏi như trên.
GV quan sát, phát hiện và giúp các em gặp khó khăn khi thực hiện.
GV đánh giá kết quả thực hiện của HS
	HS lắng nghe giáo viên diễn giảng





HS thảo luận và tạo mẫu hỏi theo yêu cầu của giáo viên


HS thảo luận và thực hiện việc tạo báo cáo như yêu cầu.


C. HOẠT ĐỘNG VẬN DỤNG
- Mục tiêu: Học sinh tạo được báo cáo đơn giản khác
- Hình thức tổ chức hoạt động: cá nhân, thảo luận nhóm
- Phương tiện dạy học: SGK, máy tính, máy chiếu
- Sản phẩm: Học sinh tạo được báo cáo hiển thị danh sách học sinh như yêu cầu.
Nội dung hoạt động


	HOẠT ĐỘNG CỦA GIÁO VIÊN
	HOẠT ĐỘNG CỦA HỌC SINH

	Giáo viên yêu cầu học sinh tạo tạo báo cáo để in ra danh sách học sinh có điểm toán và văn đều lớn hơn hoặc bằng 8.
GV quan sát, phát hiện và giúp các em gặp khó khăn khi thực hiện.
GV đánh giá kết quả thực hiện của HS
	HS theo dõi, thảo luận và thực hiện việc tạo báo cáo như yêu cầu.





	Giáo viên yêu cầu học sinh tạo tạo báo cáo để in ra danh sách học sinh có điểm một trong các môn toán,lí hoặc hóa là 10 điểm.
GV quan sát, phát hiện và giúp các em gặp khó khăn khi thực hiện.
GV đánh giá kết quả thực hiện của HS
	HS theo dõi, thảo luận và thực hiện việc tạo báo cáo như yêu cầu.






D. HOẠT ĐỘNG TÌM TÒI, MỞ RỘNG
- Mục tiêu: Giúp học sinh có nhu cầu mở rộng thêm kiến thức của mình
- Hình thức tổ chức hoạt động: cá nhân, thảo luận nhóm
- Phương tiện dạy học: SGK, máy tính, máy chiếu
- Sản phẩm: Học sinh tạo được báo cáo như yêu cầu.
Nội dung hoạt động
	HOẠT ĐỘNG CỦA GIÁO VIÊN
	HOẠT ĐỘNG CỦA HỌC SINH

	1. GV cho học sinh tự đặt ra một câu hỏi yêu cầu và tạo báo cáo để thực hiện công việc đó trong trong CSDL QuanLi_HS.
- GV nhận xét và chốt lại câu hỏi
2. GV cho học sinh tự đặt ra một câu hỏi yêu cầu và tạo báo cáo để thực hiện công việc đó trong trong CSDL  KINH_DOANH.
- GV nhận xét và chốt lại câu hỏi

	- Học sinh lắng nghe.
- HS thảo luận và trả lời câu hỏi
- Học sinh ghi nhiệm vụ và thực hiện nhiệm vụ ở ngoài lớp.

 Học sinh lắng nghe.
- HS thảo luận và trả lời câu hỏi
- Học sinh ghi nhiệm vụ và thực hiện nhiệm vụ ở ngoài lớp.


3. Củng cố, dặn dò, hướng dẫn học ở nhà
a. Củng cố:
Giáo viên hệ thống hóa lại bài và nhận xét về buổi thực hành
b. Dặn dò, hướng dẫn học ở nhà:
Học sinh về nhà học bài cũ, xem và nghiên cứu trước bài 2 của bài tập và thực hành 9.

 Tiết:33							
							
ÔN TẬP 
I. MỤC TIÊU BÀI HỌC
1. Kiến thức, kỹ năng và thái độ
- Kiến thức: Củng cố lại toàn bộ kiến thức trong học kì I.
- Kỹ năng: Chuẩn bị cho bài kiểm tra học kì I.
2. Định hướng phát triển năng lực
Năng lực tự học, năng lực hợp tác
II. PHƯƠNG PHÁP - KĨ THUẬT DẠY HỌC
Trực quan, phát vấn, giảng giải
III. PHƯƠNG TIỆN DẠY HỌC
1. Giáo viên: 
Giáo án, SGK, sách bài tập
2. Học sinh:
Vở, sách giáo khoa
IV. TỔ CHỨC CÁC HOẠT ĐỘNG DẠY HỌC
1. Ổn định lớp
Điểm diện ...
2. Chuỗi các hoạt động
A. HOẠT ĐỘNG KHỞI ĐỘNG
- Mục tiêu: Nhớ kiến thức chương của Học Kì I.
- Phương pháp/kĩ thuật dạy học: vấn đáp.
- Hình thức tổ chức: Làm việc cá nhân, nhóm.
- Phương tiện dạy học: SGK, vở học, máy tính, máy chiếu.
- Sản phẩm: trả lời câu hỏi theo yêu cầu của GV.
Nội dung hoạt động
	HOẠT ĐỘNG CỦA GIÁO VIÊN
	HOẠT ĐỘNG CỦA HỌC SINH

	GV đặt câu hỏi: Trong học kì I chúng ta đã học những bài nào?
GV nhận xét và chốt lại câu trả lời.
Trong học kì I chúng ta đã học những bài sau: (GV nhắc lại tên các bài học trong Học kì I)
	HS lắng nghe, suy nghĩ trả lời.


B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC
- Mục tiêu: Nhớ kiến thức chương của Học Kì I.
- Phương pháp/kĩ thuật dạy học: vấn đáp.
- Hình thức tổ chức: Làm việc cá nhân, nhóm.
- Phương tiện dạy học: SGK, vở học, máy tính, máy chiếu.
- Sản phẩm: trả lời câu hỏi theo yêu cầu của GV.
Nội dung hoạt động
Hoạt động 1: Giải một số câu trả lời trắc nghiệm.
	HOẠT ĐỘNG CỦA GIÁO VIÊN
	HOẠT ĐỘNG CỦA HỌC SINH

	- GV đặt câu hỏi
- GV nhận xét và chốt lại câu trả lời.
	- HS lắng nghe, trao đổi, suy nghĩ trả lời.
- HS ghi bài


Câu 1: Khi tạo cấu trúc bảng, tên trường được nhập vào cột?
a. Field name.		b. Data type		c. Field size		d. Format
Câu 2: Mỗi đối tượng của Access có các chế độ làm việc là:
a. Trang dữ liệu và cập nhật		b. Trang dữ liệu và thiết kế
c. Thiết kế và bảng			d. Chỉnh sửa và thiết kế
Câu 3: Trong CSDL đang làm việc, để tạo một bảng mới bằng cách tự thiết kế, thì thao tác thực hiện nào sau đây là đúng.
a. Table – Create Table in design view
b. Query – Create Query in design view
c. Form – Create Form in design view
d. Report – Create Report in design view
Câu 4: Dữ liệu của CSDL được lưu trữ ở
a. Query		b. Form		c. Table		d. Report
Câu 5: Dữ liệu kiểu logic trong Microsoft Access được ký hiệu là:
a. Autonumber		b. Text		c. Yes/No		d. Number
Câu 6: Hệ quản trị CSDL là:
a. Phần mềm dùng tạo lập, lưu trữ và khai thác một CSDL.
b. Phần mềm dùng tạo lập CSDL.
c. Phần mềm để thao tác và xử lý các đối tượng trong CSDL.
d. Phần mềm dùng tạo lập, lưu trữ một CSDL.
Câu 7: Trong Access để tạo CSDL mới, thao tác thực hiện lệnh nào sau đây là đúng: 
a. File/New/Blank Database			b. File/Open/<tên tệp>
c. Create Table in Design View  		d. Create table by using wizard 
Câu 8: Bảng đã được hiển thị ở chế độ thiết kế, muốn thêm một trường vào bên trên trường hiện tại, thao tác thực hiện lệnh nào sau đây là đúng
a. File/New/Blank Database	b. Insert/Rows
c. File/Save/<Tên tệp>		d. Create Table by Using Wizard 
Câu 9: Bảng đã được hiển thị ở chế độ trang dữ liệu, với một trường đã chọn, muốn sắp xếp các bản ghi theo thứ tự tăng, thao tác thực hiện nào sau đây là đúng: 
	a. Record/Sort/Sort Ascending 	b. Insert/New Record 	
	c. Edit/Delete Rows 		d. Insert/Colum 
Câu 10: Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn xóa bản ghi hiện tại, thao tác thực hiện nào sau đây là đúng 
	a. Insert/Colum 		b. Delete 	
	c. Edit/Delete Rows 		d. Insert/New Record 
Câu 11. Khi làm việc với cấu trúc bảng, để xác định kiểu dữ liệu của trường, ta xác định tên kiểu dữ liệu tại cột : 
	a. Field Type 	b. Data Type 	
	c. Description 	d. Field
Câu 12. Trong khi tạo cấu trúc bảng, muốn thay đổi kích thước của trường, ta xác định giá trị mới tại dòng : 
	a. Field Name 	b. Field Size 	c. Description 	d. Data Type 
Câu 13. Trong CSDL đang làm việc, để mở một bảng đã có, thao tác thực hiện lệnh nào sau đây là đúng: 
	a. Create Table in Design View 	b. File/New/Blank Database 
	C. Nháy đúp chuột vào tên bảng cần mở 	d. Create Table entering data 
Câu 14. Muốn xóa liên kết giữa hai bảng, trong cửa sổ Relationships ta thực hiện:
a.Chọn hai bảng và nhấn phớm Delete
b. Chọn đường liên kết giữa hai bảng đó và nhấn phím Delete
c. Chọn tất cả các bảng và nhấn phớm Delete
d. Cả ba câu đều sai
Câu 15: Trong Access, muốn tạo biểu mẫu theo cách thuật sĩ, ta chọn:
a. Create form for using Wizard			b. Create form by using Wizard
c. Create form with using Wizard			d. Create form in using Wizard
Hoạt động 2: Giáo viên cho một cấu trúc bảng và vấn đáp học sinh cách thực hiện để tạo được bảng theo mong muốn.
 Tạo bảng Nhan_Vien có cấu trúc như sau:

	Field Name
	Data Type
	Field Properties

	MaNV
	Text
	Field Size: 4

	HoDem
	Text
	Field Size: 25

	Ten
	Text
	Field Size: 7

	Phai
	Text
	Field Size: 4

	Ngaysinh
	Date/Time
	Format: Short Date

	DiaChi
	Text
	Field Size: 230

	ChucVu
	Text
	Field Size: 20


C. HOẠT ĐỘNG VẬN DỤNG
D. HOẠT ĐỘNG TÌM TÒI, MỞ RỘNG
3. Củng cố, dặn dò, hướng dẫn học ở nhà
a. Củng cố:
Giáo viên hệ thống hóa lại bài
b. Dặn dò, hướng dẫn học ở nhà:
Học sinh về nhà ôn tập để chuẩn bị kiểm tra học kì I. .

Tiết: 34
KIỂM TRA HỌC KÌ I
1. Mục tiêu:
0. Củng cố các kiến thức và các nội dung đã học trong chương 1 và chương 2
0. Rèn luỵên kĩ năng xây dựng được các nội dung của một số bài toán quản lí (quản lí học sinh, quản lí thư viện).
1. Chuẩn bị của giáo viên và học sinh:
0. Giáo viên: đề kiểm tra
0. Học sinh: giấy, bút và các dụng cụ học tập khác để làm bài.
1. Phương pháp:
0. Nêu vấn đề
1. Hoạt động dạy- học:
3. Hoạt động 1: Ổn định lớp
3. Hoạt động 2: Từng học sinh độc lập làm bài kiểm tra trên giấy
Hình thức: trắc nghiệm 60%
Tự luận 40%
I.  Phần trắc nghiệm (6điểm): Mỗi câu trả lời đúng được 0.5 điểm
 Câu 1. Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn tìm kiếm những bản ghi theo điều kiện nào đó, thao tác thực hiện lệnh nào sau đây là đúng: 
	A. Insert/Colum   	B. Record/Fillter By Selection
	C. Record/Fillter/Fillter By Form  D. Edit/Find/<đ.kiện> 
 Câu 2. Các chức năng chính của Access: 
	A. Lưu trữ dữ liệu 	B. Tính toán và khai thác dữ liệu  
	    C. Lập bảng 	 	D. Ba câu  đều đúng  
 Câu 3. Tên của tập tin trong Access bắt buộc  phải  đặt trước hay sau khi tạo CSDL: 
	A. Đặt tên tệp sau khi đã tạo CSDL 
      B. Bắt buộc vào là đặt tên tệp ngay rồi mới tạo CSDL sau  
 Câu 4. Khi chọn kiểu dữ liệu cho trường số điện thoại nên chọn loại nào? 
	A. Autonumber 	B. Number   	C. Text   	D. Date/Time 
 Câu 5. Khi làm việc với cấu trúc bảng, để xác định kiểu dữ liệu của trường, ta xác định tên kiểu dữ liệu tại cột : 
	A. Description 	B. Field Properties 	C. Data Type 	D. Field Type 
 Câu 6. Trong khi tạo cấu trúc bảng, muốn thay đổi kích thước của trường, ta xác định giá trị mới tại dòng : 
	A. Field Name 	B. Field Size 	C. Data Type 	D. Description 
 Câu 7. Trong Access, từ Descending có ý nghĩa gì ? 
	A. Sắp xếp dữ liệu theo chiều tăng dần  
       B. Sắp xếp dữ liệu theo thứ tự số chẵn rồi đến số lẻ
	C. Sắp xếp dữ liệu theo thứ tự số lẻ rồi đến số chẵn  
       D. Sắp xếp dữ liệu theo chiều giảm dần 

 Câu 8. Trong Access, nút lệnh này   có ý nghĩa gì ? 
	A. Xác định khoá chính 	B. Khởi động Access 
	C.  Mở tệp cơ sở dữ liệu	D. Cài mật khẩu cho tệp cơ sở dữ liệu 
 Câu 9. Hãy sắp xếp các bước sau để được một thao tác đúng ?
(1) Chọn nút Create   		 (3) Nhập tên cơ sở dữ liệu 
   (2) Chọn File - New                 	 (4) Chọn Blank Database 
    A. (2)  (3)  (4)  (1) 	B. (1)  (2)  (3)  (4) 
     C. (1)  (2)  (4)  (3) 	D. (2)  (4)  (3)  (1) 
 Câu 10. Biểu mẫu là một đối tượng trong Access dùng để thực hiện công việc chủ yếu nào   
	A. Xem, nhập, sửa dữ liệu   	 B. Tìm kiếm thông tin
     	C. Lập báo cáo 	D. Kết xuất thông tin 
 Câu 11. Chọn phát biểu đúng nhất. Khi tạo một biểu mẫu để nhập dữ liệu thì ta bắt buộc phải: 
	A. Chọn bố cục cho biểu mẫu 	B. Xác định hành động cho biểu mẫu đo
ù 	C. Xác định dữ liệu nguồn 	D. Nhập tên biểu mẫu 
 Câu 12. Hãy sắp xếp các bước sau để được một thao tác đúng ?
(1) Chọn nút [image: ]                (2) Chọn nút Create           (3) Chọn các bảng để tạo mối liên kết
(4) Chọn trường liên quan từ các bảng liên kết 
A. (1)  (3)  (4)  (2) 	B. (2)  (3)  (4)  (1)
C. (2)  (1)  (3)  (4) 	D. (1)  (2)  (3)  (4) 
II. Tự luận (4 điểm): 
Câu 1(3 điểm): CSDL là gì? Em hãy trình bày các vai trò của con người khi làm việc với CSDL.
Câu 2(1 điểm): Một bạn học sinh thiếu điểm thi cuối học kì môn Tin học. Vì vậy hệ thống quản lí học sinh không tổng kết điểmcuối học kì được. Sau 15 phút, giáo viên bộ môn nhập điểm cho em học sinh này và hệ thống tự động đưa ra kết quả học tập và xếp loại hs ngay. Em hãy cho biết CSDl trên thoả mãn tính chất gì? Hãy giải thích rõ.
3. Lưu ý

Tiết: 36
BÀI TẬP VÀ THỰC HÀNH SỐ 9
BÀI TẬP THỰC HÀNH TỔNG HỢP(Tiết 1)
I. MỤC TIÊU BÀI HỌC
1. Kiến thức, kỹ năng và thái độ
1. Kiến thức
2. Kĩ năng
- Củng cố và các kĩ năng cơ bản sử dụng Access.
- Tạo được Biểu mẫu để nhập dữ liệu (chủ yếu dùng thuật sĩ).
- Tạo được Mẫu hỏi đơn giản theo yêu cầu.
- Tạo được Báo cáo đơn giản.
3. Thái độ
- Nghiêm túc tập trung thực hành.
2. Đinh hướng phát triển năng lực
Quản lí điểm kiểm tra trong trường THPT
II. PHƯƠNG PHÁP KĨ THUẬT DẠY HỌC
- Thuyết trình, hỏi đáp, hướng dẫn.
III. PHƯƠNG TIỆN DẠY HỌC
- Giáo viên: SGK, giáo án, phòng thực hành.
- Học sinh: SGK, chuẩn bị bài trước khi đến lớp.
IV. TỔ CHỨC CÁC HOẠT ĐỘNG DẠY HỌC
1. Ổn định lớp
Báo cáo sĩ số, ổn định trật tự, chỗ ngồi, khởi động máy.
2. Chuỗi các hoạt động
A. HOẠT ĐỘNG KHỞI ĐỘNG
(1) Mục tiêu: qua thực tế kiểm tra chung các môn học tại trường, học sinh tổ chức lưu trữ dữ liệu kiểm tra và khai thác chúng trong một số trường hợp.
(2) Phương pháp/ kỹ thuật dạy học: Thuyết trình, hỏi đáp
(3) Hình thức tổ chức hoạt động: cá nhân
(4) Phương tiện dạy học: sgk
(5) Sản phẩm: Trả lời được các câu hỏi đặt ra.
	HOẠT ĐỘNG CỦA GIÁO VIÊN
	HOẠT ĐỘNG CỦA HỌC SINH

	Khi tổ chức kiểm tra chung, Nhà trường cần lưu lại thông tin gì?


Như vậy Nhà trường cần lưu thông tin của những đối tượng nào?
Nếu em là Hiệu trưởng thì khi kết thúc học kỳ I em cần biết những thông tin gì? Vì sao?
	Trả lời: Thông tin Nhà trường cần lưu lại là: Điểm số của mỗi học sinh sau mỗi lần kiểm tra đối với mỗi môn học. 
Trả lời: Những đối tượng đó là: điểm,  học sinh, môn học
Trả lời: những thông tin Hiệu trưởng cần biết là:
- So sánh điểm số giữa các môn học.
- So sánh điểm số giữa các lớp 
- So sánh điểm số giữa các giáo viên
- … 
Qua việc so sánh như vậy, Hiệu trưởng nhà trường sẽ đề ra những biện pháp để phát triển nhà trường.


B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC
(1) Mục tiêu: Củng cố lại các bước tạo CSDL, tạo bảng, tạo biểu mẫu, tạo liên kết bảng
(2) Phương pháp/ kỹ thuật dạy học: Hỏi đáp, thảo luận
(3) Hình thức tổ chức hoạt động: Nhóm
(4) Phương tiện dạy học: sgk, đèn chiếu, phần mềm Netop School
(5) Sản phẩm: Phiếu học tập
	HOẠT ĐỘNG CỦA GIÁO VIÊN
	HOẠT ĐỘNG CỦA HỌC SINH

	Chia lớp thành 4 nhóm tương ứng 4 tổ, tổ trưởng là Nhóm trưởng
Phát phiếu học tập như sau:
	Chia nhóm, ngồi theo nhóm


Hoàn thành phiếu học tập

	PHIẾU HỌC TẬP
1. Nêu các bước tạo CSDL?
2. Đặt tên trường, chọn kiểu dữ liệu, chỉ định khóa chính cho 3 bảng ứng với 3 đối tượng quản lí sau: (tham khảo sgk, bổ sung, điều chỉnh)
	TÊN BẢNG
	TÊN TRƯỜNG
	KHÓA CHÍNH
	KIỂU DỮ LIỆU

	BANG_DIEM
	-
-
-
…
	
	

	HOC_SINH
	-
-
-
…
	
	

	MON_HOC
	-
-
-
…
	
	


3. Chỉ ra mối liên kết giữa các bảng:
· Liên kết giữa bảng … với bảng … thông qua trường …
· …
4. Nêu các bước chính tạo biểu mẫu (Form) bằng thuật sĩ:
KẾT QUẢ PHIẾU HỌC TẬP
1. Các bước tạo CSDL:
Khởi động Access  File/New  Blank DataBase  đặt tên CSDL mới, chọn thư mục lưu trữ tệp CSDL Create
2. 
	TÊN BẢNG
	TÊN TRƯỜNG
	KHÓA CHÍNH
	KIỂU DỮ LIỆU

	BANG_DIEM
	STT
Ma_HS
Ma_MH
Ngay_Kiem_Tra
Diem_So
	*
	AutoNumber
Text
Text
Date/Time
Number

	HOC_SINH
	Ma_HS
Ho_Ten
Lop
	*
	Text
Text
Text

	MON_HOC
	Ma_MH
Ten_MH
Giao_Vien
	*
	Text
Text
Text



3. Mối liên kết giữa các bảng:
· Liên kết giữa bảng  BANG_DIEM với bảng  HOC_SINH thông qua trường Ma_HS
· Liên kết giữa bảng  BANG_DIEM với bảng  MON_HOC thông qua trường Ma_MH
4. Nêu các bước chính tạo biểu mẫu (Form) bằng thuật sĩ:
Chọn Form ở của sổ các đối tượng  nháy đúp vào Create new form by using wizard  chọn bảng  chọn trường ...

	Giải thích thêm khóa chỉnh của bảng BANG_DIEM, sự cần thiết phải thêm trường STT
	Chú ý nghe giảng


C. HOẠT ĐỘNG VẬN DỤNG
(1) Mục tiêu: Tạo CSDL HOC_TAP.mdb trên đĩa, tạo các liên kết và tạo các biểu mẫu.
(2) Phương pháp/ kỹ thuật dạy học: hướng dẫn trực tiếp
(3) Hình thức tổ chức hoạt động: cá nhân
(4) Phương tiện dạy học: máy tính
(5) Sản phẩm: CSDL HOC_TAP.mdb trên đĩa, tạo các liên kết và tạo các biểu mẫu.
D. HOẠT ĐỘNG TÌM TÒI, MỞ RỘNG
(1) Mục tiêu: Thấy được sự ràng buộc dữ liệu giữa các bảng sau khi liên kết, thấy được ưu điểm của việc nhập dữ liệu bằng biểu mẫu
(2) Phương pháp/ kỹ thuật dạy học: vấn đáp
(3) Hình thức tổ chức hoạt động: cá nhân
(4) Phương tiện dạy học: máy tính
(5) Sản phẩm: Nhập được dữ liệu giả định cho 3 bảng 
3. Củng cố, dặn dò, hướng dẫn học ở nhà
	
	
	
	

 Tiết:36
BÀI TẬP VÀ THỰC HÀNH SỐ 9
BÀI TẬP THỰC HÀNH TỔNG HỢP (tt)
I. MỤC TIÊU BÀI HỌC
1. Kiến thức, kỹ năng và thái độ
a) Kiến thức
b) Kĩ năng
- Củng cố và các kĩ năng cơ bản sử dụng Access.
- Tạo được Biểu mẫu để nhập dữ liệu (chủ yếu dùng thuật sĩ).
- Tạo được Mẫu hỏi đơn giản theo yêu cầu.
- Tạo được Báo cáo đơn giản.
c) Thái độ
- Nghiêm túc tập trung thực hành.
2. Đinh hướng phát triển năng lực: Quản lí điểm kiểm tra trong trường THPT
II. PHƯƠNG PHÁP KĨ THUẬT DẠY HỌC
- Thuyết trình, vấn đáp, hướng dẫn.
III. PHƯƠNG TIỆN DẠY HỌC
- Giáo viên: SGK, giáo án, phòng thực hành, các máy tính trong phòng đều có tệp CSDL HOC_TAP.mdb chuẩn, một số Mẫu hỏi và Báo cáo.
- Học sinh: SGK, chuẩn bị bài trước khi đến lớp.
IV. TỔ CHỨC CÁC HOẠT ĐỘNG DẠY HỌC
1. Ổn định lớp
Báo cáo sĩ số, ổn định trật tự, chỗ ngồi, khởi động máy.
2. Chuỗi các hoạt động
A. HOẠT ĐỘNG KHỞI ĐỘNG
(1) Mục tiêu: qua thực tế kiểm tra chung các môn học tại trường, học sinh tổ chức lưu trữ dữ liệu kiểm tra và khai thác chúng trong một số trường hợp.
(2) Phương pháp/ kỹ thuật dạy học: Thuyết trình, hỏi đáp
(3) Hình thức tổ chức hoạt động: cá nhân
(4) Phương tiện dạy học: sgk, máy tính
(5) Sản phẩm: nhu cầu tạo lập các mẫu hỏi để khai thác dữ liệu.
	HOẠT ĐỘNG CỦA GIÁO VIÊN
	HOẠT ĐỘNG CỦA HỌC SINH

	Chọn CSDL HOC_TAP.mdb tốt nhất trong tiết học hành trước và chuyển vào các máy tính để làm cơ sở cho tiết 34.
Yêu cầu học sinh thi tính điểm trung bình của một học sinh nào đó (có trong CSDL)
Sau khi cả lớp trả lời kết quả, GV nhận xét về thời gian, độ chính xác, …
	



Thi tính điểm trung bình của học sinh đã được chỉ định

Chú ý lắng nghe và hình thành nhu cầu tạo mẫu hỏi.



B. HOẠT ĐỘNG HÌNH THÀNH KIẾN THỨC
Hoạt động 1: thực hiện bài tập 4
(1) Mục tiêu: Củng cố lại các bước tạo Mẫu hỏi
(2) Phương pháp/ kỹ thuật dạy học: Hỏi đáp, thảo luận
(3) Hình thức tổ chức hoạt động: Nhóm, cá nhân
(4) Phương tiện dạy học: sgk, đèn chiếu, phần mềm Netop School
(5) Sản phẩm: Phiếu học tập và trên máy tính
	HOẠT ĐỘNG CỦA GIÁO VIÊN
	HOẠT ĐỘNG CỦA HỌC SINH

	Chia lớp thành 4 nhóm tương ứng 4 tổ, tổ trưởng là Nhóm trưởng
Phát phiếu học tập như sau:
	Chia nhóm, ngồi theo nhóm


Hoàn thành phiếu học tập

	Chuẩn hóa các bảng
Yêu cầu và hướng dẫn HS làm vào máy
	Chú ý nghe giảng
Thực hành trên máy


Hoạt động 2: thực hiện bài tập 5
(1) Mục tiêu: Củng cố lại các bước tạo Báo cáo
(2) Phương pháp/ kỹ thuật dạy học: Hỏi đáp, thảo luận
(3) Hình thức tổ chức hoạt động: Nhóm, cá nhân
(4) Phương tiện dạy học: sgk, đèn chiếu, phần mềm Netop School
(5) Sản phẩm: Phiếu học tập và trên máy tính
	HOẠT ĐỘNG CỦA GIÁO VIÊN
	HOẠT ĐỘNG CỦA HỌC SINH

	Chia lớp thành 4 nhóm tương ứng 4 tổ, tổ trưởng là Nhóm trưởng
Phát phiếu học tập như sau:
	Chia nhóm, ngồi theo nhóm


Hoàn thành phiếu học tập

	Chuẩn hóa các câu trả lời
Yêu cầu và hướng dẫn HS làm vào máy
	Chú ý nghe giảng
Thực hành trên máy



C. HOẠT ĐỘNG VẬN DỤNG
(1) Mục tiêu: Tạo các mẫu hỏi, báo cáo phù hợp với nhu cầu thực tế tại trường.
(2) Phương pháp/ kỹ thuật dạy học: hướng dẫn trực tiếp
(3) Hình thức tổ chức hoạt động: cá nhân
(4) Phương tiện dạy học: máy tính
(5) Sản phẩm: một số yêu cầu, tạo một số mẫu hỏi, báo cáo để giải quyết các yêu cầu đó. 
D. HOẠT ĐỘNG TÌM TÒI, MỞ RỘNG
(1) Mục tiêu: 
(2) Phương pháp/ kỹ thuật dạy học:
(3) Hình thức tổ chức hoạt động:
(4) Phương tiện dạy học:
(5) Sản phẩm:
3. Củng cố, dặn dò, hướng dẫn học ở nhà
	
	
	

Tiết: 37, 38
BÀI TẬP CHƯƠNG II
Ngày soạn: 08/01/2018
Tiết: 37+38
BÀI TẬP CHƯƠNG II
I. Mục đích, yêu cầu: 
Học sinh nắm được các khái niệm chính của Access và biết thực hiện được các thao tác cơ bản của Access như:làm việc với bảng và cấu trúc bảng, thiết lập mối liên kết giữa các bảng, tạo biểu mẫu, mẫu hỏi và báo cáo thông qua hệ thống các câu hỏi trắc nghiệm.
II.  Chuẩn bị đồ dùng dạy học: 
· Giáo viên: sách giáo khoa, sách giáo viên, sách bài tập,  các câu hỏi trắc nghiệm.
· Học sinh: sách giáo khoa, sách bài tập.
III. Phương pháp: 
· Thuyết trình
· Đàm thoại
· Đặt vấn đề
· Trắc nghiệm khách quan.
IV. Hoạt động dạy học
1.  Ổn định lớp và kiểm tra bài cũ: 
2. Nội dung:  Củng cố lại các nội dung đã học thông qua các câu trắc nghiệm 
Câu 1. MDB viết tắt bởi: 
	A. Microsoft Access DataBase 	B. Microsoft DataBase 
	C. Không có câu nào đúng 	D. Management DataBase 
 Câu 2. Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn thêm 1 bản ghi, thao tác thực hiện lệnh nào sau đây là đúng: 
	A. Insert/New Record 	B. Delete 	C. Edit/Delete Rows 	D. Insert/Colum 
 Câu 3. Khi làm việc với cấu trúc bảng, để xác định kiểu dữ liệu của trường, ta xác định tên kiểu dữ liệu tại cột : 
	A. Field Type 	B. Data Type 	C. Description 	D. Field Properties 
 Câu 4. Trong khi tạo cấu trúc bảng, muốn thay đổi kích thước của trường, ta xác định giá trị mới tại dòng : 
	A. Field Name 	B. Field Size 	C. Description 	D. Data Type 
 Câu 5. Trong Acess để tạo CSDL mới, thao tác thực hiện lệnh nào sau đây là đúng:   
	A. Create table by using wizard   	B. File/open/<tên tệp> 
	C. Create Table in Design View 	D. File/new/Blank Database 
 Câu 6. Khi chọn dữ liệu cho các trường chỉ chứa một trong hai giá trị như gioitinh, trường  đơn đặt hàng đã hoặc chưa giải quyết...nên chọn kiểu dữ liệu để sau này nhập dữ liệu cho nhanh. 
	A. Yes/No 	B. Number 	C. Text 	D. Auto Number  
 Câu 7. Trong Access, muốn sắp xếp các bản ghi theo thứ tự, ta thực hiện ............ Sort 
	A. Insert 	B. Tools 	C. Record 	D. File 
 Câu 8. Khi chọn kiểu dữ liệu cho trường thành tiền (bắt buộc kèm theo đơn vị tiền tệ) , nên  chọn loại nào: 
	A. Currency 	B. Number	C. Text   	D. Date/time   
 Câu 9. Bảng đã được hiển thị ở chế độ trang dữ liệu, với một trường đã chọn, Muốn sắp xếp các bản ghi theo thứ tự tăng,  thao tác thự hiện lệnh nào sau đây là đúng : 
	A. Insert/Colum        B. Insert/New Record   C. Edit/Delete Rows   D. Record/Sort/Sort Ascending  
 Câu 10. Bảng đã được hiển thị ở chế độ thiết kế, muốn xoá trường đã được chọn, thao tác thực hiện lệnh nào sau đây là đúng: 
	A. File/New/Blank Database 	B. Insert/Rows 
	C. Create Table by using wizrd 	D. Edit/Delete 
 Câu 11. Hãy sắp xếp các bước sau để được một thao tác đúng ?
(1) Chọn nút Create                 (3) Nhập tên cơ sở dữ liệu
(2) Chọn File - New                 (4) Chọn Blank Database 
	A. (1)  (2)  (4)  (3) 	B. (1)  (2)  (3)  (4) 
	C. (2)  (3)  (4)  (1) 	D. (2)  (4)  (3)  (1) 
 Câu 12. Trong CSDL đang làm việc, để mở một bảng đã có, thao tác thực hiện lệnh nào sau đây là đúng: 
	A. Create Table in Design View 	B. File/New/Blank Database 
	C. Nháy đúp chuột vào tên bảng cần mở 	D. Create Table entering data 
 Câu 13. Trong cửa sổ Cơ sở dữ liệu đang làm việc, để tạo một Bảng mới trong chế độ thiết kế, thao tác thực hiện lệnh nào sau đây là đúng: 
	A. Create Table in Design View  	B. Create Table by entering data 
	C. Create Table by using wizrd 	D. Nháy kép <Tên Tệp> 
 Câu 14. Điều kiện để tạo mối liên kết giữa hai bảng là : 
	A. Trường liên kết của hai bảng phải là chữ hoa 
	B. Trường liên kết của hai bảng phải cùng kiểu dữ liệu 
	C. Trường liên kết của hai bảng phải là kiểu dữ liệu số 
	D. Trường liên kết của hai bảng phải khác nhau về kiểu dữ liệu 
 Câu 15. Hãy sắp xếp các bước sau để được một thao tác đúng ?
(1) Chọn nút [image: ]                
(2) Chọn nút Create           
(3) Chọn các bảng để tạo mối liên kết
(4) Chọn trường liên quan từ các bảng liên kết 
	A. (1)  (2)  (3)  (4) 	B. (1)  (3)  (4)  (2) 
	C. (2)  (1)  (3)  (4) 	D. (2)  (3)  (4)  (1) 
 Câu 16. Trong khi làm việc với cấu trúc bảng, muốn xác định khóa chính, ta thực hiện : ............  Primary Key 
	A. Edit 	B. Insert	C. Tools	D. Format 
 Câu 17. Bảng đã được hiển thị ở chế độ trang dữ liệu, muốn xóa bản ghi hiện tại, thao tác thực hiện lệnh nào sau đây là đúng: 
	A. Insert/Colum  	B. Delete   	C. Insert/New Record   	D. Edit/Delete Record
 Câu 18. Access là gì? 
	A. Là phần mềm công cụ 		B. Là phần cứng 
	C. Là hệ QTCSDL do hãng Microsoft sản xuất 	D. Là phần mềm hệ thống 
 Câu 19. Trong Access, có mấy chế độ làm việc với các đối tượng ? 
	A. 4 	B. 2 	C. 1 	D. 3 
 Câu 20. Khi chọn kiểu dữ liệu cho trường số điện thoại nên chọn loại nào? 
	A. Text   	B. Number   	C. Autonumber 	D. Date/Time 
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CHỦ ĐỀ 4. HỆ CƠ SỞ DỮ LIỆU QUAN HỆ 
§ 10. CƠ SỞ DỮ LIỆU QUAN HỆ (Mục 1)

I. MỤC TIÊU
1. Về kiến thức
· Biết khái niệm mô hình dữ liệu, các loại mô hình dữ liệu.
· Biết các đặc trưng cơ bản của mô hình quan hệ.	
2. Về kĩ năng
3. Về thái độ
· Có thái độ nghiêm túc trong học tập.
· Học sinh ngày càng say mê với cơ sở dữ liệu quan hệ, đặc biệt là sau khi đã biết tất cả các thao tác về cơ sở dữ liệu. 
4. Định hướng phát triển năng lực: 
Năng lực tự học, năng lực hợp tác, năng lực giải quyết vấn đề.
II. TỔ CHỨC CÁC HOẠT ĐỘNG HỌC TẬP
1. Ổn định lớp
2. Kiểm tra bài cũ: Không.
3. Tiến trình bài học
3.1. Hoạt động khởi động
 (1) Mục tiêu: Giúp học sinh hệ thống lại kiến thức cơ bản của học kỳ I đồng thời tạo động cơ để HS có nhu cầu tìm hiểu về mô hình dữ liệu quan hệ.
(2) Phương pháp/kĩ thuật dạy học: Đàm thoại, phát hiện.
(3) Hình thức tổ chức hoạt động: Làm việc cá nhân.
(4) Phương tiện dạy học: SGK, Projector, máy tính.
(5) Kết quả: Học sinh có nhu cầu mong muốn được tìm hiểu về mô hình dữ liệu quan hệ.
Nội dung hoạt động
	Giáo viên
	Học sinh

	(?) Yêu cầu học sinh cho biết nội dung cơ bản đã học ở học kỳ I.
- Khởi động Access và minh họa.
- Dẫn dắt vào bài 10.
	- Học sinh nhắc lại các nội dung cơ bản đã học ở HKI.
- Quan sát.

-Lắng nghe.


3.2. Hình thành kiến thức
3.2.1. Mô hình dữ liệu
(1) Mục tiêu: Giúp học sinh biết được về mô hình dữ liệu, các loại mô hình dữ liệu.
 (2) Phương pháp/kĩ thuật dạy học: Đàm thoại, phát hiện.
(3) Hình thức tổ chức hoạt động: Làm việc cá nhân.
(4) Phương tiện dạy học: SGK, Projector, máy tính.
(5) Kết quả: Học sinh biết được về mô hình dữ liệu, các loại mô hình dữ liệu, 
Nội dung hoạt động
	Giáo viên
	Học sinh

	(?) Kể tên các bước xây dựng CSDL đã học?
- Nhận xét, dẫn dắt vào bài.
(?) Mô hình quan hệ là gì?
- Nhận xét, chốt nội dung. 
(?) Kể tên các loại mô hình dữ liệu?
- Gọi HS khác nhận xét.
- Nhận xét, chốt nội dung, minh họa.
	- Khảo sát, thiết kế, kiểm thử.
- Lắng nghe. 

- Tham khảo SGK và trả lời.
- Lắng nghe, ghi bài.

- Tham khảo SGK và trả lời.
- Lắng nghe.
- Lắng nghe, ghi bài, quan sát.


3.2.2. Các đặc trưng của mô hình dữ liệu quan hệ 
(1) Mục tiêu: Giúp học sinh biết được về các đặc trưng của mô hình dữ liệu quan hệ.
 (2) Phương pháp/kĩ thuật dạy học: Đàm thoại, phát hiện.
(3) Hình thức tổ chức hoạt động: Làm việc cá nhân, thảo luận nhóm.
(4) Phương tiện dạy học: SGK, Projector, máy tính.
(5) Kết quả: Học sinh biết được về các đặc trưng của mô hình dữ liệu quan hệ.
Nội dung hoạt động
	Giáo viên
	Học sinh

	 (?) Kể tên các đặc trưng của mô hình dữ liệu quan hệ?
- Nhận xét.
(?) Chúng ta đã biết cách mô tả dữ liệu. Vậy dữ liệu của Access được lưu trữ ở đâu, mô tả như thế nào?
- Gọi nhóm khác nhận xét, bổ sung.
- Nhận xét, chốt nội dung, minh họa.
(?) Nhắc lại những thao tác đã học?


- Gọi nhóm khác nhận xét, bổ sung.
- Nhận xét, chốt nội dung, minh họa.
- Nêu một ví dụ về ràng buộc dữ liệu trên bảng và minh họa bằng CSDL cụ thể.
	- Tham khảo SGK và trả lời.

- Lắng nghe.
- Thảo luận nhóm và đại diện nhóm trả lời.


- Đại diện nhóm nhận xét.
- Lắng nghe, ghi bài, quan sát.
- Thảo luận nhóm và đại diện nhóm trả lời.


- Đại diện nhóm nhận xét.
- Lắng nghe, ghi bài và quan sát.
- Lắng nghe, ghi bài và quan sát.



3.3. Hoạt động luyện tập, vận dụng
(1) Mục tiêu: Giúp học sinh nhận biết được về mô hình dữ liệu, các loại mô hình dữ liệu, các đặc trưng của mô hình dữ liệu quan hệ.
(2) Phương pháp/kĩ thuật: Đàm thoại, phát hiện.
(3) Hình thức tổ chức hoạt động: Làm việc cá nhân, thảo luận nhóm.
(4) Phương tiện dạy học: SGK, Projector, máy tính.
(5) Kết quả: Học sinh biết vận dụng các kiến thức đã học để trả lời các câu hỏi trắc nghiệm. 
Nội dung hoạt động
3.3.1.  Hoạt động luyện tập
- Nắm khái niệm mô hình dữ liệu;
- Nắm một số mô hình mô hình dữ liệu phổ biến;
- Nắm các đặc trưng của mô hình dữ liệu quan hệ.
3.3.2.  Hoạt động vận dụng
Câu 1: Mô hình phổ biến để xây dựng CSDL quan hệ là:
A. Mô hình phân cấp 	B. Mô hình dữ liệu quan hệ
C. Mô hình hướng đối tượng 	D. Mô hình cơ sở quan hệ
Câu 2: Các khái niệm dùng để mô tả các yếu tố nào sẽ tạo thành mô hình dữ liệu quan hệ?
A. Cấu trúc dữ liệu 	B. Các ràng buộc dữ liệu
C. Các thao tác, phép toán trên dữ liệu 	D. Tất cả câu trên
Câu 3: Mô hình dữ liệu quan hệ được E. F. Codd đề xuất năm nào?
A. 1975 	B. 2000 	C. 1995	D. 1970
Câu 4: Trong mô hình quan hệ, về mặt cấu trúc thì dữ liệu được thể hiện trong các:
A. Cột (Field) 	B. Hàng (Record)    C. Bảng (Table) 	D. Báo cáo (Report)
Câu 5: Thao tác trên dữ liệu có thể là:
A. Sửa bản ghi         B. Thêm bản ghi          C. Xoá bản ghi 		D. Tất cả đáp án
3.4. Hoạt động tìm tòi, mở rộng
(1) Mục tiêu: Giúp học sinh có nhu cầu mở rộng thêm kiến thức của mình.
(2) Phương pháp/kĩ thuật: Làm việc cá nhân, thảo luận nhóm.
(3) Hình thức tổ chức hoạt động: Ngoài lớp học.
(4) Phương tiện: SGK,  máy tính.
(5) Kết quả: Học sinh biết mở rộng các kiến thức của mình thông qua một dự án thực tế.
Nội dung hoạt động
HS về nhà học bài và xem trước nội dung 2. Cơ sở dữ liệu quan hệ của bài 10.
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§ 10. CƠ SỞ DỮ LIỆU QUAN HỆ (Mục 2a, b)

I. MỤC TIÊU
1. Về kiến thức
· Biết khái niệm CSDL quan hệ, hệ quản trị CSDL quan hệ.
· Biết các thuật ngữ.
· Biết các đặc trưng của một quan hệ  trong hệ CSDL quan hệ.	
2. Về kĩ năng
3. Về thái độ
· Có thái độ nghiêm túc trong học tập.
· Học sinh ngày càng say mê với cơ sở dữ liệu quan hệ, đặc biệt là sau khi đã biết tất cả các thao tác về cơ sở dữ liệu. 
4. Năng lực hướng tới
· Nhận biết được các thuật ngữ đối với CSDL quan hệ cụ thể.
II. TỔ CHỨC CÁC HOẠT ĐỘNG HỌC TẬP
1. Ổn định lớp
2. Kiểm tra bài cũ: Có
3. Tiến trình bài học
3.1. Hoạt động khởi động (kiểm tra bài cũ).
 (1) Mục tiêu: Giúp học sinh nhớ được mô hình dữ liệu, các loại mô hình dữ liệu, các đặc trưng của mô hình dữ liệu quan hệ đồng thời tạo động cơ để HS có nhu cầu tìm hiểu về CSDL quan hệ.
(2) Phương pháp/kĩ thuật dạy học: Vấn đáp.
(3) Hình thức tổ chức hoạt động: Làm việc cá nhân.
(4) Phương tiện dạy học: SGK, Projector, máy tính.
(5) Kết quả: Học sinh trả lời được các câu hỏi của giáo viên.
Nội dung hoạt động
	Giáo viên
	Học sinh

	(?) Mô hình dữ liệu là gì? Kể tên các loại mô hình dữ liệu mà em biết? Cho biết chủ đề và tựa bài 10?
- Nhận xét, cho điểm HS.
(?) Cho biết các đặc trưng của mô hình dữ liệu quan hệ? Cho biết các đề mục chính bài 10 (mục 1, 2)?
- Nhận xét, cho điểm HS.
- Tóm tắt nội dung mục 1 và dẫn dắt vào mục 2a, b.
	- Học sinh trả lời câu hỏi.


- Lắng nghe.
- Học sinh trả lời câu hỏi.


- Lắng nghe.
- Lắng nghe, ghi nhớ.



3.2. Hình thành kiến thức
3.2.1. Cơ sở dữ liệu quan hệ (Mục a. Khái niệm)
(1) Mục tiêu: Giúp học sinh biết được về khái niệm CSDL quan hệ, hệ quản trị CSDL quan hệ, các thuật ngữ, các đặc trưng của một quan hệ  trong hệ CSDL quan hệ.
(2) Phương pháp/kĩ thuật dạy học: Đàm thoại, phát hiện.
(3) Hình thức tổ chức hoạt động: Làm việc cá nhân.
(4) Phương tiện dạy học: SGK, Projector, máy tính.
(5) Kết quả: Học sinh biết được về khái niệm CSDL quan hệ, hệ quản trị CSDL quan hệ, các thuật ngữ, các đặc trưng của một quan hệ  trong hệ CSDL quan hệ.
Nội dung hoạt động
	Giáo viên
	Học sinh

	(?) Chiếu 1 số CSDL đã học ở HKI và yêu cầu HS nhắc lại khái niệm CSDL?
- Nhận xét và yêu cầu HS cho biết khái niệm CSDL quan hệ?


- Nhận xét, chốt nội dung.
(?) Nhắc lại khái niệm hệ QTCSDL?
- Nhận xét và yêu cầu HS cho biết tên hệ QTCSDL đã học ở HKI?
- Nhận xét, minh họa thêm 1 số hệ QTCSDL khác và yêu cầu HS cho biết khái niệm CSDL quan hệ?
- Nhận xét, chốt nội dung.
(?) Thuật ngữ gì dùng để chỉ bảng?
- Nhận xét, chốt nội dung.
(?) Thuật ngữ gì dùng để chỉ cột và hàng?
- Nhận xét, chốt nội dung.
(?) Thuật ngữ gì dùng để chỉ kiểu dữ liệu?
- Nhận xét, chốt nội dung.
- Giới thiệu các đặc trưng của một quan hệ  trong hệ CSDL quan hệ.
- Giải thích và minh họa đặc trưng đầu tiên.

(?) Tại sao các bộ là phân biệt?
- Gọi HS khác nhận xét, bổ sung.
-  Nhận xét, minh họa và chốt nội dung.
- Giải thích và minh họa đặc trưng thứ 3.

(?) Cho ví dụ về thuộc tính đa trị và phức hợp.
- Giải thích và minh họa đặc trưng thứ 4.
- Tóm tắt nội dung phần 2a.
	- Quan sát và nhắc lại khái niệm CSDL. 


- Lắng nghe. Tham khảo SGK và trả lời: 
CSDL được xây dựng dựa trên mô hình dữ liệu quan hệ gọi là CSDL quan hệ.
- Lắng nghe, ghi bài.

- Nhắc lại khái niệm hệ QTCSDL 
- Lắng nghe và trả lời: Access.

- Lắng nghe. Tham khảo SGK và trả lời: 
Hệ QTCSDL quan hệ dùng để tạo lập, cập nhật và khai thác CSDL quan hệ.
- Lắng nghe, ghi bài.

- Quan hệ

- Lắng nghe, ghi bài.

- Thuộc tính và bộ.

- Lắng nghe, ghi bài.

- Miền.

- Lắng nghe, ghi bài.

- Lắng nghe.


- Lắng nghe, quan sát và ghi bài.

- Tại vì trong quan hệ luôn có khóa.
- Nhận xét.

-  Lắng nghe, quan sát và ghi bài.
- Lắng nghe, quan sát và ghi bài.

- Tham khảo SGK và cho ví dụ tương tự.
-  Lắng nghe, quan sát và ghi bài.
- Lắng nghe và ghi nhớ.


3.3. Hoạt động luyện tập, vận dụng
(1) Mục tiêu: Giúp học sinh nhận biết được về CSDL quan hệ, hệ quản trị CSDL quan hệ, các thuật ngữ, các đặc trưng của một quan hệ  trong hệ CSDL quan hệ.
(2) Phương pháp/kĩ thuật: Đàm thoại, phát hiện.
(3) Hình thức tổ chức hoạt động: Làm việc cá nhân, thảo luận nhóm.
(4) Phương tiện dạy học: SGK, Projector, máy tính.
(5) Kết quả: Học sinh biết vận dụng các kiến thức đã học để trả lời các câu hỏi mà giáo viên đặt ra. 
Nội dung hoạt động
3.3.1.  Hoạt động luyện tập
- Nắm khái niệm về CSDL quan hệ, hệ quản trị CSDL quan hệ.
- Nắm các thuật ngữ.
- Nắm các đặc trưng của một quan hệ  trong hệ CSDL quan hệ.
3.3.2.  Hoạt động vận dụng: 2. Cơ sở dữ liệu quan hệ (Mục b. Ví dụ)
	Giáo viên
	Học sinh

	- Chiếu CSDL quan hệ QL_MUONSACH (Hình 71 (SGK trang 83)).
(?) CSDL quan hệ trên có bao nhiêu quan hệ? Kể tên?
- Nhận xét. (?) Mỗi quan hệ có bao nhiêu thuộc tính? Kể tên? Đề xuất miền cho các thuộc tính?
- Gọi đại diện các nhóm nhận xét.
- Nhận xét bài làm các nhóm và cho điểm.
(?) Mỗi quan hệ có bao nhiêu bộ?
- Nhận xét và đưa ra những lưu ý về CSDL quan hệ trên.
	- Quan sát.


- Có 3 quan hệ: NGƯỜI MƯỢN, SÁCH, MƯỢN SÁCH.
- Lắng nghe.Thảo luận nhóm, trả lời vào bảng phụ và treo kết quả lên bảng.
- Đại diện nhóm nhận xét.
- Lắng nghe.
- Quan sát và trả lời.
- Lắng nghe và ghi nhớ.


3.4. Hoạt động tìm tòi, mở rộng
(1) Mục tiêu: Giúp học sinh có nhu cầu mở rộng thêm kiến thức của mình.
(2) Phương pháp/kĩ thuật: Làm việc cá nhân, thảo luận nhóm.
(3) Hình thức tổ chức hoạt động: Ngoài lớp học.
(4) Phương tiện: SGK,  máy tính.
(5) Kết quả: Học sinh biết mở rộng các kiến thức của mình thông qua một dự án thực tế.
Nội dung hoạt động
HS về nhà học bài, xem lại ví dụ, tìm thêm 1 số ví dụ về CSDL quan hệ và xem trước nội dung mục 2c.
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§10. CƠ SỞ DỮ LIỆU QUAN HỆ (Tiết 3)
I. MỤC TIÊU
Sau bài học, HS đạt được:
1. Kiến thức
Hiểu khái niệm về khóa và liên kết giữa các bảng.
2. Kĩ năng
 		Xác định dược các bảng và khóa liên kết giữa các bảng của bài toán quản lí đơn giản.
3. Thái độ 
		Tự giác, tích cực trong học tập.
4. Định hướng hình thành năng lực 
· Năng lực giải quyết vấn đề.
· Năng lực làm việc nhóm, năng lực sử dụng CNTT.
· Năng lực thực hành.
II. CHUẨN BỊ CỦA GIÁO VIÊN VÀ HỌC SINH
1. Chuẩn bị của giáo viên
· Giáo án, SGK, SGV.
· GV nên chuẩn bị sẵn CSDL, máy chiếu, phòng máy.
2. Chuẩn bị của học sinh
· Đọc trước nội dung của bài thực hành.
· Sách giáo khoa.
 III. TỔ CHỨC CÁC HOẠT ĐỘNG HỌC TẬP
1. Ổn định lớp 
2. Kiểm tra bài cũ 
	Câu hỏi: Nêu khái niệm cơ sở dữ liệu quan hệ? Các đặc trưng chính của một quan hệ trong hệ CSDL quan hệ? Cho ví dụ.
· GV gọi  học sinh lên trả lời câu hỏi
· Học sinh trả lời.
· Học sinh còn lại ở dưới lớp quan sát các thao tác cũng như câu trả lời, nhận xét, bổ sung nếu có.
· GV nhận xét, củng cố câu trả lời, ghi điểm cho học sinh.
3. Tiến trình bài học
HOẠT ĐỘNG 1. Tìm hiểu về khóa, khóa chính 
(1) Mục tiêu: Nắm khái niệm khóa và khóa chính.
(2) Phương pháp/kĩ thuật dạy học: Đàm thoại, phát hiện, khai thác mối quan hệ giữa thực tiễn với tin học.
(3) Hình thức tổ chức: Làm việc cá nhân, thảo luận nhóm.
(4) Phương tiện dạy học: SGK, Máy tính, máy chiếu.
(5) Sản phẩm: Biết xác định và xây dựng khóa chính của bảng.

	Hoạt động của GV
	Hoạt động của HS

	Bước 1. Giao nhiệm vụ
· Giáo viên trình chiếu các ví dụ và từ đó phát vấn để học sinh nêu được khái niệm khoá, khoá chính.
· Trong phần này Giáo viên nên sử dụng máy chiếu để thể hiện các bảng cũng như các mối quan hệ giữa các bảng trong bài toán quản lý thư viện để từ đó chỉ ra cho HS thấy tại sao chúng ta phải liên kết giữa các bảng và tại sao chúng ta phải tạo các khóa cho các bảng.
Bước 2. Thực hiện nhiệm vụ
- GV trình chiếu ví dụ, đặt câu hỏi:
+ Đối với quan hệ NGƯỜI MƯỢN: Dựa vào thuộc tính nào để có thể phân biệt người mượn sách?
+  Dựa vào các thuộc tính nào để có thể phân biệt các lần mượn sách?
- Hướng dẫn HS trả lời các câu hỏi trên và dần hình thành khái niệm khóa, khóa chính.




· Khi các em gửi thư , các em có phải nhất thiết ghi đầy đủ địa chỉ của người gửi và địa chỉ người nhận?


 Bước 3. Thảo luận, trao đổi, báo cáo
GV nhận xét HS, giảng giải thêm.
Như vậy trong các thuộc tính của một bảng, ta quan tâm đến một tập thuộc tính (có thể chỉ gồm một thuộc tính) vừa đủ để phân biệt được các bộ. Vừa đủ ở đây được hiểu không có một tập con nhỏ hơn trong tập thuộc tính đó có tính chất phân biệt được các bộ trong bảng các bộ trong bảng. Trong một bảng, tập thuộc tính được mô tả ở trên được gọi là khóa của một bảng.
· Để đảm bảo sự nhất quán về dữ liệu, tránh trường hợp thông tin về một đối tượng xuất hiện hơn một lần sau những lần cập nhật. Do đó người ta sẽ chọn 1 khóa trong các khóa của bảng làm khóa chính.
 Bước 4. Phương án KTĐG
Cho ví dụ 1 bảng, yêu cầu hs xác định khóa, khóa chính.
	Bước 1. Nhận nhiệm vụ

- HS theo dõi, nắm được yêu cầu.






Bước 2. Thực hiện nhiệm vụ
Tìm hiểu ví dụ, trả lời các câu hỏi.
· Dựa vào thuộc tính Số thẻ để phân biệt người mượn sách.
· Dựa vào các thuộc tính Số thẻ, Mã số sách, Ngày mượn để phân biệt các lần mựợn sách.
· Như vậy đối với bảng NGƯỜI MƯỢN ta chọn trường số thẻ làm khoá. Đối với bảng MƯỢN SÁCH ta chọn nhóm các trường (số thẻ, mã số sách, ngày mượn) để làm khoá.
· Có thể không ghi địa chỉ người gửi, nhưng bắt buộc phải ghi địa chỉ người nhận.
· Như vậy địa chỉ người nhận làm khoá chính.
- HS hình thành khái niệm khóa, khóa chính, các tính chất của khóa, các yêu cầu của khóa chính.
Bước 3. Thảo luận, trao đổi, báo cáo
- HS trình bày các kiến thức tìm hiểu được về khóa, khóa chính.






Bước 4. Phương án KTĐG
 HS thực hiện yêu cầu.


HOẠT ĐỘNG 2. Tìm hiểu về liên kết giữa các bảng 
(1) Mục tiêu: Hiểu được ý nghĩa của việc liên kết các bảng
(2) Phương pháp/kĩ thuật dạy học: Đàm thoại, phát hiện, khai thác mối quan hệ giữa thực tiễn với tin học.
(3) Hình thức tổ chức: Làm việc cá nhân, thảo luận nhóm.
(4) Phương tiện dạy học: SGK, Máy tính, máy chiếu.
(5) Sản phẩm: ý nghĩa của việc liên kết các bảng.

	Hoạt động của GV
	Hoạt động của HS

	Bước 1. Giao nhiệm vụ
· Giáo viên trình bày ví dụ:
[image: HInh_42_sach]
Yêu cầu HS xác định mục đích của việc  tạo liên kết giữa các bảng.
Bước 2. Thực hiện nhiệm vụ
Hướng dẫn HS thực hiện nhiệm vụ



Bước 3. Thảo luận, trao đổi, báo cáo
- GV nhận xét HS, giảng giải thêm.
· Giảng giải thêm: Mục đích chính của việc xác định khóa là thiết lập sự liên kết giữa các bảng. Điều đó cũng giải thích tại sao ta cần xác định khóa sao cho nó bao gồm càng ít thuộc tính càng tốt. Thông qua các ví dụ có thể diễn giải cách thiết lập sự liên kết giữa các bảng và qua đó giúp học sinh hiểu được thêm về ý nghĩa và phương pháp xác định khóa.
Bước 4. Phương án KTĐG
Thông qua bài tập vận dụng cuối bài.
	Bước 1. Nhận nhiệm vụ

- HS theo dõi, nắm được yêu cầu.








Bước 2. Thực hiện nhiệm vụ
Phân tích ví dụ, tìm hiểu SGK đưa ra mục đích thực hiện liên kết bảng
Bước 3. Thảo luận, trao đổi, báo cáo
- HS trình bày các kiến thức tìm hiểu được về liên kết






Bước 4. Phương án KTĐG
 Thông qua bài tập vận dụng cuối bài.


HOẠT ĐỘNG 3: Bài tập vận dụng
(1)Mục tiêu: giúp những HS hệ thống kiến thức của tiết học qua các câu hỏi trắc nghiệm.
(2)Phương pháp/kĩ thuật dạy học: Thảo luận nhóm.
(4)Phương tiện dạy học: SGK, Máy tính, máy chiếu.
(5)Sản phẩm: HS trả lời phiếu câu hỏi và qua đó HS củng cố kiến thức bài học.
Nội dung hoạt động
GV phát phiếu câu hỏi cho các nhóm;
Câu 1: Phát biểu nào sai trong các phát biểu sau khi nói về khoá chính?
A. Một bảng có thể có nhiều khoá chính
B. Mỗi bảng có ít nhất một khoá
C. Xác định khoá phụ thuộc vào quan hệ logic của các dữ liệu chứ không phụ thuộc vào giá trị các dữ liệu
D. Nên chọn khoá chính là khoá có ít thuộc tính nhất
Câu 2: Khi cập nhật dữ liệu vào bảng, ta không thể để trống trường nào sau đây?
A. Khóa chính                                                          B. Khóa và khóa chính
C. Khóa chính và trường bắt buộc điền dữ liệu       D. Tất cả các trường của bảng
Câu 3: Trong mô hình quan hệ, ràng buộc như thế nào được gọi là ràng buộc toàn vẹn thực thể (ràng buộc khoá)?
A. Các hệ QT CSDL quan hệ kiểm soát việc nhập dữ liệu sao cho dữ liệu tại các cột khoá chính không được để trống, dữ liệu tại các cột khoá chính không được trùng nhau để đảm bảo sự nhất quán dữ liệu
B. Dữ liệu tại các cột khoá chính không được để trống
C. Dữ liệu tại các cột khoá chính không được trùng nhau
D. Dữ liệu tại các cột khoá chính không được để trống nhưng được trùng nhau
Câu 4: Danh sách của mỗi phòng thi gồm có các trường: STT, Họ tên học sinh, Số báo danh, phòng thi. Ta chọn khoá chính là :
A. STT		B. Số báo danh		C. Phòng thi		D. Họ tên học sinh
Câu 5: Giả sử một bảng có 2 trường SOBH (số bảo hiểm) và HOTEN (họ tên) thì nên chọn trường SOBH làm khoá chính hơn vì :
A. Trường SOBH là duy nhất, trong khi đó trường HOTEN không phải là duy nhất
B. Trường SOBH là kiểu số, trong khi đó trường HOTEN không phải là kiểu số
C. Trường SOBH đứng trước trường HOTEN
D. Trường SOBH là trường ngắn hơn
Câu 6: Trong bảng sau đây, mỗi học sinh chỉ có mộ mã số (Mahs)
 [image: ]
Khoá chính của bảng là:
A. Khoá chính = {Mahs}
B. Khoá chính = {HoTen, Ngaysinh, Lop, Diachi, Toan}
C. Khoá chính = {HoTen, Ngaysinh, Lop, Diachi, Li}
D. Khoá chính = {HoTen, Ngaysinh, Lop, Diachi}
Câu 7. Hai bảng trong một CSDL quan hệ liên kết với nhau thông qua :
A. Địa chỉ của các bảng			B. Thuộc tính khóa
C. Tên trường			D. Thuộc tính của các trường được chọn (không nhất thiết phải là khóa)
Câu 8: Cho các bảng sau  :
- DanhMucSach(MaSach, TenSach, MaLoai)
- LoaiSach(MaLoai, LoaiSach)
- HoaDon(MaSach, SoLuong, DonGia)
Để biết giá của một quyển sách thì cần những bảng nào ?
A. HoaDon								B. DanhMucSach, HoaDon	
C. DanhMucSach, LoaiSach					D. HoaDon, LoaiSach

ĐÁP ÁN:
	1A
	2A
	3A
	4B
	5A
	6A
	7B
	8B


4. Hướng dẫn học ở nhà(1’)
Xem lại bài học và xem trước bài tập và thực hành 10 (Trang 87 SGK).
 IV. RÚT KINH NGHIỆM
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BÀI TẬP VÀ THỰC HÀNH 10:  HỆ CƠ SỞ DỮ LIỆU QUAN HỆ (tiết 1)
I. MỤC TIÊU
Sau bài học, HS đạt được:
1. Kiến thức
· Biết chọn khóa cho các bảng dữ liệu của CSDL đơn giản.
· Hiểu khái niệm liên kết giữa các bảng trong sơ sở dữ liệu quan hệ.
· Biết cách xác lập liên kết giữa các bảng thông qua khóa, biết mục đích của việc xác lập liên kết giữa các bảng.
2. Kĩ năng
· Tạo bảng, phân tích chọn đúng kiểu dữ liệu và khóa chính.
· Liên kết đúng giữa các bảng.
· Tạo đúng mẫu hỏi, báo cáo theo yêu cầu.
3. Thái độ 
		Tự giác, tích cực trong học tập.
4. Định hướng hình thành năng lực 
· Năng lực giải quyết vấn đề.
· Năng lực làm việc nhóm, năng lực sử dụng CNTT.
· Năng lực thực hành.
II. CHUẨN BỊ CỦA GIÁO VIÊN VÀ HỌC SINH
1. Chuẩn bị của giáo viên
· Giáo án, SGK, SGV.
· Phòng máy, một cơ sở dữ liệu quản lí thí sinh. 
2. Chuẩn bị của học sinh
· Đọc trước nội dung của bài thực hành.
· Sách giáo khoa.
 III. TỔ CHỨC CÁC HOẠT ĐỘNG HỌC TẬP
1. Ổn định lớp
2. Kiểm tra bài cũ 
	Kết hợp trong quá trình thực hành.
3. Tiến trình bài học
HOẠT ĐỘNG 1. Phân tích CSDL, xác định khóa chính cho bảng.
(1)Mục tiêu: rèn luyện kĩ năng phân tích CSDL mới.
(2)Phương pháp/kĩ thuật dạy học: mảnh ghép, vấn đáp.
(3)Hình thức tổ chức: Làm việc cá nhân, Thảo luận nhóm.
(4)Phương tiện dạy học: SGK, Máy tính, máy chiếu.
(5)Sản phẩm: Phân tích kiểu dữ liệu, xác định khóa chính để xây dựng CSDL.
	Hoạt động của GV
	Hoạt động của HS

	Bước 1. Giao nhiệm vụ
-Giới thiệu cấu trúc 3 bảng THÍ SINH, ĐÁNH PHÁCH và ĐIỂM THI. Giáo viên cũng nên giới thiệu phải có 3 bảng như vậy để đảm bảo sự khách quan, công bằng trong việc chấm thi.
- Hãy xác định khóa trong bảng THÍ SINH?giải thích?
-Hãy xác định khóa trong bảng ĐÁNH PHÁCH? giải thích?
- Hãy xác định khóa trong bảng ĐIỂM THI? giải thích?
Bước 2. Thực hiện nhiệm vụ
- Theo dõi các nhóm, hướng dẫn.



Bước 3. Thảo luận, trao đổi, báo cáo
Hướng dẫn HS báo cáo kết quả, đưa ra đáp án.
Giáo viên cũng cần lưu ý với học sinh trong trường hợp các bảng với dữ liệu mẫu như trong sách giáo khoa, ta cũng có thể sử dụng trường STT làm trường khoá.
Bước 4. Phương án KTĐG
Đánh giá, nhận xét các nhóm thông qua sản phẩm các nhóm thảo luận được và thái độ khi tham gia thảo luận.
	Bước 1. Nhận nhiệm vụ
Theo dõi, xác định rõ yêu cầu.







Bước 2. Thực hiện nhiệm vụ
- Thảo luận đưa ra câu trả lời cho 3 câu hỏi trên.
Bước 3. Thảo luận, trao đổi, báo cáo
Đại diện nhóm trình bày kết quả thảo luận được.



Bước 4. Phương án KTĐG
 


HOẠT ĐỘNG 2. Phân tích CSDL, liên kết cần thiết giữa ba bảng. 
(1)Mục tiêu: rèn luyện kĩ năng phân tích liên kết.
(2)Phương pháp/kĩ thuật dạy học: mảnh ghép, vấn đáp.
(3)Hình thức tổ chức: Làm việc cá nhân, thảo luận nhóm.
(4)Phương tiện dạy học: SGK, Máy tính, máy chiếu.
(5)Sản phẩm: xây dựng liên kết cần thiết giữa ba bảng.
	Hoạt động của GV
	Hoạt động của HS

	Bước 1. Giao nhiệm vụ
- Nêu yêu cầu của bài tập 2: Em hãy chỉ ra các mối liên kết cần thiết giữa ba bảng để có được kết quả thi thông báo cho thí sinh.
Bước 2. Thực hiện nhiệm vụ
· Kết quả thi của mỗi học sinh bao gồm những thông tin nào? Các thông tin đó dựa trên những bảng nào?
· Như vậy các thông tin cần lấy dựa trên 2 bảng là THÍ SINH và ĐIỂM THI. Tuy nhiên 2 bảng này không có trường chung, vì vậy để lấy được tất cả các thông tin trên, ta cần thực hiện liên kết giữa hai bảng trên thông qua bảng thứ 3 là bảng ĐÁNH PHÁCH.
· Hãy xác định các mối liên kết trên.
Bước 3. Thảo luận, trao đổi, báo cáo
Hướng dẫn HS báo cáo kết quả, đưa ra đáp án.





Bước 4. Phương án KTĐG
Đánh giá, nhận xét các nhóm thông qua sản phẩm các nhóm thảo luận được và thái độ khi tham gia thảo luận.
	Bước 1. Nhận nhiệm vụ
Theo dõi, xác định rõ yêu cầu.


Bước 2. Thực hiện nhiệm vụ
- Thảo luận đưa ra câu trả lời cho các câu hỏi trên.







Bước 3. Thảo luận, trao đổi, báo cáo
· Kết quả thi của mỗi học sinh bao gồm: STT, SBD, họ tên, ngày sinh, trường (bảng THÍ SINH), điểm (bảng ĐIỂM THI).
· THÍ SINH liên kết với ĐÁNH PHÁCH thông qua SBD (liên kết 1-1).
ĐÁNH PHÁCH liên kết với ĐIỂM THI thông qua Phách(liên kết 1-1).




4. Củng cố, hướng dẫn học ở nhà 
· GV nhắc lại những vấn đề mà HS còn mắc phải trong quá giải bài tập.
· Yêu cầu HS về nhà xem lại các nội dung đã làm.
· Trả lời các câu hỏi và bài tập SGK trang 93.
 IV. RÚT KINH NGHIỆM
	
	
	
	
	
	
	
	

Tiết: 44

BÀI TẬP THỰC HÀNH 10.
HỆ CƠ SỞ DỮ LIỆU QUAN HỆ (Tiết 2))
I. MỤC TIÊU
1. Về kiến thức
· Biết cách sử dụng CSDL quan hệ đã có để cập nhật và khai thác thông tin phục vụ nhu cầu của người dùng.
2. Về kĩ năng
· Tạo được biểu mẫu, mẫu hỏi, báo cáo ở mức độ bình thường.
3. Về thái độ
· Có thái độ nghiêm túc trong học tập.
· Học sinh ngày càng say mê với cơ sở dữ liệu quan hệ.
4. Năng lực hướng tới
· Tạo được biểu mẫu, mẫu hỏi, báo cáo ở mức độ cao.
II. TỔ CHỨC CÁC HOẠT ĐỘNG HỌC TẬP
1. Ổn định lớp
2. Kiểm tra bài cũ: Không
3. Tiến trình bài học
3.1. Hoạt động khởi động
 (1) Mục tiêu: Tạo động cơ để HS có nhu cầu khai thác CSDL quan hệ QuanLyKiemTra.mdb.
(2) Phương pháp/kĩ thuật dạy học: Đàm thoại, phát hiện.
(3) Hình thức tổ chức hoạt động: Làm việc cá nhân.
(4) Phương tiện dạy học: SGK, Projector, máy tính.
(5) Kết quả: Học sinh có nhu cầu mong muốn được khai thác CSDL quan hệ QuanLyKiemTra.mdb.
Nội dung hoạt động
	Giáo viên
	Học sinh

	- Dẫn dắt vào bài.
- Hướng dẫn làm bài:
+ Để đưa ra kết quả thi của thí sinh ta cần truy vấn dữ liệu từ các bảng THÍ SINH, ĐIỂM THI, ĐÁNH PHÁCH. Để truy vấn dữ liệu ta phải sử dụng mẫu hỏi. Vậy việc cần làm đầu tiên là thiết kế mẫu hỏi KET_QUA_THI.
+ Sau khi có mẫu hỏi KET_QUA_THI, ta dựa trên đó để đưa ra thông báo kết quả thi. Vậy bây giờ chúng ta phải làm sao để có được thông báo kết quả thi?
- Nhận xét và hướng dẫn HS cách thực hiện các công việc cần làm:
+ Thiết kế query KET_QUA_THI.
+ Đưa ra kết quả thi để thông báo cho học sinh.
+ Đưa ra kết quả thi theo trường.
+ Đưa ra kết quả thi của tỉnh theo sắp xếp giảm dần của điểm thi.
	- Lắng nghe.
- Lắng nghe, quan sát.








- Trả lời: Tạo báo cáo.





- Lắng nghe, quan sát và ghi nhớ các thao tác để tự thực hành.


3.2. Hình thành kiến thức
3.2.1. Bài 3. 
(1) Mục tiêu: Giúp học sinh biết cách đưa ra kết quả thi để thông báo cho học sinh, đưa ra kết quả thi theo trường, đưa ra kết quả thi của toàn tỉnh theo thứ tự giảm dần của điểm thi.
(2) Phương pháp/kĩ thuật dạy học: Đàm thoại, khai thác mối quan hệ giữa thực tiễn với tin học.
(3) Hình thức tổ chức hoạt động: Thực hành trên máy.
(4) Phương tiện dạy học: SGK, Projector, máy tính.
(5) Kết quả: Học sinh biết vận dụng các kiến thức đã học vào giải quyết tình huống thực tiễn có nội dung trong bài 3.

Nội dung hoạt động
	Giáo viên
	Học sinh

	(?) Mở lại CSDL quan hệ đã tạo ở tiết trước và thực hiện các công việc:
+ Thiết kế query KET_QUA_THI.




+ Đưa ra kết quả thi để thông báo cho học sinh.


+ Đưa ra kết quả thi theo trường.


+ Đưa ra kết quả thi của tỉnh theo sắp xếp giảm dần của điểm thi.
- Quan sát, quản lý học sinh; giải đáp thắc mắc và giúp đỡ học sinh khi cần.
- Tiến hành chấm điểm 3 bạn làm xong đầu tiên. 
- Cuối giờ, chấm điểm của một số bạn bất kỳ trong lớp. Chiếu kết quả làm của các em đó cho cả lớp cùng quan sát và nhận xét.
- Tóm tắt nội dung tiết học.
	- Thực hành trên máy.


- Tạo mẫu hỏi KET_QUA_THI gồm các trường: STT, SBD, Họ tên thí sinh, Ngày sinh, Trường, Điểm.
- Tạo báo cáo kết quả thi để thông báo cho học sinh lấy dữ liệu từ mẫu hỏi KET_QUA_THI.
- Tạo báo cáo kết quả thi theo trường lấy dữ liệu từ mẫu hỏi KET_QUA_THI.
- Tạo báo cáo kết quả thi của tỉnh theo sắp xếp giảm dần của điểm thi lấy dữ liệu từ mẫu hỏi KET_QUA_THI.





- Quan sát, lắng nghe và rút kinh nghiệm. 


3.3. Hoạt động luyện tập, vận dụng
(1) Mục tiêu: Giúp học sinh khai thác CSDL quan hệ QuanLyKiemTra.mdb với những tình huống thực tế khác nhau. 
(2) Phương pháp/kĩ thuật: Đàm thoại, khai thác mối quan hệ giữa thực tiễn với tin học.
(3) Hình thức tổ chức hoạt động: Thực hành trên máy.
(4) Phương tiện dạy học: SGK, Projector, máy tính.
(5) Kết quả: Học sinh biết vận dụng các kiến thức đã học vào giải quyết các tình huống thực tiễn.
Nội dung hoạt động
3.3.1.  Hoạt động luyện tập
- Nắm được các bước để tạo mẫu hỏi và báo cáo.
3.3.2.  Hoạt động vận dụng
	Giáo viên
	Học sinh

	(?)Mở lại CSDL quan hệ đã tạo ở trên và thực hiện các công việc:
+ Tạo biểu mẫu cho 3 bảng THÍ SINH, ĐIỂM THI, ĐÁNH PHÁCH và nhập thêm cho mỗi bảng 5 bộ bất kì.
+ Tạo mẫu hỏi in ra danh sách các thí sinh có điểm từ 8 trở lên.
+ Tạo báo cáo in ra danh sách các thí sinh sinh sau ngày 01/06/1990.
- Phân tích và gợi ý cách làm bài. 
- Quan sát, quản lý học sinh, giải đáp thắc mắc và  giúp đỡ học sinh khi cần.
	- Quan sát.













- Lắng nghe và ghi nhớ.

- Thực hành trên máy.



3.4. Hoạt động tìm tòi, mở rộng
(1) Mục tiêu: Giúp học sinh có nhu cầu mở rộng thêm kiến thức của mình.
(2) Phương pháp/kĩ thuật: Làm việc cá nhân, thảo luận nhóm.
(3) Hình thức tổ chức hoạt động: Ngoài lớp học.
(4) Phương tiện: SGK,  máy tính.
(5) Kết quả: Học sinh biết mở rộng các kiến thức của mình thông qua một dự án thực tế.
Nội dung hoạt động
HS về nhà xem lại BÀI TẬP VÀ THỰC HÀNH 10 đồng thời thực hiện một số yêu cầu sau:
Sử dụng CSDL quan hệ QuanLyKiemTra.mdb và thực hiện các yêu cầu sau:
- Tạo một biểu mẫu cho bảng THÍ SINH, ĐÁNH PHÁCH dạng chính, phụ.
- Mở lại 3 biểu mẫu ở trên và tạo thêm các nút lệnh thêm, xóa, tới, lùi, lưu, đóng.
- Tính tổng điểm của các thí sinh theo từng trường.
- Thống kê những trường có thí sinh co điểm thi dưới 8.
	

§11 CÁC THAO TÁC TRÊN CƠ SỞ DỮ LIỆU QUAN HỆ (TT)
I. Mục tiêu:
1) Về kiến thức: 
+ Biết được các chức năng của hệ QTCSDL quan hệ và vai trò – ý nghĩa của các chức năng đó trong quá trình tạo lập, cập nhật và khai thác hệ QTCSDL quan hệ;
+ Biết cách tạo lập CSDL và khai thác CSDL (sắp xếp các bản ghi, truy vấn CSDL, kết xuất báo cáo) trên một số hệ QTCSDL quan hệ.
2) Về kỹ năng: 
+ Liên hệ với các thao tác cụ thể đã được học trên hệ QTCSDL Access.
3) Về thái độ: Hướng Hs xây dựng được một mô hình dữ liệu được dùng để mô tả dữ liệu ở mức cao.
II.  Chuẩn bị của Giáo viên và học sinh:
· Giáo viên: Sách giáo viên, sách giáo khoa, một số hình ảnh minh hoạ, máy chiếu, Hướng dẫn thực hiện chuẩn kiến thức, kĩ năng môn Tin học THPT.	
· Học sinh: sách giáo khoa.
III. Phương pháp:
· Thuyết trình
· Đàm thoại
· Gợi mở

Hoạt động 4: 3. Khai thác CSDL.
(1)Mục tiêu: biết các thao tác khai thác cơ sở dữ liệu.
(2)Phương pháp/kĩ thuật dạy học: Đàm thoại,vấn đáp, phát hiện, khai thác mối quan hệ giữa thực tiễn với tin học.
(3)Hình thức tổ chức: Làm việc cá nhân, Thảo luận nhóm.
(4)Phương tiện dạy học: SGK, Máy tính, máy chiếu.
(5)Sản phẩm: thực hiện được các thao tác khai thác cơ sở dữ liệu .

Nội dung hoạt động
· Sắp xếp các bản ghi
· Truy vấn dữ liệu
· Xem dữ liệu
· Kết xuất báo cáo
	Hoạt động của GV
	Hoạt động của HS
	Nội dung

	* GV nhắc lại phát biểu đơn giản về bài toán sắp xếp trong SGK Tin học 10
a. Sắp xếp trên Access:
+ Mở bảng Hoc_sinh đã được tạo và đã được nhập dữ liệu.
+ Yêu cầu hs thực hiện sắp xếp cột To theo thứ tự tăng dần
* Yêu cầu hs sắp xếp tăng dần theo điểm môn Toán

b. Truy vấn trên Access:
- Mở bảng Hoc_sinh đã được tạo và đã được nhập dữ liệu
- Yêu cầu hs thực hiện hiển thị danh sách hs tổ 1













c. Xem dữ liệu trên Access:
- Mở bảng Hoc_sinh
-Yêu cầu hs thực hiện hiển thị bảng chỉ gồm các cột Hodem, ten, ngsinh

d. Kết xuất báo cáo trên Access:
- Yêu cầu hs thực hiện xuất kết quả học tập của từng hs ra máy in
	1. Các thao tác để sắp xếp 
+ Chọn cột To
+ Bấm chuột vào công cụ
2. Quan sát quá trình thực hiện và kết quả của GV
* Access thực hện sắp xếp ngay trên bảng dữ liệu nguồn


* HS Quan sát quá trình thực hiện và kết quả hiển thị trên màn hình, nhận xét.
* Thực hiện các thao tác trên máy của GV
+ Chọn đối tượng Queries
+ Bấm đúp chuột vào Create query by using wizard
+Chọn bảng Hoc_sinh
+Chọn các trường cho mẫu hỏi
+Chọn Next 2 lần
+ Trên cột To, dòng criteria gõ 1
+Thực hiện mẫu hỏi để thu kết quả

* Thực hiện yêu cầu của GV 
+ Bấm đúp chuột vào bảng Hoc_sinh
+Bấm phải chuột vào các cột không muốn hiển thị, chọn lệnh Hide columns

*Thực hiện yêu cầu của GV 

	· Sắp xếp các bản ghi







· Truy vấn dữ liệu









· Xem dữ liệu




· Kết xuất báo cáo




1. Câu hỏi chủ đề các thao tác khai thác cơ sở dữ liệu  :
(1)Mục tiêu: củng cố kiến thức qua các câu trắc nghiệm chủ đề.
(2)Phương pháp/kĩ thuật dạy học: Đàm thoại, vấn đáp.
(3)Hình thức tổ chức: Làm việc cá nhân, Thảo luận nhóm.
(4)Phương tiện dạy học: SGK, Máy tính, máy chiếu.
(5)Sản phẩm: trả lời các câu trắc nghiệm.

Nội dung hoạt động

Câu 1: Việc đầu tiên để tạo lập một CSDL quan hệ là :
A. Tạo ra một hay nhiều biểu mẫu			B. Tạo ra một hay nhiều báo cáo
C. Tạo ra một hay nhiều mẫu hỏi			D. Tạo ra một hay nhiều bảng
Câu 2: Thao tác khai báo cấu trúc bảng bao gồm :
A. Khai báo kích thước của trường			B. Tạo liên kết giữa các bảng
C. Đặt tên các trường và chỉ định kiểu dữ liệu cho mỗi trường	D. Câu A và C đúng
Câu 3: Thao tác nào sau đây không thuộc loại tạo lập CSDL quan hệ?
A. Tạo cấu trúc bảng                                       	B. Chọn khoá chính
C. Ðặt tên bảng và lưu cấu trúc bảng              	D. Nhập dữ liệu ban đầu
Câu 4: Trong quá trình tạo cấu trúc của một bảng, khi tạo một trường, việc nào sau đây không  nhất thiết phải thực hiện?
A. Đặt tên, các tên của các trường cần phân biệt                     B.Chọn kiểu dữ liệu
C. Đặt kích thước                                                                     D. Mô tả nội dung
Câu 5: Cho các thao tác sau :
B1: Tạo bảng      B2: Đặt tên và lưu cấu trúc    B3: Chọn khóa chính cho bảng   B4: Tạo liên kết
Khi tạo lập CSDL quan hệ ta thực hiện lần lượt các bước sau:
A. B1-B3-B4-B2               B. B2-B1-B2-B4            	C. B1-B3-B2-B4            D. B1-B2-B3-B4
Câu 6: Thao tác nào sau đây không phải là thao tác cập nhật dữ liệu?
A. Nhập dữ liệu ban đầu                                            	B. Sửa những dữ liệu chưa phù hợp
C. Thêm bản ghi                                               	D. Sao chép CSDL thành bản sao dự phòng
Câu 7: Chỉnh sửa dữ liệu là:
A. Xoá một số quan hệ				B. Xoá giá trị của một vài thuộc tính của một bộ
C. Thay đổi các giá trị của một vài thuộc tính của một bộ	D. Xoá một số thuộc tính
Câu 8: Xoá bản ghi là :
A. Xoá một hoặc một số quan hệ			B. Xoá một hoặc một số cơ sở dữ liệu
C. Xoá một hoặc một số bộ của bảng			D. Xoá một hoặc một số thuộc tính của bảng
Câu 9: Thao tác nào sau đây không là khai thác CSDL quan hệ?
A. Sắp xếp các bản ghi                                               B. Thêm bản ghi mới
C. Kết xuất báo cáo				           	D. Xem dữ liệu 
Câu 10: Khai thác CSDL quan hệ có thể là:
A. Tạo bảng, chỉ định khóa chính, tạo liên kết   B. Đặt tên trường, chọn kiểu dữ liệu, định tính chất trường      
C. Thêm, sửa, xóa bản ghi			D. Sắp xếp, truy vấn, xem dữ liệu, kết xuất báo cáo                                   
ĐÁP ÁN:
	1D
	2D
	3D
	4D
	5C
	6D
	7C
	8C
	9B
	10D


D. Củng cố và dặn dò:
· Các bước tạo lập CSDL: Tạo bảng, lưu bảng, chọn khoá và tạo liên kết
· Các thao tác cập nhật dữ liệu: Thêm bản ghi, xoá bản ghi, chỉnh sửa dữ liệu của bản ghi.
· Các thao tác khai thác dữ liệu : sắp xếp các bản ghi, truy vấn cơ sở dữ liệu, xem dữ liệu và kết xuất báo cáo.
· Chuẩn bị bài thực hành 10
 V.Rút kinh nghiệm:
	
	
	
	
	

Ngày soạn:
Tiết: 46
KIỂM TRA MỘT TIẾT
I. Mục tiêu: 
· Củng cố lại các kiến thức đã học thông qua một số câu hỏi tự luận và trắc nghiệm.
· Cụ thể nhấn mạnh vào một số nội dung sau: Khái niệm CSDL quan hệ, hệ CSDL quan hệ, phân biệt sự khác nhau giữa khóa và khóa chính, các thao tác thường gặp  trên hệ CSDL quan hệ.
II. Chuẩn bị của giáo viên và học sinh:
· Giáo viên: chuẩn bị các câu hỏi và ra đề kiểm tra.
· Học sinh: tự ôn tập lại các kiến thức và độc lập làm bài.
III. Phương pháp:
· Nêu vấn đề
IV.  Ma trận đề:
	                  Cấp độ

Tên 
chủ đề      
(nội dung,chương…)
	Nhận biết
	Thông hiểu
	Vận dụng
	Cộng

	
	
	
	 
Cấp độ thấp
	
Cấp độ cao
	

	1. CSDLQH
	CSDL QH
	- Khái niệm CSDLQH và hệ QTCSDL QH.

	- Đặc trưng của CSDLQH

	
	
	

	
	
	Số câu:3 TN
Số điểm:0.9
	Số câu:2 TN, 
Số điểm:0.6
	
	
	Số câu: 5
1.5 Điểm= 15%

	
	Khoá và liên kết giữa các khoá
	- Khái niệm khoá.
- Liên kết giữa các bảng
	- Xác định khoá chính.
- Xác định liên kết giữa các bảng
	
	Xác định khoá
	

	
	
	Số câu: 4 TN
Số điểm:1.2
	Số câu: 2 TL
Số điểm:1
	
	Số câu:1 (TL)
Số điểm:1
	Số câu: 7
3.2 Điểm= 32

	Tổng số câu: 12
Tổng số điểm
	Số câu: 7 
Số điểm:2.1
	Số câu: 4
Số điểm:1.6
	
	Số câu:1 (TL)
Số điểm:1
	Số câu: 12
4.7 Điểm= 47%

	2. Thao tác với Hệ QTCSDL QH
	Tạo lập CSDL
	Tạo lập CSDL
	
	
	
	

	
	
	Số câu:1TN
Số điểm:0.3
	
	
	
	Số câu:1 0.3điểm=3% 

	
	Cập nhật CSDL
	Cập nhật CSDL
	Cập nhật CSDL
	Liệt kê tình huống cập nhật thông tin của 1 CSDL QH cụ thể
	
	

	
	
	Số câu:3 TN
Số điểm:0.9
	Số câu:1 TN
Số điểm:0.3
	Số câu:1 TL
Số điểm:1
	
	Số câu:5
2.2 điểm =22% 

	
	Khai thác CSDL
	Khai thác CSDL
	Khai thác CSDL
	Nêu tình huống và các thông tin được khai thác của 1 CSDL QH cụ thể
	
	

	
	
	Số câu:3 TN
Số điểm:0.9
	Số câu:3 TN
Số điểm:0.9
	Số câu:1 TL
Số điểm:1
	
	Số câu:7
2.8 điểm =28% 

	Số câu: 13
Số điểm:5.3  Tỉ lệ 53%
	Số câu: 7
Số điểm: 2.1
21%
	Số câu:4
Số điểm:1.2
12%
	Số câu: 2
Số điểm: 2
20 %
	
	Số câu: 13
Số điểm:5.3  Tỉ lệ 53%

	Tổng số câu: 25
Tổng số điểm: 10
Tỉ lệ 100%
	Số câu: 14
Số điểm: 4.2
42%
	Số câu:8
Số điểm: 2.8
28%
	Số câu: 3
Số điểm: 3
30 %
	



V. Nội dung:
Phần I. Trắc nghiệm khách quan: (6 điểm)
Hãy tô đậm vào đáp án đúng              
	Câu
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12
	13
	14
	15
	16
	17
	18
	19
	20

	A
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O

	B
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O

	C
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O

	D
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O
	O



Câu 1: Cần tiến hành cập nhật hồ sơ học sinh của nhà trường trong các trường hợp nào sau đây?
A. Một học sinh mới chuyển từ trường khác đến; thông tin về ngày sinh của một học sinh bị sai.
B. Sắp xếp danh sách học sinh theo thứ tự tăng dần của tên
C. Tìm học sinh có điểm môn toán cao nhất khối.
D. Tính tỉ lệ học sinh trên trung bình môn Tin của từng lớp.
Câu 2: Xét công tác quản lí hồ sơ. Trong số các công việc sau, những việc nào không thuộc nhóm thao tác cập nhật hồ sơ?
A. Xóa một hồ sơ				B. Thống kê và lập báo cáo	
C. Thêm hai hồ sơ				D. Sửa tên trong một hồ sơ.
Câu 3: Các khái niệm dùng để mô tả các yếu tố nào sẽ tạo thành mô hình dữ liệu quan hệ?
A. Cấu trúc dữ liệu				B. Các ràng buộc dữ liệu
C. Các thao tác, phép toán trên dữ liệu	D. Tất cả câu trên
Câu 4: Liên kết giữa các bảng cho phép:
A. Tránh được dư thừa dữ liệu 		C. Có thể có được thông tin tổng hợp từ nhiều bảng
C. Nhất quán dữ liệu				D. Cả A, B, C đều đúng
Câu 5: Trong Access, để tạo liên kết giữa 2 bảng thì hai bảng đó phải có hai trường thỏa mãn điều kiện:
A. Có tên giống nhau				B. Có kiểu dữ liệu giống nhau hoặc phù hợp nhau
C. Có ít nhất một trường là khóa chính	D. Cả A, B, C
Câu 6: Báo cáo thường được sử dụng để:
A. Thể hiện được sự so sánh  và tổng hợp thông tin từ các nhóm dữ liệu
B. Trình bày nội dung văn bản theo mẫu quy định
C. A và B đều đúng
D. A và B đều sai
Câu 7: Để tạo một báo cáo, cần trả lời các câu hỏi gì?
A. Báo cáo được tạo ra để kết xuất thông tin gì? Dữ liệu từ những bảng, mẫu hỏi nào sẽ được đưa vào báo cáo? Dữ liệu sẽ được nhóm như thế nào?
B. Báo cáo được tạo ra để kết xuất thông tin gì? Dữ liệu từ những bảng, mẫu hỏi nào sẽ được đưa vào báo cáo? Tạo báo cáo bằng cách nào?
C. Báo cáo được tạo ra để kết xuất thông tin gì? Dữ liệu từ những bảng, mẫu hỏi nào sẽ được đưa vào báo cáo? Dữ liệu sẽ được nhóm như thế nào? Hình thức báo cáo như thế nào?
D. Báo cáo được tạo ra để kết xuất thông tin gì? Dữ liệu từ những bảng, mẫu hỏi nào sẽ được đưa vào báo cáo? 
Câu 8: Giả sử bảng HOCSINH gồm có các trường MAHS, HOTEN, DIEM. LOP. Muốn hiển thị thông tin điểm cao nhất của mỗi lớp để sử dụng lâu dài, trong Access ta sử dụng đối tượng nào trong các đối tượng sau?
A. Reports	 	B. Queries 		C. Forms    			D. Tables
Câu 9: Cho các bảng sau  :
- DanhMucSach(MaSach, TenSach, MaLoai)
- LoaiSach(MaLoai, LoaiSach)
- HoaDon(MaSach, SoLuong, DonGia)
Để biết giá của một quyển sách thì cần những bảng nào ?
A. HoaDon	B. DanhMucSach, HoaDon	C. DanhMucSach, LoaiSach		D. HoaDon, LoaiSach
Câu 10: Cho bảng dữ liệu sau: 
[image: ]
Có các lí giải nào sau đây cho rằng bảng đó không phải là một quan hệ trong hệ CSDL quan hệ?
A. Tên các thuộc tính bằng chữ Việt		B. Không có thuộc tính tên người mượn
C. Có một cột thuộc tính là phức hợp		D. Số bản ghi quá ít.

Câu 11: Trong mô hình quan hệ, về mặt cấu trúc thì dữ liệu được thể hiện trong các:
A. Cột (Field)		B. Hàng (Record)	C. Bảng (Table)	D. Báo cáo (Report)
Câu 12: Thao tác trên dữ liệu có thể là:
A. Sửa bản ghi		B. Thêm bản ghi	C. Xoá bản ghi	D. Tất cả đáp án trên
Câu 13: Phát biểu nào về hệ QTCSDL quan hệ là đúng?
A. Phần mềm dùng để xây dựng các CSDL quan hệ
B. Phần mềm dùng để tạo lập, cập nhật và khai thác CSDL quan hệ
C. Phần mềm Microsoft Access
D. Phần mềm để giải các bài toán quản lí có chứa các quan hệ giữa các dữ liệt
Câu 14: Khi cập nhật dữ liệu vào bảng, ta không thể để trống trường nào sau đây?
A. Khóa chính                                                          B. Khóa và khóa chính
C. Khóa chính và trường bắt buộc điền dữ liệu       D. Tất cả các trường của bảng
Câu 15: Khẳng định nào là sai khi nói về khoá?
A. Khoá là tập hợp tất cả các thuộc tính trong bảng để phân biệt được các cá thể
B. Khoá là tập hợp tất cả các thuộc tính vừa đủ để phân biệt được các cá thể
C. Khoá chỉ là một thuộc tính trong bảng được chọn làm khoá
D. Khoá phải là các trường  STT
Câu 16: Cho các thao tác sau :
B1: Tạo bảng      B2: Đặt tên và lưu cấu trúc    B3: Chọn khóa chính cho bảng   B4: Tạo liên kết
Khi tạo lập CSDL quan hệ ta thực hiện lần lượt các bước sau:
A. B1-B3-B4-B2               B. B2-B1-B2-B4            	C. B1-B3-B2-B4            D. B1-B2-B4-B2
Câu 17: Chỉnh sửa dữ liệu là:
A. Xoá một số quan hệ				
B. Xoá giá trị của một vài thuộc tính của một bộ
C. Thay đổi các giá trị của một vài thuộc tính của một bộ	
D. Xoá một số thuộc tính
Câu 18: Xoá bản ghi là :
A. Xoá một hoặc một số quan hệ			B. Xoá một hoặc một số cơ sở dữ liệu
C. Xoá một hoặc một số bộ của bảng			D. Xoá một hoặc một số thuộc tính của bảng
Câu 19: Cho bảng dữ liệu sau:
[image: ]
Bảng này không là một quan hệ trong hệ CSDL quan hệ, vì:
A. Ðộ rộng các cột không bằng nhau		B. Có hai bản ghi có cùng giá trị thuộc tính số thẻ là TV – 02
C. Một thuộc tính có tính đa trị 		D. Có bản ghi chưa đủ các giá trị thuộc tính
Câu 20: Trong mô hình quan hệ, ràng buộc như thế nào được gọi là ràng buộc toàn vẹn thực thể (ràng buộc khoá)?
A. Các hệ QT CSDL quan hệ kiểm soát việc nhập dữ liệu sao cho dữ liệu tại các cột khoá chính không được để trống, dữ liệu tại các cột khoá chính không được trùng nhau để đảm bảo sự nhất quán dữ liệu
B. Dữ liệu tại các cột khoá chính không được để trống
C. Dữ liệu tại các cột khoá chính không được trùng nhau
D. Dữ liệu tại các cột khoá chính không được để trống nhưng được trùng nhau

Phần II. Tự luận(4 điểm)
Cho CSDL QL_HS có các đối tượng sau: 
· HocSinh(MaHS, Hoten, Lop, GT, NgaySinh)
· NoiQuy(MaNQ, TenNQ, Diem)
· TheoDoiNQ(MaHS, MaNQ, Tuan, ThoiGian)
Câu 1: Xác định khoá có thể có của các đối tượng. (1 điểm)
Câu 2: Xác định khoá chính của các đối tượng. (0.5 điểm)
Câu 3: Xác định liên kết giữa các bảng. (0.5 điểm)
Câu 4: Nêu các tình huống mà CSDL có thể cập nhật thông tin và các thông tin nào có thể cập nhật. (Ít nhất 3 tình huống). (1 điểm)
Câu 5: Nêu tình huống CSDL trên có thể kết xuất thông tin? Và thông tin kết xuất? (Ít nhất 3 tình huống) (1 điểm)

VI. ĐÁP ÁN:
Phần I (Trắc nghiệm) Mỗi câu đúng được 0.3 điểm:
	Câu
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12
	13
	14
	15
	16
	17
	18
	19
	20

	ĐA
	A
	B
	D
	D
	B
	C
	A
	A
	B
	C
	C
	D
	B
	C
	B
	C
	C
	C
	C
	A



Phần II:
Câu 1: Xác định khoá có thể có của các đối tượng. (1 điểm)
+ Đối tượng HocSinh có thể có các khoá sau:
· Khoá 1: {MaHS}
· Khoá 2: {Hoten, NgaySinh}
+ Đối tượng NoiQuy có thể có các khoá sau:
· Khoá 1: {MaNQ}
· Khoá 2: {TenNQ}
+ Đối tượng TheoDoiNQ có thể có các khoá sau:
· Khoá 1: {MaHS, MaNQ,Tuan,ThoiGian}
Câu 2: Xác định khoá chính của các đối tượng. (0.5 điểm)
+ Đối tượng HocSinh : {MaHS}
+ Đối tượng NoiQuy : {MaNQ}
+ Đối tượng TheoDoiNQ : {MaHS, MaNQ,Tuan,ThoiGian}
Câu 3: Xác định liên kết giữa các bảng. (0.5 điểm)
+ Bảng HocSinh liên kết với bảng TheoDoiNQ qua MaHS
+ Bảng NoiQuy liên kết với bảng TheoDoiNQ qua MaNQ
Câu 4: Nêu các tình huống mà CSDL có thể cập nhật thông tin và các thông tin nào có thể cập nhật. (Ít nhất 4 tình huống). (1 điểm)
· Khi có học sinh mới chuyển về trường: cập nhật thông tin học sinh: thêm học sinh {MaHS, Hoten, GT, NgaySinh, Lop}
· Khi nhà trường có quyết định thay đổi về bảng nội quy: Thay đổi điểm của nội quy hoặc tên nội quy.
· Khi có học sinh vi phạm nội quy: cập nhật: MaHS, MaNQ, Tuan, ThoiGian

· Ghi chú: HS có thể đưa ra các tình huống khác nếu đảm bảo yêu cầu: thêm, xoá, chỉnh sửa thông tin của các đối tượng thì đạt yêu cầu.
Câu 5: Nêu tình huống CSDL trên có thể kết xuất thông tin? Và thông tin kết xuất? (Ít nhất 4 tình huống) (1 điểm)
· Khi có xem thông tin vi phạm của 1 học sinh: hiển thị thông tin học sinh vi phạm từ đầu năm đến thời điểm hiện tại gồm các thông tin: Mã học sinh, tên nội quy vi phạm, điểm trừ của mục vi phạm, tổng điểm trừ vi phạm đến thời điểm hiện tại
· Khi tổng kết thi đua cuối tuần: thông tin điểm trừ của từng lớp, hiển thị thông tin: Lop, tên học sinh vi phạm, nội quy vi phạm, tổng điểm trừ từng lớp trong tuần.
· Khi tổng kết thi đua cuối năm, cuối học kì: thông tin điểm trừ của từng lớp, hiển thị thông tin: Lop, tên học sinh vi phạm, nội quy vi phạm, tổng điểm trừ từng lớp trong năm, học kì.
· Ghi chú: HS có thể đưa ra các tình huống khác nếu đảm bảo yêu cầu: tổng hợp, kết xuất, báo cáo thông tin của các đối tượng thì đạt yêu cầu.
VII. TIẾN TRÌNH LÊN LỚP:
· Kiểm tra sỉ số
· Phát đề
· Theo dõi học sinh trong thời gian kiểm tra.
· Thu bài.

 
Tiết: 47
BÀI 13. BẢO MẬT THÔNG TIN TRONG CÁC HỆ CƠ SỞ DỮ LIỆU (Tiết 1)
I. Mục tiêu: 
1. Kiến thức: 
- Biết khái niệm bảo mật.
- Biết giải pháp bảo mật hệ thống: Chính sách và ý thức; Phân quyền truy cập và nhận dạng người dùng.
2. Kĩ năng: Biết một số cách thông dụng bảo mật CSDL
3. Thái độ: Có ý thức và thái độ đúng đắn trong việc sử dụng và bảo mật CSDL
4. Định hướng hình thành năng lực: Hình thành năng lực bảo mật CSDL trong hệ thống CSDL sử dụng.
II. Chuẩn bị của giáo viên và học sinh:
	1. Chuẩn bị của giáo viên: 
	- Thiết bị dạy học: Máy tính, máy chiếu
- Học liệu: sách giáo khoa;  sách giáo viên;  Hướng dẫn thực hiện chuẩn kiến thức, kĩ năng môn Tin học THPT.	
2. Chuẩn bị của học sinh: Sách giáo khoa, sách bài tập, xem trước bài học.
III. Tổ chức các hoạt động học tập: 
1. Ổn định lớp (1’)
2. Kiểm tra bài cũ (3’)
	Hãy nêu các thao tác với CSDL quan hệ.
 Làm thế nào để bảo mật các thông tin trong CSDL mà chúng ta vừa mới tạo ra, chúng ta sẽ tìm hiểu vấn đề này trong Bài 13. BẢO MẬT THÔNG TIN TRONG CÁC HỆ CƠ SỞ DỮ LIỆU
3. Tiến trình bài học
Hoạt động 1: Tìm hiểu khái niệm bảo mật thông tin 
(1) Mục tiêu: Hình thành kiến thức về vấn đề bảo mật thông tin trong các hệ CSDL.
(2) Phương pháp/kĩ thuật dạy học: Đàm thoại, phát hiện-giải quyết vấn đề, vấn đáp, khai thác mối quan hệ giữa thực tiễn với tin học.
(3) Hình thức tổ chức: Cá nhân, cặp đôi.
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu.

	Hoạt động của GV
	Hoạt động của HS

	Bước 1. Giao nhiệm vụ
    Ngày nay trong xã hội tin học hóa nhiều hoạt động đều diễn ra trên mạng có qui mô toàn thế giới. Do đó vấn đề bảo mật thông tin được đặt lên hàng đầu. Em hãy cho biết bảo mật thông tin là gì?
Bước 2. Thực hiện nhiệm vụ
   Quan sát, hỗ trợ HS (nếu cần)


Bước 3. Thảo luận, trao đổi, báo cáo
Lắng nghe kết quả báo cáo của HS












Bước 4. Phương án KTĐG
   Đánh giá kết quả hoạt động dựa trên kết quả báo cáo và quá trình thực hiện nhiệm vụ.
Điều chỉnh, bổ sung:
Ví dụ, một số hệ quản lí học tập và giảng dạy của nhà trường cho phép mọi phụ huynh HS truy cập để biết kết quả học tập của con em mình. Mỗi phụ huynh chỉ có quyền xem điểm của con em mình hoặc của khối con em mình học. Đây là quyền truy cập hạn chế nhất (mức thấp nhất). các thầy cô giáo trong trường có quyền truy cập cao hơn: Xem kết quả và mọi thông tin khác của bất kì HS nào trong trường. Người quản lí học tập có quyền nhập điểm, cập nhật các thông tin khác trong CSDL.
	Bước 1. Giao nhiệm vụ
   Im lặng, lắng nghe yêu cầu của GV







Bước 2. Thực hiện nhiệm vụ
   Nghiên cứu SGK, thảo luận với bạn bên cạnh để thực hiện yêu cầu của GV.
Bước 3. Thảo luận, trao đổi, báo cáo
   Bảo mật trong hệ CSDL là:
+ Ngăn chặn các truy cập không được phép.
+ Hạn chế tối đa các sai sót của người dùng.
+ Đảm bảo các thông tin không bị mất hoặc thay đổi ngoài ý muốn.
+ Không tiết lộ nội dung dữ liệu cũng như chương trình xử lý.
Vd: tài khoản của mỗi cá nhân trong ngân hàng…
Bước 4. Phương án KTĐG
Ghi nhận, phản biện kết quả kiểm tra đánh giá



Hoạt động 2: Tìm hiểu về giải pháp bảo mật thông tin Chính sách và ý thức 
(1) Mục tiêu: Biết được những kiến thức cơ bản về giải pháp chính sách và ý thức.
(2) Phương pháp/kĩ thuật dạy học: Đàm thoại, vấn đáp
 	  (3) Hình thức tổ chức: Cá nhân, cặp đôi.
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu.
	Hoạt động của GV
	Hoạt động của HS

	Bước 1. Giao nhiệm vụ
- Yêu cầu học sinh tham khảo sách giáo khoa và trả lời câu hỏi: Giải pháp bảo mật này được thực hiện như thế nào?
- Liên hệ thực tế: Cho một số ví dụ có liên quan đến xâm phạm thông tin dùng chung hoặc thông tin của người khác.
Bước 2. Thực hiện nhiệm vụ
   Quan sát, hỗ trợ HS (nếu cần)


Bước 3. Thảo luận, trao đổi, báo cáo
Lắng nghe kết quả báo cáo của HS














Bước 4. Phương án KTĐG
   Đánh giá kết quả hoạt động dựa trên kết quả báo cáo và quá trình thực hiện nhiệm vụ.
Điều chỉnh, bổ sung:
Người dùng phải có ý thức coi vệ thông tin là một tài nguyên quan trọng, có trách nhiệm thực hiện đúng qui phạm mà người quản trị hệ thống yêu cầu, tự giác thực hiện các điều khoản do pháp luật qui định.
	Bước 1. Giao nhiệm vụ
   Im lặng, lắng nghe yêu cầu của GV








Bước 2. Thực hiện nhiệm vụ
   Nghiên cứu SGK, thảo luận với bạn bên cạnh để thực hiện yêu cầu của GV.
Bước 3. Thảo luận, trao đổi, báo cáo
+ Cấp quốc gia: các chính sách, điều luật; Trong các tổ chức: quy định cụ thể, cung cấp tài chính, nguồn lực…
+ Người phân tích và thiết kế CSDL: có các giải pháp ngăn chặn cả về phần cứng và phần mềm.
+ Người dùng: ý thức tôn trọng tài nguyên dùng chung
- Ví dụ:
+ tấn công các trang web
+ đánh cắp mật khẩu rút tiền ở ngân hàng.
Bước 4. Phương án KTĐG
Ghi nhận, phản biện kết quả kiểm tra đánh giá



Hoạt động 3: Tìm hiểu về giải pháp bảo mật thông tin Phân quyền truy cập và nhận dạng người dùng.(15’)
(1) Mục tiêu: Biết về phân quyền truy cập và nhận dạng người dùng.
(2) Phương pháp/kĩ thuật dạy học: Đàm thoại, nêu-giải quyết vấn đề
(3) Hình thức tổ chức: Cá nhân, thảo luận nhóm.
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu.


	Hoạt động của GV
	Hoạt động của HS

	Bước 1. Giao nhiệm vụ
Yêu cầu HS đọc SGK và thảo luận nhóm để trả lời các câu hỏi sau:
- Bảng phân quyền là gì?
- Hệ thống nhận dạng người dùng bằng cách nào?
- Theo em, điều gì sẽ xảy ra nếu không có bảng phân quyền (khi quản lý CSDL)?
Bước 2. Thực hiện nhiệm vụ
   Quan sát, hỗ trợ HS (nếu cần)

Bước 3. Thảo luận, trao đổi, báo cáo
Lắng nghe kết quả báo cáo của HS














Bước 4. Phương án KTĐG
   Đánh giá kết quả hoạt động dựa trên kết quả báo cáo và quá trình thực hiện nhiệm vụ.
Điều chỉnh, bổ sung:
- Các quyền trong bảng phân quyền: đọc (Đ), sửa (S), bổ sung (BS), xóa (X), không được truy cập (K).
- Người quản trị CSDL cần cung cấp:
    + Bảng phân quyền truy cập cho hệ QT CSDL.
    + Phương tiện cho người dùng để hệ QT CSDL nhận biết đúng họ.
- Hướng dẫn minh họa thông qua bảng phân quyền truy cập (trang 102 SGK)
	Bước 1. Giao nhiệm vụ
   Im lặng, lắng nghe yêu cầu của GV









Bước 2. Thực hiện nhiệm vụ
   Nghiên cứu SGK, thảo luận nhóm để thực hiện yêu cầu của GV.
Bước 3. Thảo luận, trao đổi, báo cáo
- Bảng phân quyền là dữ liệu của CSDL, tuy nhiên nó được quản lí chặt chẽ, không giới thiệu công khai và chỉ có những người quản trị hệ thống mới có quyền truy cập. 
- Hệ thống nhận dạng người dùng thông qua tên và mật khẩu.
- Khi không có bảng phân quyền, CSDL sẽ bị cập nhật dữ liệu (thêm, sửa, xóa) bởi những người không có trách nhiệm.

Bước 4. Phương án KTĐG
Ghi nhận, phản biện kết quả kiểm tra đánh giá


Hoạt động 4. Củng cố kiến thức 
(1) Mục tiêu: Củng cố lại kiến thức vừa học 
(2) Phương pháp/kĩ thuật dạy học: Đàm thoại, vấn đáp.
(3) Hình thức tổ chức: Cá nhân, cặp đôi.
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu.
	Hoạt động của GV
	Hoạt động của HS

	Bước 1. Giao nhiệm vụ
Yêu cầu HS đọc SGK và thảo luận nhóm để trả lời các câu hỏi sau:
Câu 1: Phát biểu nào dưới đây không phải là bảo mật thông tin trong hệ CSDL?
A. Ngăn chặn các truy cập không được phép
B. Hạn chế tối đa các sai sót của người dùng
C. Đảm bảo thông tin không bị mất hoặc bị thay đổi ngoài ý muốn
D. Khống chế số người sử dụng CSDL 
Câu 2: Bảo mật CSDL:
A. Chỉ quan tâm bảo mật dữ liệu		
B. Chỉ quan tâm bảo mật chương trình xử lí dữ liệu
C. Quan tâm bảo mật cả dữ liệu và chương trình xử lí dữ liệu 
D. Chỉ là các giải pháp kĩ thuật phần mềm.
Câu 3: Chọn các phát biểu sai trong các phát biểu dưới đây?
A. Bảo mật hạn chế được thông tin không bị mất hoặc bị thay đổi ngoài ý muốn
B. Có thể thực hiện bảo mật bằng giải pháp phần cứng
C. Hiệu quả của bảo mật chỉ phụ thuộc vào hệ QTCSDL và chương trình ứng dụng
D. Hiệu quả bảo mật phụ thuộc rất nhiều vào các chủ trương, chính sách của chủ sở hữu thông tin và ý thức của người dùng.
Câu 4: Bảng phân quyền cho phép :
A. Phân các quyền truy cập đối với người dùng
B. Giúp người dùng xem được thông tin CSDL.
C. Giúp người quản lí xem được các đối tượng truy cập hệ thống.
D. Đếm được số lượng người truy cập hệ thống.
Câu 5: Người có chức năng phân quyền truy cập là:
A. Người dùng	
B.Người viết chương trình ứng dụng.
C. Người quản trị CSDL.
D. Lãnh đạo cơ quan.
Bước 2. Thực hiện nhiệm vụ
   Quan sát, hỗ trợ HS (nếu cần)


Bước 3. Thảo luận, trao đổi, báo cáo
Lắng nghe kết quả báo cáo của HS
Bước 4. Phương án KTĐG
   Đánh giá kết quả hoạt động dựa trên kết quả báo cáo và quá trình thực hiện nhiệm vụ.
	Bước 1. Giao nhiệm vụ
   Im lặng, lắng nghe yêu cầu của GV






























































Bước 2. Thực hiện nhiệm vụ
   Nghiên cứu SGK, thảo luận với bạn bên cạnh để thực hiện yêu cầu của GV.
Bước 3. Thảo luận, trao đổi, báo cáo
1D, 2C, 3C, 4A, 5C

Bước 4. Phương án KTĐG
Ghi nhận, phản biện kết quả kiểm tra đánh giá


IV. Dặn dò  và rút kinh nghiệm: (1’)
· Học bài cũ, chuẩn bị bài mới (mục 3, 4)
· Trả lời câu hỏi sau bài học.
	
	
	
	
	
	
	
	
	














 Tiết: 48
BÀI 13.  BẢO MẬT THÔNG TIN TRONG CÁC HỆ CƠ SỞ DỮ LIỆU (Tiết 2)
I. Mục tiêu: 
1. Kiến thức: Biết giải pháp bảo mật hệ thống: Mã hóa thông tin và nén dữ liệu; Lưu biên bản
2. Kĩ năng: Biết một số cách thông dụng bảo mật CSDL
3. Thái độ: Có ý thức và thái độ đúng đắn trong việc sử dụng và bảo mật CSDL
4. Định hướng hình thành năng lực: Hình thành năng lực bảo mật CSDL trong hệ thống CSDL sử dụng.
II. Chuẩn bị của giáo viên và học sinh:
	1. Chuẩn bị của giáo viên: 
	- Thiết bị dạy học: Máy tính, máy chiếu
- Học liệu: sách giáo khoa;  sách giáo viên;  Hướng dẫn thực hiện chuẩn kiến thức, kĩ năng môn Tin học THPT.	
2. Chuẩn bị của học sinh: Sách giáo khoa, sách bài tập, xem trước bài học (Tin học 10).
III. Tổ chức các hoạt động học tập: 
1. Ổn định lớp 
2. Kiểm tra bài cũ 
Hãy trình bày giải pháp bảo mật thông tin phân quyền truy cập và nhận dạng người dùng.
 Hôm nay chúng ta sẽ cùng nhau nghiên cứu thêm 2 giải pháp bảo mật thông tin trong hệ CSDL thường dùng, đó là Mã hóa thông tin và nén dữ liệu; Lưu biên bản.
3. Tiến trình bài học
Hoạt động 1: Tìm hiểu giải pháp bảo mật thông tin Mã hóa thông tin và nén dữ liệu 
(1) Mục tiêu: Biết giải pháp bảo mật thông tin Mã hóa thông tin và nén dữ liệu.
(2) Phương pháp/kĩ thuật dạy học: Đàm thoại, phát hiện-giải quyết vấn đề
(3) Hình thức tổ chức: Cá nhân, cặp đôi.
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu.
	Hoạt động của GV
	Hoạt động của HS

	Bước 1. Giao nhiệm vụ
Yêu cầu HS đọc SGK và trao đổi với bạn bên cạnh để trả lời 2 yêu cầu sau:
- Mã hóa thông tin là gì?
- Mã hóa thông tin bằng cách nén dữ liệu nhằm mục đích gì?
Bước 2. Thực hiện nhiệm vụ
   Quan sát, hỗ trợ HS (nếu cần)


Bước 3. Thảo luận, trao đổi, báo cáo
Lắng nghe kết quả báo cáo của HS









Bước 4. Phương án KTĐG
   Đánh giá kết quả hoạt động dựa trên kết quả báo cáo và quá trình thực hiện nhiệm vụ.
Điều chỉnh, bổ sung:
- Các bản sao dữ liệu thường được mã hóa và nén bởi các chương trình riêng.
-Một số thuật toán mã hóa như: chuyển kí tự thành số, chuyển số thành kí tự, cộng vào mã ASCII một hằng số, …
 Minh họa cụ thể
- Hướng dẫn HS đọc SGK
	Bước 1. Giao nhiệm vụ
   Im lặng, lắng nghe yêu cầu của GV





Bước 2. Thực hiện nhiệm vụ
   Nghiên cứu SGK, thảo luận với bạn bên cạnh để thực hiện yêu cầu của GV.
Bước 3. Thảo luận, trao đổi, báo cáo
- Mã hóa thông tin là biến đổi thông tin (gốc) thành các “bản sao dữ liệu”
- Mục đích của việc mã hóa thông tin bằng cách nén dữ liệu nhằm giảm khả năng rò rỉ (tăng cường tính bảo mật của dữ liệu) và  giảm dung lượng lưu trữ.
Bước 4. Phương án KTĐG
Ghi nhận, phản biện kết quả kiểm tra đánh giá


	
Hoạt động 2: Tìm hiểu giải pháp bảo mật thông tin Lưu biên bản (15’)
(1) Mục tiêu: Biết giải pháp bảo mật thông tin lưu biên bản.
(2) Phương pháp/kĩ thuật dạy học: Đàm thoại, vấn đáp
(3) Hình thức tổ chức: Cá nhân, cặp đôi
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu.
	Hoạt động của GV
	Hoạt động của HS

	Bước 1. Giao nhiệm vụ
Yêu cầu HS đọc SGK và trao đổi với bạn bên cạnh để trả lời 2 yêu cầu sau:
- Trong giải pháp này hệ thống sẽ lưu trữ những gì?
- Cho ví dụ thực tiễn về giải pháp này 
Bước 2. Thực hiện nhiệm vụ
   Quan sát, hỗ trợ HS (nếu cần)


Bước 3. Thảo luận, trao đổi, báo cáo
Lắng nghe kết quả báo cáo của HS
















Bước 4. Phương án KTĐG
   Đánh giá kết quả hoạt động dựa trên kết quả báo cáo và quá trình thực hiện nhiệm vụ.
Điều chỉnh, bổ sung:
- Biên bản hệ thống cung cấp thông tin cho phép đánh giá mức độ quan tâm của người dùng đối với hệ thống.
- Hệ thống rút tiền tự động: nếu nhập mật khẩu sai ba lần liên tiếp sẽ bị khóa thẻ. Ý nghĩa: tránh việc người sử dụng nhặt được thẻ rơi, dò mật khẩu rút tiền.
	Bước 1. Giao nhiệm vụ
   Im lặng, lắng nghe yêu cầu của GV






Bước 2. Thực hiện nhiệm vụ
   Nghiên cứu SGK, thảo luận với bạn bên cạnh để thực hiện yêu cầu của GV.
Bước 3. Thảo luận, trao đổi, báo cáo
- Biên bản hệ thống thông thường cho biết:
+ Số lần truy cập và hệ thống, vào từng thành phần của hệ thống, vào từng yêu cầu tra cứu, …
+ Thông tin về lần cập nhật cuối cùng: phép cập nhật, người cập nhật, thời điểm cập nhật, …
- VD: Hệ thống nạp tiền điện thoại di động: nếu nhập mã số trên card sai ba lần sẽ bị khóa. Ý nghĩa: tránh việc người dùng dò mã số card ngẫu nhiên để nạp tiền điện thoại.
Bước 4. Phương án KTĐG
Ghi nhận, phản biện kết quả kiểm tra đánh giá


Hoạt động 3. Củng cố kiến thức 
(1) Mục tiêu: Củng cố lại kiến thức vừa học 
(2) Phương pháp/kĩ thuật dạy học: Đàm thoại, vấn đáp.
(3) Hình thức tổ chức: Cá nhân, cặp đôi.
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu.
	Hoạt động của GV
	Hoạt động của HS

	Bước 1. Giao nhiệm vụ
Yêu cầu HS đọc SGK và thảo luận nhóm để trả lời các câu hỏi sau:
Câu 1: Các giải pháp cho việc bảo mật CSDL gồm có:
A. Phân quyền truy cập, nhận dạng người dùng, mã hoá thông tin và nén dữ liệu, lưu biên bản.
B. Phân quyền truy cập, nhận dạng người dùng, mã hoá thông tin và nén dữ liệu, chính sách và ý thức, lưu biên bản, cài đặt mật khẩu
C.Nhận dạng người dùng, mã hoá thông tin và nén dữ liệu, chính sách và ý thức, lưu biên bản.
D. Phân quyền truy cập, nhận dạng người dùng; mã hoá thông tin và nén dữ liệu; chính sách và ý thức; lưu biên bản.
Câu 2: Trong các phát biểu sau, phát biểu nào không phải là chức năng của biên bản hệ thống?
A. Lưu lại số lần truy cập vào hệ thống.	
B. Lưu lại thông tin của người truy cập vào hệ thống.
C. Lưu lại các yêu cầu tra cứu hệ thống.	
D. Nhận diện người dùng để cung cấp dữ liệu mà họ được phân quyền truy cập.
Câu 3: Phát biểu nào dưới đây sai khi nói về mã hoá thông tin?
A. Các thông tin quan trọng và nhạy cảm nên lưu trữ dưới dạng mã hoá.
B. Mã hoá thông tin để giảm khả năng rò rỉ thông tin.
C. Nén dữ liệu cũng góp phần tăng cường tính bảo mật của dữ liệu.	
D. Các thông tin sẽ được an toàn tuyệt đối sau khi đã được mã hoá.
Bước 2. Thực hiện nhiệm vụ
   Quan sát, hỗ trợ HS (nếu cần)
Bước 3. Thảo luận, trao đổi, báo cáo
Lắng nghe kết quả báo cáo của HS
Bước 4. Phương án KTĐG
   Đánh giá kết quả hoạt động dựa trên kết quả báo cáo và quá trình thực hiện nhiệm vụ.
Điều chỉnh, bổ sung:
Cần lưu ý là hiện nay các giải pháp cả phần cứng lẫn phần mềm chưa đảm bảo hệ thống được bảo vệ an toàn tuyệt đối.
	Bước 1. Giao nhiệm vụ
   Im lặng, lắng nghe yêu cầu của GV
































Bước 2. Thực hiện nhiệm vụ
   Nghiên cứu SGK, thảo luận với bạn bên cạnh để thực hiện yêu cầu của GV.
Bước 3. Thảo luận, trao đổi, báo cáo
1D, 2D, 3D

Bước 4. Phương án KTĐG
Ghi nhận, phản biện kết quả kiểm tra đánh giá


IV. Dặn dò  và rút kinh nghiệm
· Học bài cũ, chuẩn bị bài thực hành 11
· Trả lời câu hỏi sau bài học.
	
	
	
	
	
	
	
	
	

Tiết: 49 
BÀI TẬP VÀ THỰC HÀNH 11
BẢO MẬT CƠ SỞ DỮ LIỆU(Tiết 1)
I. Mục tiêu
a. Về kiến thức:
0.   Hiểu thêm khái niệm và tầm quan trọng của bảo mật CSDL;
b. Về kĩ năng
0.   Biết một số cách thông dụng bảo mật CSDL;
c. Về thái độ
· Có thái độ đúng đắn trong việc sử dụng và bảo mật CSDL.
II. Chuẩn bị của giáo viên và học sinh:
a. Chuẩn bị của giáo viên: 
·  Giáo án, Sách GK Tin 12, Sách GV Tin 12, bảng phụ, máy tính và phần mềm Access.
·  Bảng dữ liệu:
	
	Mat_hang
	Khach_hang
	Cong_ty
	Phieu_nhap
	Phieu_xuat

	Khách hàng
	Đ(K6)
	K
	K
	K
	K

	Thủ kho
	Đ(K6)
	Đ
	Đ
	Đ
	Đ

	Kế toán
	Đ
	Đ
	Đ
	Đ, B, X, S
	Đ, B, X, S

	Quản lý
	Đ, B, X, S
	Đ, B, X, S
	Đ, B, X, S
	Đ
	Đ


b. Chuẩn bị của học sinh: Sách GK tin 12, vở ghi.
III . Tiến trình bài dạy
1. Ổn định lớp:
2. Kiểm tra bài cũ: 
	Kết hợp trong giờ thực hành.
3. Nội dung bài mới.
Hoạt động 1: Tìm hiểu bài 1
1. Mục tiêu: Học sinh biết các yêu cầu của mỗi đối tượng người dùng đối với những thành phần của cơ sở dữ liệu.
1. Phương pháp/ Kỹ thuật: Đàm thoại, Khai thác mối quan hệ giữa thực tiễn với tin học.
1. Hình thức tổ chức hoạt động: Làm việc cá nhân, thảo luận nhóm.
1. Phương tiện dạy học: SGK, máy tính, bảng phụ.


1. Sản phẩm: Nêu chức năng chương trình kinh doanh của một cửa hàng điện tử. 
Nội dung hoạt động
	Hoạt động của giáo viên 
	Hoạt động của học sinh

	 - Giới thiệu nội dung và yêu cầu của bài 1.
- Chia lớp làm 4 nhóm tương ứng với 4 loại đối tượng và yêu cầu mỗi nhóm tìm các chức năng của chương trình?
- Gọi HS đại diện từng nhóm đọc chức năng mà nhóm mình yêu cầu đối với chương trình quản lí.














- Cho HS các nhóm khác bổ sung.

- Giáo viên bổ sung để thống nhất. 
	- Theo dõi nội dung yêu cầu của giáo viên.


- Nhóm khách hàng:
+ Xem các thông tin về các mặt hàng có trong kho.

- Nhóm thủ kho:
+ Xem các thông tin về các mặt hàng có trong kho.
+ Nhập hàng vào kho.
+Xuất hàng.


- Nhóm kế toán:
+ Thống kê tình hình thu chi của cửa hàng.


- Nhóm quản lý của hàng:
+ Tất cả các chức năng của ba nhóm trên.


- Theo dõi gv và các bạn để nhận biết.




Hoạt động 2: Tìm hiểu bài 2.
1. Mục tiêu: Học sinh biết các quyền mà mỗi đối tượng sử dụng chương trình sẽ được cấp.
2. Phương pháp/ Kỹ thuật: Đàm thoại, Khai thác mối quan hệ giữa thực tiễn với tin học.
3. Hình thức tổ chức hoạt động: Làm việc cá nhân, thảo luận nhóm.
4. Phương tiện dạy học: SGK, máy tính, bảng phụ, máy chiếu.
5. Sản phẩm: kết luận được phân quyền. 
Nội dung hoạt động
	Hoạt động của giáo viên 
	Hoạt động của học sinh

	 - Giới thiệu nội dung và yêu cầu của bài 2.
- Chia lớp làm 4 nhóm tương ứng với 4 loại đối tượng và yêu cầu học sinh trong các nhóm thảo luận để xác định các quyền của nhóm mình khi truy cập đến cơ sở dữ liệu.
- Gọi HS đại diện từng nhóm nêu ra trước lớp và giải thích lý do lựa chọn.




- Giới thiệu bảng phân quyền đã điền sẳn các quyền.

- Yêu cầu HS các nhóm thảo luận để xác định bảng phân quyền nêu trong bài đã phù hợp chưa? Điểm nào phù hợp, điểm nào chưa? giải thích? Đề nghị sửa đổi?

- Yêu cầu HS đại diện nhóm lên bảng điền, gọi thành viên trong nhóm giải thích vì sao lại chọn quyền đó.
- Yêu cầu HS các nhóm khác bổ sung.
- Định hướng để HS đi đến thống nhất. 
	- Theo dõi nội dung để định hướng nhiệm vụ.

- Thảo luận theo nhóm để đưa ra các quyền.


- Nhóm khách hàng: chỉ đọc

- Nhóm thủ kho: chỉ đọc

- Nhóm kế toán: chỉ đọc

- Nhóm quản lý của hàng: đọc, bổ sung, sửa, xóa.


- Quan sát bảng phân quyền của GV.

- Thảo luận để phân quyền cho từng đối tượng trên bảng dữ liệu.





- Điền lên bảng và giải thích lí do.




- Phản biện và bổ sung.



Hoạt động : Tìm hiểu bài 3.
1. Mục tiêu: Xác định quyền truy cập.
2. Phương pháp/ Kỹ thuật: mảnh ghép, vấn đáp.
3. Hình thức tổ chức hoạt động: Làm việc cá nhân, thảo luận nhóm.
4. Phương tiện dạy học: SGK, máy tính, bảng phụ, máy chiếu.
5. Sản phẩm: trả lời câu hỏi  vì sao phải phân quyền truy cập.
Nội dung hoạt động
	Hoạt động của giáo viên 
	Hoạt động của học sinh

	 - Giới thiệu nội dung và yêu cầu của bài 3.
?Theo em, vì sao người ta làm như vâỵ.

- Yêu cầu HS các nhóm thảo luận?





- Giải quyết thắc mắc của HS và cùng thảo luận.
	- Theo dõi nội dung để định hướng nhiệm vụ.



- HS vừa quan sát vừa thảo luận

- HS quan sát sách giáo khoa, trình bày các thắc mắc theo từng nhóm của mình.


- Đại diện từng nhóm trình bày trước lớp.






IV. Củng cố - Dặn dò.
- Các em xem lại bài và chuẩn bị nội dung bài tập 2 và bài tập 3 trang 106, 107
V. Hướng dẫn học sinh tự học ở nhà.




Tiết: 50 
 
BÀI TẬP VÀ THỰC HÀNH 11
BẢO MẬT CƠ SỞ DỮ LIỆU(Tiết 2)
I. Mục tiêu
a. Về kiến thức:
0.   Hiểu thêm khái niệm và tầm quan trọng của bảo mật CSDL;
b. Về kĩ năng
0.   Biết một số cách thông dụng bảo mật CSDL;
c. Về thái độ
· Có thái độ đúng đắn trong việc sử dụng và bảo mật CSDL.
II. Chuẩn bị của giáo viên và học sinh:
a. Chuẩn bị của giáo viên: 
·  Giáo án, Sách GK Tin 12, Sách GV Tin 12, bảng phụ, máy tính và phần mềm Access.
·  Bảng dữ liệu:
	
	Mat_hang
	Khach_hang
	Cong_ty
	Phieu_nhap
	Phieu_xuat

	Khách hàng
	Đ(K6)
	K
	K
	K
	K

	Thủ kho
	Đ(K6)
	Đ
	Đ
	Đ
	Đ

	Kế toán
	Đ
	Đ
	Đ
	Đ, B, X, S
	Đ, B, X, S

	Quản lý
	Đ, B, X, S
	Đ, B, X, S
	Đ, B, X, S
	Đ
	Đ


b. Chuẩn bị của học sinh: Sách GK tin 12, vở ghi.
III . Tiến trình bài dạy
1. Ổn định lớp:
2. Kiểm tra bài cũ: 
	Kết hợp trong giờ thực hành.
3. Nội dung bài mới.
Hoạt động 1: Tìm hiểu bài 2.
1. Mục tiêu: Học sinh biết các quyền mà mỗi đối tượng sử dụng chương trình sẽ được cấp.
2. Phương pháp/ Kỹ thuật: Đàm thoại, Khai thác mối quan hệ giữa thực tiễn với tin học.
3. Hình thức tổ chức hoạt động: Làm việc cá nhân, thảo luận nhóm.
4. Phương tiện dạy học: SGK, máy tính, bảng phụ, máy chiếu.
5. Sản phẩm: kết luận được phân quyền. 

Nội dung hoạt động
	Hoạt động của giáo viên 
	Hoạt động của học sinh

	 - Giới thiệu nội dung và yêu cầu của bài 2.
- Chia lớp làm 4 nhóm tương ứng với 4 loại đối tượng và yêu cầu học sinh trong các nhóm thảo luận để xác định các quyền của nhóm mình khi truy cập đến cơ sở dữ liệu.
- Gọi HS đại diện từng nhóm nêu ra trước lớp và giải thích lý do lựa chọn.




- Giới thiệu bảng phân quyền đã điền sẳn các quyền.

- Yêu cầu HS các nhóm thảo luận để xác định bảng phân quyền nêu trong bài đã phù hợp chưa? Điểm nào phù hợp, điểm nào chưa? giải thích? Đề nghị sửa đổi?

- Yêu cầu HS đại diện nhóm lên bảng điền, gọi thành viên trong nhóm giải thích vì sao lại chọn quyền đó.
- Yêu cầu HS các nhóm khác bổ sung.
- Định hướng để HS đi đến thống nhất. 
	- Theo dõi nội dung để định hướng nhiệm vụ.

- Thảo luận theo nhóm để đưa ra các quyền.


- Nhóm khách hàng: chỉ đọc

- Nhóm thủ kho: chỉ đọc

- Nhóm kế toán: chỉ đọc

- Nhóm quản lý của hàng: đọc, bổ sung, sửa, xóa.


- Quan sát bảng phân quyền của GV.

- Thảo luận để phân quyền cho từng đối tượng trên bảng dữ liệu.

- Điền lên bảng và giải thích lí do.

- Phản biện và bổ sung.



Hoạt động 2 : Tìm hiểu bài 3.
1. Mục tiêu: Xác định quyền truy cập.
2. Phương pháp/ Kỹ thuật: mảnh ghép, vấn đáp.
3. Hình thức tổ chức hoạt động: Làm việc cá nhân, thảo luận nhóm.
4. Phương tiện dạy học: SGK, máy tính, bảng phụ, máy chiếu.
5. Sản phẩm: trả lời câu hỏi  vì sao phải phân quyền truy cập.
Nội dung hoạt động
	Hoạt động của giáo viên 
	Hoạt động của học sinh

	 - Giới thiệu nội dung và yêu cầu của bài 3.
?Theo em, vì sao người ta làm như vâỵ.

- Yêu cầu HS các nhóm thảo luận?





- Giải quyết thắc mắc của HS và cùng thảo luận.
	- Theo dõi nội dung để định hướng nhiệm vụ.



- HS vừa quan sát vừa thảo luận

- HS quan sát sách giáo khoa, trình bày các thắc mắc theo từng nhóm của mình.


- Đại diện từng nhóm trình bày trước lớp.






IV. Củng cố - Dặn dò.
- Các em xem lại bài và chuẩn bị nội dung ôn tập để KTHK
· V. Hướng dẫn học sinh tự học ở nhà.



Tiết: 51
ÔN TẬP

	I. MỤC TIÊU
Sau bài học, học sinh đạt được
1. Kiến thức
- Cơ sở dữ liệu quan hệ;
- Các thao tác trên cơ sở dữ liệu quan hệ.
- Giải pháp bảo mật và an toàn thông tin.
2. Kỹ năng
Vận dụng kiến thức đã học để thực hiện:
- Các bước cập nhật dữ liệu;
- Các bước khai thác dữ liệu trên CSDL QH.
- Các giải pháp bảo mật và an toàn thông tin.
3. Thái độ
1. Ham thích môn học, có tính kỷ luật cao
1. Tự giác tích cực trong học tập
4. Định hướng hình thành năng lực: Năng lực tự học, năng lực giải quyết vấn đề, năng lực giao tiếp.
	II. CHUẨN BỊ CỦA GIÁO VIÊN VÀ HỌC SINH
1. Chuẩn bị của giáo viên
- Thiết bị dạy học: Máy tính, máy chiếu.
- Học liệu: SGK, SGV, CSDL mẫu
2. Chuẩn bị của học sinh
- Chuẩn bị các nội dung liên quan đến bài học theo sự hướng dẫn của giáo viên như chuẩn bị tài liệu, TBDH, SGK, vở ghi chép, ...
- Sưu tầm tranh ảnh, tư liệu, …
	III. TỔ CHỨC CÁC HOẠT ĐỘNG HỌC TẬP
1. Ổn định lớp
2. Kiểm tra bài cũ
3. Tiến trình bài học
A. KHỞI ĐỘNG
B. HÌNH THÀNH KIẾN THỨC MỚI
Hoạt động 1: Nhắc lại kiến thức đã học
(1) Mục tiêu: Học sinh nắm chắc tất cả các kiến thức cơ bản đã được học.
(2) Phương pháp/Kĩ thuật: Gợi mở, đàm thoại
(3) Hình thức tổ chức hoạt động: Cá nhân
(4) Phương tiện dạy học: Máy tính, máy chiếu
(5) Sản phẩm: HS trả lời đúng các kiến thức cơ bản đã học
Nội dung hoạt động
	HOẠT ĐỘNG CỦA GV 
	HOẠT ĐỘNG CỦA HS

	- Đặt câu hỏi để giúp HS nhớ lại kiến thức đã được học
- Kể tên các công việc thường gặp khi xử lí thông tin của một tổ chức.
- Trình bày khái niệm: CSDL; hệ quản trị CSDL, hệ CSDL






- Kể tên các mức thể hiện của CSDL.
- Kể tên các yêu cầu cơ bản của hệ CSDL.

- Có những vai trò nào của con người khi làm việc với hệ CSDL.
- Nêu các bước khi xây dựng CSDL.
- Trình bày khái niệm mô hình dữ liệu, CSDL quan hệ, hệ quản trị CSDL quan hệ.





- Trình bày khái niệm về khoá trong cơ sở dữ liệu quan hệ.
- Thế nào là hệ CSDL tập trung, hệ cơ sở dữ liệu phân tán.




- Có những giải pháp bảo mật thông tin nào? Theo em giải pháp nào cần quan tâm nhất?
	- Theo dõi câu hỏi của GV và suy nghĩ trả lời:
+ Tạo lập hồ sơ
+ Cập nhật hồ sơ
+ Khai thác hồ sơ
- Các khái niệm:
+ CSDL là một tập hợp các DL về 1 tổ chức nào đó được lưu trữ trên các thiết bị nhớ để đáp ứng nhu cầu khai thác thông tin của nhiều người dùng.
+ Phền mềm cung cấp môi trường để tạo lập, lưu trữ và khai thác thông tin của CSDL được gọi là hệ quản trị CSDL.
+ Hệ CSDL là 1 CSDL cùng hệ quản trị CSDL quản trị và khai thác CSDL đó.
- Các mức thể hiện
+ Mức vật lí; Mức khái niện;  Mức khung nhìn
- Các yêu cầu cơ bản:
+ Tính cấu trúc; Tính toàn vẹn; tính nhất quán; tính an toàn và bảo mật; tính độc lập; không dư thừa dữ liệu
- Ba vai trò:
+ Người quản trị CSDL; người lập trình ứng dụng; người dùng
- Có thể chia thành 3 bước
+ Khảo sát; thiết kế; kiểm thử
- Các khái niệm:
+ Mô hình DL là một tập khái niệm dùng để mô tả cấu trúc DL, các thao tác DL, các ràng buộc DL của một CSDL
+ CSDL được XD dựa trên mô hình DL quan hệ được gọi là CSDL quan hệ.
+ Hệ quản trị dùng để tạo lập, cập nhật và khai thác CSDL quan hệ gọi lag hệ QTCSDL quan hệ.
- Khoá của một bảng là một tập ít nhất các thuộc tính sao cho không có hai bộ nào trên bảng có giá trị bằng nhau trên các thuộc tính đó.
- Kiến trúc tập trung: toàn bộ DL được lưu trữ tập trung tại 1 máy hoặc một dàn máy. Người dùng có thể truy cập vào CSDL thông qua các phương tiện truyềnthông dữ liệu.
- Kiến trúc phân tán: Dữ liệu đặt ở nhiều nơi. Người dùng có thể truy cập dữ liệu từ xa.
- Các giải pháp bảo mật: 
+ Xây dựng các chính sách và ý thức
+ Phân quyền truy cập
+ Nhận dạng người dùng
+ mã hoá thông tin và nén dữ liệu
+ Lưu biên bản hệ thống


C. LUYỆN TẬP VÀ VẬN DỤNG
Hoạt động 2: Luyện tập và vận dụng
(1) Mục tiêu: Học sinh nắm chắc tất cả các kiến thức cơ bản đã được học.
(2) Phương pháp/Kĩ thuật: Gợi mở, đàm thoại
(3) Hình thức tổ chức hoạt động: Cá nhân
(4) Phương tiện dạy học: Máy tính, máy chiếu
(5) Sản phẩm: HS trả lời đúng các kiến thức cơ bản đã học
Nội dung hoạt động
PHẦN TRẮC NGHIỆM
BÀI 10. CƠ SỠ DỮ LIỆU QUAN HỆ
Câu 1: Mô hình phổ biến để xây dựng CSDL quan hệ là:
A. Mô hình phân cấp 		B. Mô hình dữ liệu quan hệ
C. Mô hình hướng đối tượng 	D. Mô hình cơ sở quan hệ
Câu 2: Các khái niệm dùng để mô tả các yếu tố nào sẽ tạo thành mô hình dữ liệu quan hệ?
A. Cấu trúc dữ liệu 				B. Các ràng buộc dữ liệu
C. Các thao tác, phép toán trên dữ liệu 	D. Tất cả câu trên
Câu 3: Trong mô hình quan hệ, về mặt cấu trúc thì dữ liệu được thể hiện trong các:
A. Cột (Field) 		B. Hàng (Record) 	C. Bảng (Table) 	D. Báo cáo (Report)
Câu 4: Thao tác trên dữ liệu có thể là:
A. Sửa bản ghi 	B. Thêm bản ghi 	C. Xoá bản ghi 	D. Tất cả đáp án trên
Câu 5: Phát biểu nào về hệ QTCSDL quan hệ là đúng?
A. Phần mềm dùng để xây dựng các CSDL quan hệ
B. Phần mềm dùng để tạo lập, cập nhật và khai thác CSDL quan hệ
C. Phần mềm Microsoft Access
D. Phần mềm để giải các bài toán quản lí có chứa các quan hệ giữa các dữ liệu
Câu 6: Thuật ngữ “quan hệ” dùng trong hệ CSDL quan hệ là để chỉ đối tượng:
A. Kiểu dữ liệu của một thuộc tính 	B. Bảng 	C. Hàng 	D. Cột
Câu 7: Thuật ngữ “bộ” dùng trong hệ CSDL quan hệ là để chỉ đối tượng:
A. Kiểu dữ liệu của một thuộc tính 	B. Bảng 	C. Hàng 	D. Cột
Câu 8: Thuật ngữ “thuộc tính” dùng trong hệ CSDL quan hệ là để chỉ đối tượng:
A. Kiểu dữ liệu của một thuộc tính 	B. Bảng 	C. Hàng 	D. Cột
Câu 9: Thuật ngữ “miền” dùng trong hệ CSDL quan hệ là để chỉ đối tượng:
A. Kiểu dữ liệu của một thuộc tính 	B. Bảng 	C. Hàng 	D. Cột
Câu 10: Giả sử một bảng có 2 trường SOBH (số bảo hiểm) và HOTEN (họ tên) thì nên chọn trường SOBH làm khoá chính hơn vì:
A. Trường SOBH là duy nhất, trong khi đó trường HOTEN không phải là duy nhất
B. Trường SOBH là kiểu số, trong khi đó trường HOTEN không phải là kiểu số
C. Trường SOBH đứng trước trường HOTEN
D. Trường SOBH là trường ngắn hơn
Câu 11. Hai bảng trong một CSDL quan hệ liên kết với nhau thông qua:
A. Địa chỉ của các bảng 	B. Thuộc tính khóa		C. Tên trường 	
D. Thuộc tính của các trường được chọn (không nhất thiết phải là khóa)
Câu 12: Cho các bảng sau:
- DanhMucSach(MaSach, TenSach, MaLoai)
- LoaiSach(MaLoai, LoaiSach)
- HoaDon(MaSach, SoLuong, DonGia)
Để biết giá của một quyển sách thì cần những bảng nào?
A. HoaDon 				B. DanhMucSach, HoaDon 	
C. DanhMucSach, LoaiSach 	D. HoaDon, LoaiSach
 BÀI 11. CÁC THAO TÁC VỚI CSDL QUAN HỆ
 Câu 1: Việc đầu tiên để tạo lập một CSDL quan hệ là:
A. Tạo ra một hay nhiều biểu mẫu 	B. Tạo ra một hay nhiều báo cáo
C. Tạo ra một hay nhiều mẫu hỏi 	D. Tạo ra một hay nhiều bảng
Câu 2: Thao tác khai báo cấu trúc bảng bao gồm:
A. Khai báo kích thước của trường 	B. Tạo liên kết giữa các bảng
C. Đặt tên các trường và chỉ định kiểu dữ liệu cho mỗi trường 	D. Câu A và C đúng
Câu 3: Thao tác nào sau đây không thuộc loại tạo lập CSDL quan hệ?
A. Tạo cấu trúc bảng 			B. Chọn khoá chính
C. Ðặt tên bảng và lưu cấu trúc bảng 	D. Nhập dữ liệu ban đầu
Câu 4: Trong quá trình tạo cấu trúc của một bảng, khi tạo một trường, việc nào sau đây không nhất thiết phải thực hiện?
A. Đặt tên, các tên của các trường cần phân biệt 	B. Chọn kiểu dữ liệu
C. Đặt kích thước 						D. Mô tả nội dung
Câu 5: Cho các thao tác sau:
B1: Tạo bảng B2: Đặt tên và lưu cấu trúc B3: Chọn khóa chính cho bảng B4: Tạo liên kết
Khi tạo lập CSDL quan hệ ta thực hiện lần lượt các bước sau:
A. B1-B3-B4-B2 		B. B2-B1-B3-B4 		C. B1-B3-B2-B4 	D. B1-B2-B3-B4
Câu 6: Thao tác nào sau đây không phải là thao tác cập nhật dữ liệu?
A. Nhập dữ liệu ban đầu 	B. Sửa những dữ liệu chưa phù hợp
C. Thêm bản ghi 		D. Sao chép CSDL thành bản sao dự phòng
Câu 7: Chỉnh sửa dữ liệu là:
A. Xoá một số quan hệ 		B. Xoá giá trị của một vài thuộc tính của một bộ
C. Thay đổi các giá trị của một vài thuộc tính của một bộ D. Xoá một số thuộc tính
Câu 8: Xoá bản ghi là:
A. Xoá một hoặc một số quan hệ 		B. Xoá một hoặc một số cơ sở dữ liệu
C. Xoá một hoặc một số bộ của bảng 	D. Xoá một hoặc một số thuộc tính của bảng
Câu 9: Thao tác nào sau đây không là khai thác CSDL quan hệ?
A. Sắp xếp các bản ghi 		B. Thêm bản ghi mới
C. Kết xuất báo cáo 			D. Xem dữ liệu
Câu 10: Khai thác CSDL quan hệ có thể là:
A. Tạo bảng, chỉ định khóa chính, tạo liên kết 
B. Đặt tên trường, chọn kiểu dữ liệu, định tính chất trường 
C. Thêm, sửa, xóa bản ghi 		D. Sắp xếp, truy vấn, xem dữ liệu, kết xuất báo cáo 
 
BÀI 13: BẢO MẬT THÔNG TIN TRONG CÁC HỆ CSDL
 
Câu 1: Phát biểu nào dưới đây không phải là bảo mật thông tin trong hệ CSDL?
A. Ngăn chặn các truy cập không được phép 	
B. Hạn chế tối đa các sai sót của người dùng
C. Đảm bảo thông tin không bị mất hoặc bị thay đổi ngoài ý muốn
D. Khống chế số người sử dụng CSDL
Câu 2: Các giải pháp cho việc bảo mật CSDL gồm có:
A. Phân quyền truy cập, nhận dạng người dùng, mã hoá thông tin và nén dữ liệu, lưu biên bản.
B. Phân quyền truy cập, nhận dạng người dùng, mã hoá thông tin và nén dữ liệu, chính sách và ý thức, lưu biên bản, cài đặt mật khẩu
C. Nhận dạng người dùng, mã hoá thông tin và nén dữ liệu, chính sách và ý thức, lưu biên bản.
D. Phân quyền truy cập, nhận dạng người dùng; mã hoá thông tin và nén dữ liệu; chính sách và ý thức; lưu biên bản.
Câu 3: Bảo mật CSDL:
A. Chỉ quan tâm bảo mật dữ liệu 	
B. Chỉ quan tâm bảo mật chương trình xử lí dữ liệu
C. Quan tâm bảo mật cả dữ liệu và chương trình xử lí dữ liệu 
D. Chỉ là các giải pháp kĩ thuật phần mềm.
Câu 4: Chọn các phát biểu sai trong các phát biểu dưới đây?
A. Bảo mật hạn chế được thông tin không bị mất hoặc bị thay đổi ngoài ý muốn
B. Có thể thực hiện bảo mật bằng giải pháp phần cứng
C. Hiệu quả của bảo mật chỉ phụ thuộc vào hệ QTCSDL và chương trình ứng dụng
D. Hiệu quả bảo mật phụ thuộc rất nhiều vào các chủ trương, chính sách của chủ sở hữu thông tin và ý thức của người dùng.
Câu 5: Bảng phân quyền cho phép:
A. Phân các quyền truy cập đối với người dùng 
B. Giúp người dùng xem được thông tin CSDL.
C. Giúp người quản lí xem được các đối tượng truy cập hệ thống.
D. Đếm được số lượng người truy cập hệ thống.
Câu 6: Người có chức năng phân quyền truy cập là:
A. Người dùng 			B. Người viết chương trình ứng dụng.
C. Người quản trị CSDL. 		D. Lãnh đạo cơ quan.
Câu 7: Trong một trường THPT có xây dựng một CSDL quản lý điểm Học Sinh. Người Quản trị CSDL có phân quyền truy cập cho các đối tượng truy cập vào CSDL. Theo em cách phân quyền nào dưới đây hợp lý: 
A. HS: Xem; GVBM: Xem, Bổ sung; BGH: Xem, sửa, xoá. 
B. HS: Xem; GVBM: Xem, Bổ sung, sửa, xóa; BGH: Xem, Bổ sung.
C. HS: Xem; GVBM: Xem, Bổ sung, sửa, xoá; BGH: Xem. 
D. HS: Xem, Xoá; GVBM: Xem, Bổ sung, sửa, xoá; BGH: Xem, Bổ sung, sửa, xoá.
Câu 8: Câu nào sai trong các câu dưới đây khi nói về chức năng lưu biên bản hệ thống?
A. Cho biết số lần truy cập vào hệ thống, vào từng thành phần của hệ thống, vào từng yêu cầu tra cứu,…
B. Cho thông tin về một số lần cập nhật cuối cùng
C. Lưu lại nội dung cập nhật, người thực hiện, thời điểm cập nhật
D. Lưu lại các thông tin cá nhân của người cập nhật
Câu 9: Để nâng cao hiệu quả của việc bảo mật, ta cần phải:
A.Thường xuyên sao chép dữ liệu 	B. Thường xuyên nâng cấp phần cứng, phần mềm 
C.Thường xuyên thay đổi các tham số của hệ thống bảo vệ
D. Nhận dạng người dùng bằng mã hóa.

PHẦN TỰ LUẬN
1. Hãy nêu các giải pháp bảo mật chủ yếu.
2. Với vị trí người dùng, em có thể làm gì để bảo vệ hệ thống khi khai thác CSDL?
3. Biên bản hệ thống dùng để làm gì?
4. Cho ví dụ để giải thích lý do cần phải thường xuyên thay đổi tham số của hệ thống bảo vệ
5.  Nêu khái niệm mô hình quan hệ, CSDL quan hệ.
6. Phân biệt các cách xem dữ liệu.
7. Nêu các bước tạo lập csdl quan hệ.
8. Cho biết nguyên lý của một giải pháp bảo mật thông tin. Lấy ví dụ minh họa.
D. TÌM TÒI, MỞ RỘNG
(1) Mục tiêu: Giúp những học sinh có nhu cầu mở rộng kiến thức và tương tác với cộng đồng.
(2) Phương pháp/kĩ thuật: Phát hiện và giải quyết vấn đề.
(3) Hình thức tổ chức hoạt động: Ngoài lớp học.
(4) Phương tiện dạy học: SGK, máy tính, máy chiếu.
(5) Kết quả: Học sinh mở rộng các kiến thức của mình thông qua các bài toán trong thực tế.
Nội dung hoạt động
Tìm thêm một số ví dụ về tệp trong thực tế;
IV. HƯỚNG DẪN HỌC Ở NHÀ 
- Ôn lại bài học hôm nay;
- Chuẩn bị cho bài kiểm tra học kỳ II.
 

Tiết: 52
KIỂM TRA HỌC KỲ II

	I. MỤC TIÊU
Sau bài học, học sinh đạt được
1. Kiến thức
- Cơ sở dữ liệu quan hệ;
- Các thao tác trên cơ sở dữ liệu quan hệ.
- Giải pháp bảo mật và an toàn thông tin.
2. Kỹ năng
Vận dụng kiến thức đã học để thực hiện:
- Các bước cập nhật dữ liệu;
- Các bước khai thác dữ liệu trên CSDL QH.
- Các giải pháp bảo mật và an toàn thông tin.
3. Thái độ
1. Ham thích môn học, có tính kỷ luật cao
1. Cẩn thận nghiêm túc trong học tập
4. Định hướng hình thành năng lực: Năng lực giải quyết vấn đề, năng lực sáng tạo.
	II. CHUẨN BỊ CỦA GIÁO VIÊN VÀ HỌC SINH
1. Chuẩn bị của giáo viên
- Thiết bị dạy học: Máy tính, máy chiếu.
- Học liệu: SGK, SGV.
2. Chuẩn bị của học sinh
- Chuẩn bị các nội dung liên quan đến bài học theo sự hướng dẫn của giáo viên như chuẩn bị tài liệu, TBDH, SGK, vở ghi chép, ...
- Sưu tầm tranh ảnh, tư liệu, …
	III. TỔ CHỨC CÁC HOẠT ĐỘNG HỌC TẬP
1. Ổn định lớp
2. Kiểm tra bài cũ
3. Tiến trình bài học
A. MA TRẬ ĐỀ KIỂM TRA
	           Mức độ
 
Nội dung
chủ đề
	Nhận biết
	Thông hiểu
	Vận dụng
thấp
	Vận dụng độ cao
	Số câu
Tổng điểm
Tỷ lệ

	Cơ sở dữ liệu quan hệ
	
	 
	 
	 
	 

	Số câu 
Số điểm      
Tỉ lệ %
	Câu: 1, 2, 13
2,5

	 
	 Câu 12
0,25

	 
	Số câu: 4
2,75
 27,5%

	Các thao tác cơ bản trên CSDL QH
	 
	
	
	 
	

	Số câu 
Số điểm    
 Tỉ lệ %
	 Câu: 3, 4
 0,5
	Câu: 5, 6, 14
1,5
	Câu: 7, 15
1,75
	 
	Số câu: 7
3,75
 37,5%

	Bảo mật thông tin trong các hệ CSDL
	
	
	
	 
	 

	Số câu 
Số điểm     
 Tỉ lệ %
	 Câu: 8
0,25
	 Câu: 9, 10, 11
 0,75
	
	Câu: 16 
 2,5
	Số câu: 5
 3,5
 35%

	Tổng số câu
Tổng số điểm
Tỉ lệ %
	Số câu 6
  3,25
 32,5%
	Số câu 6
  2,25
 22,5%
	Số câu 3
  2,0
 20%
	Số câu 1
  2,5
 25%
	Số câu 16
 10,0
100%


B. ĐỀ KIỂM TRA
I. TRẮC NGHIỆM (3 điểm)
Câu 1: Mô hình phổ biến để xây dựng CSDL quan hệ là:
A. Mô hình dữ liệu quan hệ 	B. Mô hình phân cấp 		
C. Mô hình hướng đối tượng 	D. Mô hình cơ sở quan hệ
Câu 2: Thuật ngữ “quan hệ” dùng trong hệ CSDL quan hệ là để chỉ đối tượng:
A. Kiểu dữ liệu của một thuộc tính 	B. Bảng 	C. Hàng 	D. Cột
Câu 3: Việc đầu tiên để tạo lập một CSDL quan hệ là:
A. Tạo ra một hay nhiều biểu mẫu 	B. Tạo ra một hay nhiều báo cáo
C. Tạo ra một hay nhiều mẫu hỏi 		D. Tạo ra một hay nhiều bảng
Câu 4: Trong quá trình tạo cấu trúc của một bảng, khi tạo một trường, việc nào sau đây không nhất thiết phải thực hiện?
A. Đặt tên, các tên của các trường cần phân biệt 	B. Đặt kích thước 			
C. Mô tả nội dung			D. Chọn kiểu dữ liệu
Câu 5: Thao tác nào sau đây không phải là thao tác cập nhật dữ liệu?
A. Nhập dữ liệu ban đầu 	B. Sửa những dữ liệu chưa phù hợp
C. Thêm bản ghi 		D. Sao chép CSDL thành bản sao dự phòng
Câu 6: Chỉnh sửa dữ liệu là:
A. Xoá một số quan hệ 		B. Xoá giá trị của một vài thuộc tính của một bộ
C. Thay đổi các giá trị của một vài thuộc tính của một bộ 		D. Xoá một số thuộc tính
Câu 7: Khai thác CSDL quan hệ có thể là:
A. Tạo bảng, chỉ định khóa chính, tạo liên kết 
B. Đặt tên trường, chọn kiểu dữ liệu, định tính chất trường 
C. Thêm, sửa, xóa bản ghi 		D. Sắp xếp, truy vấn, xem dữ liệu, kết xuất báo cáo 
Câu 8: Phát biểu nào dưới đây không phải là bảo mật thông tin trong hệ CSDL?
A. Khống chế số người sử dụng CSDL 	
B. Hạn chế tối đa các sai sót của người dùng
C. Đảm bảo thông tin không bị mất hoặc bị thay đổi ngoài ý muốn
D. Ngăn chặn các truy cập không được phép
Câu 9: Các giải pháp cho việc bảo mật CSDL gồm có:
A. Phân quyền truy cập, nhận dạng người dùng, mã hoá thông tin và nén dữ liệu, lưu biên bản.
B. Phân quyền truy cập, nhận dạng người dùng, mã hoá thông tin và nén dữ liệu, chính sách và ý thức, lưu biên bản, cài đặt mật khẩu
C. Nhận dạng người dùng, mã hoá thông tin và nén dữ liệu, chính sách và ý thức, lưu biên bản.
D. Phân quyền truy cập, nhận dạng người dùng; mã hoá thông tin và nén dữ liệu; chính sách và ý thức; lưu biên bản.
Câu 10: Chọn các phát biểu sai trong các phát biểu dưới đây?
A. Bảo mật hạn chế được thông tin không bị mất hoặc bị thay đổi ngoài ý muốn
B. Có thể thực hiện bảo mật bằng giải pháp phần cứng
C. Hiệu quả của bảo mật chỉ phụ thuộc vào hệ QTCSDL và chương trình ứng dụng
D. Hiệu quả bảo mật phụ thuộc rất nhiều vào các chủ trương, chính sách của chủ sở hữu thông tin và ý thức của người dùng.
Câu 11: Để nâng cao hiệu quả của việc bảo mật, ta cần phải:
A.Thường xuyên sao chép dữ liệu 	B. Thường xuyên nâng cấp phần cứng, phần mềm 
C.Thường xuyên thay đổi các tham số của hệ thống bảo vệ
D. Nhận dạng người dùng bằng mã hóa.
Câu 12:  Trong các mô hình dữ liệu được mô tả sau đây, mô hình nào là mô hình dữ liệu quan hệ?
A  Dữ liệu được biểu diễn dưới dạng các bảng gồm các bản ghi. Mỗi bản ghi có cùng các thuộc tính là một hàng của bảng. Giữa các bảng có liên kết.	
B  Các dữ liệu và thao tác trên dữ liệu được gói trong một cấu trúc chung.	
C  Một bản ghi bất kì có thể được kết nối với một số bất kì các bản ghi khác.	
D  Các bản ghi được sắp xếp theo cấu trúc từ trên xuống theo dạng cây.
II. TỰ LUẬN (7 điểm)
Câu 13. (2.0 điểm) Nêu khái niệm mô hình quan hệ, CSDL quan hệ.
Câu 14. (1.0 điểm) Phân biệt các cách xem dữ liệu.
Câu 15. (1.5 điểm)  Nêu các bước tạo lập csdl quan hệ.
Câu 16. (2.5 điểm) Cho biết nguyên lý của một giải pháp bảo mật thông tin. Lấy ví dụ minh họa.
C. HƯỚNG DẪN CHẤM
I. PHẦN TRẮC NGHIỆM
	Câu
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12

	Đáp án
	A
	B
	D
	C
	B
	C
	D
	A
	D
	C
	C
	A


 II. TỰ LUẬN
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